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Section 1: Getting Started

This section allows you to start using your phone by activating 
your service, setting up your voicemail, inserting your battery, 
and navigating from the Today screen.

Understanding this User Manual
The chapters of this guide follow the order of the menus and sub 
menus. A quick reference index of features begins on page 167.

Important safety information is also included, beginning on 
page 145, to provide information you should know before using 
your phone. 

Text Conventions

This guide provides condensed information about how to use 
your phone. To make this possible, the following terms appear in 
place of repeatedly-used procedural steps: 

Preparing Your Phone
Before you can activate your new phone, you need to install your 
SIM card and the phone battery. 

Installing Your SIM Card

Important!: The plug-in SIM card and its contacts can be easily damaged by 
scratches or bending. Use caution when inserting or removing 
the card and keep all SIM cards out of reach of children.

1. If in place, remove the battery cover and the battery from 

your phone. (For more information, refer to “Removing the 

Battery”  on page 6.) 

point out Use the Navigation touch pad ( ) to move the 
cursor arrow over a menu item or screen item of 
interest. 

select After “pointing out” a menu item or screen item, press 
the Action key ( ). 

– or – 

Use the Stylus to select on a menu item or screen 
item, to launch, access, or save a highlighted menu 
item or screen field of interest. 
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2. Make sure the gold contacts of the SIM card face into the 

phone, then slide the SIM card into the socket, as shown. 

Removing the SIM Card

1. If in place, remove the battery cover and the battery from 

your phone. (For more information, refer to “Removing the 

Battery”  on page 6.) 

2. Slide the SIM card away from socket, as shown. 

Installing the Battery

The SGH-i907 comes with a standard rechargeable battery and a 
power accessory.

Note: This phone comes packaged with a partially-charged, rechargeable 
standard Li-Ion battery and travel charger. 

You must fully charge the battery before using your phone for the first 
time. A fully discharged battery requires up to 4 hours of charge time. 

1. Place the battery so that the plastic tabs are aligned with 

the corresponding holes in the phone. 

2. Gently push the battery down until it clicks into place. 
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3. Place the battery cover onto the back of the phone by 

aligning the tabs with the corresponding slots in the phone. 

4. Slide the battery cover up until it clicks into place. 

Removing the Battery

1. Push and hold the battery cover release latch down.

2. Slide the battery cover down. 

3. Lift the battery cover off of the phone, bottom end first. 

4. Lift the battery up and away from the phone. 

Charging the Battery

Note: The SGH-i907 comes with a rechargeable battery. Fully charge this 
battery before using your phone.

Your phone is powered by a rechargeable standard Li-ion battery. 
Only use Samsung-approved charging devices and batteries. 
Samsung accessories are designed to maximize battery life. 
Using other accessories may invalidate your warranty and may 
cause damage.

Note: Use the Samsung wall charger to charge the battery provided with your 
handset.
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� Plug the terminal end of the wall charger into the phone’s 

power/accessory interface connector and the other end 

into an electrical outlet. 

The Battery Charging icon ( ) replaces the battery 

level icon. 

Checking Battery Charge

Keeping track of the battery’s charge is important. If the battery 
level becomes too low, your phone automatically shuts down and 
you could lose important data. 
• For a quick check of your phone’s battery charge level, view the 

battery icon ( ) on the upper right portion of the display. The 
number of bars indicates the battery charge level. 

• To display a more detailed view of the battery’s remaining power, 
select the battery icon ( ) ➔ Battery tab. (For more information, 
refer to “Battery tab - Charge state”  on page 7.) 

Battery Capacity

When the battery becomes low, a warning window displays and 
the backlight turns off. 

Note: Long backlight settings, simultaneous use of Wi-Fi and Bluetooth, 
searching for service, vibrate mode, and browser use affect the 
battery’s talk and standby times. 

There is also an internal backup battery that saves all phone 
settings if the regular battery is discharged. The internal battery 
maintains data for approximately four hours. This internal backup 
battery needs an initial charge of 24 hours. 

Perform ActiveSync operations or a backup utility frequently to 
avoid loosing any information in case the battery is fully 
discharged. (For more information, refer to “Synchronization”  on 
page 115.) 

Battery tab - Charge state

The Battery Tab allows you to view the current power state of 
the Li-Ion battery. To perform a battery check using the Start 
menu:

1. From the Today screen, press the Start key ( ) to 

+
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activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Power ( ) 

Battery tab. 

The Power screen displays with the Battery tab active.

Advanced tab - Power parameters

The Advanced Tab allows you to set the following battery power 
and external power parameters for your device: 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Power ( ) ➔ 

Advanced tab. The Power screen displays with the 

Advanced tab active. 

3. To stop the phone from turning itself off when on battery 

power, within the On battery power section, select the 

Turn off device if not used for box. 

The check mark disappears from the box, and the time 

delay menu becomes inactive. 
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4. Select . If you are not finished, continue to step 5. 

5. To stop the phone from turning itself off when on external 

power, within the On external power section, select the 

Turn off device if not used for box. The check mark 

disappears from the associated check box, and the 

associated time delay menu becomes inactive.

6. Select  to save your changes and return to the 

previous Settings screen.

7. Select  to return to the Today screen.

LCD Off - Power Save Mode

By default, five seconds after a call is connected, SGH-i907 turns 
off the display to save power. The LCD Off Tab allows you to set 
this power save mode function to suit yourself:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Power ( ) ➔ 

LCD Off tab. The Power screen displays with the LCD Off tab 

active. 

3. To disable this function, select the Turn off LCD after call 

has been connected for option. The check mark disappears 

from the associated check box and the time delay setting 

becomes inactive. 

4. To increase the delay time, leave the Turn off LCD after call 

has been connected for option active and select a new time 

delay (5 – 30 seconds) for the phone to wait before 

entering a power save mode. 

5. Select  to save your changes and return to the 

previous Settings screen.

6. Select  to return to the Today screen.
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Activating Your Phone
If you purchased your phone at an AT&T Store, it is probably 
activated and ready to use. If you upgraded your phone or 
received a new phone by mail, it probably requires activation 
before you can use it. 

To activate your phone, follow these steps:

1. Visit an AT&T Wireless Store to activate your phone, or visit 

www.wireless.att.com, click on the My Wireless Account link, 

then enter your login and password in the Manage Your 

Wireless Account boxes on the Online Account Management 

page.

2. When you access the My Account Overview page, select 

Activate a new phone to display instructions needed to 

activate your phone online. 

3. After gathering the required materials, follow the 

instructions to complete the activation process.

Powering On the Phone

1. Press and hold the Power On/Off 

key ( ) located on the left side 

of the phone (near the top). 

2. The phone receives a signal from 

your home network, then logs in. 

At this point, the phone displays 

the Today screen (page 11) and 

begins functioning in PDA mode 

(letting you run applications) until 

you activate the phone features. 

Powering Off the Phone

� Press and hold the Power On/Off 

key ( ) located on the left side 

of the phone (near the top) until 

the power off animation begins 

playing.

http://www.wireless.att.com/


11

The Today Screen

The Today screen displays 
important information, 
such as upcoming 
appointments, status 
indicators, the current 
date, and time. You can 
open a program directly by 
selecting the related tab 
and the program’s 
associated icon.

� To access the Today screen from anywhere, press . 

Setting Up Your Voicemail

All unanswered calls to your Samsung SGH-i907 are sent to 
voicemail, even if your device is turned off. Therefore, you’ll want 
to set up your voicemail and personal greeting as soon as you 
activate your SGH-i907. 

1. Press and hold  to dial the voicemail system.

Note: Use of the  key is reserved for speed dialing voicemail. 
To dial voicemail without using speed dial, simply dial your own phone 
number and when the system answers, enter your password and 
press .

2. When the system answers, enter your password and then 

press .

3. Follow the prompts to setup your voicemail.

Checking Your Voicemail

1. Press and hold  to speed dial voicemail.

2. When the voicemail system connects, enter your password 

and press . 

3. Press  to listen to your messages. 
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Section 2: Customization and Navigation

This section explains the menu navigation for your phone. 

Navigating Your PDA
Your SGH-i907 provides the power of a personal computer with 
exceptional portability and integration of a mobile device. 
Unlocking its power begins with customizing the SGH-i907 so 
that it becomes an extension of your desktop or laptop computer.

The SGH-i907 is powered by Windows Mobile 6.1 Professional, 
providing the power and familiarity of Microsoft Windows. Mobile 
versions of popular Microsoft applications such as Word, Excel®, 
Windows Media Player® and Outlook® eliminate the need to 
learn new software. 

Menu Types
There is one main menu 
used by the SGH-i907 
called the Start Menu. 

The Start menu contains 
links to all the applications 
and settings information, 
similar to that of a 
Windows based PC 
system. 

To access the Start menu, simply press the Start key ( ). A 
drop down menu list is then displayed, and from there, all other 
applications and settings can be accessed. 

Customizing Your Start Menu List
1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Menus ( ). 

3. Enable/Disable an application by selecting the adjacent 

box. Enable up to seven items you want displayed within 

the Start menu. 

4. Press  or select  to save your new settings and 

return to the previous screen.

Today Screen
The items listed on the Today screen provide quick access to 
several user selectable applications. The Today screen displays 
important information, such as upcoming appointments, status 
indicators, the current date, and time. You can open a program 
directly by selecting the related tab and the program’s associated 
icon. 
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Customizing Your Today Screen Theme

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Today ( ).

3. Select your new theme from the list. 

• The default theme is At&t black.

4. Press  or select  to save your new settings and 

return to the previous screen. 

5. Press  or select  to return to the Today screen.

Customizing Your Today Screen Item Listing

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Today ( ) ➔ 

Items tab. 

3. Select the box adjacent to those items that will appear on 

the Today screen. A check mark appears in the selected 

box. 

• Remove these items by selecting their boxes again, thus removing 
the check mark from each item. 

4. Position each item (from top to bottom) on the list by 

selecting the item (not its box). The item becomes 

highlighted. 

5. Select the Move Up/Move Down button to re-position the 

highlighted item in the list. 

6. Press  or select  to save your new settings and 

return to the previous screen. 

7. Press  or select  to return to the Today screen.

Customizing Your Theme
1. From the Today 

screen, press the 

Start key ( ) to 

activate the Start 

menu.

2. Select Settings 

( ) ➔ Personal 

tab ➔  Theme 

( ).
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3. From the Theme drop down menu, select a theme (color).

4. From the Today Text drop down menu, select a color for the 

Today text.

5. For Background you have two options: 

6. Select a Background image. 

The Use default image check box is already checked.

– or – 

Select the Use default image check box (the Select a 

Picture screen displays). 

7. Select a picture from the displayed pictures. 

Customizing Your 
Today Plus Options
When you activate the 
Today Plus menu (shown), 
several default icons 
display on the menu. You 
can customize this options 
menu and display the 
applications or settings 
icons you want. To choose 
which options display, do 

the following:

1. Activate the Today Plus menu. For more information, refer 

to “Today Plus Option Lists”  on page 44.

2. In the Today screen, select the Today Plus tab (Connection, 

Favorites, Contacts, or Settings) whose options list you 

want to change. 

3. Position the cursor in the blank space below the shortcuts. 

4. Press and hold . Some of following options pop-up in 

the display: 

• Show Items: Lets you show/hide options currently appearing in the 
Connection option list. 

• Connection Tab Options: Allows you to select items in which to 
connect, sort Favorites, Move, Add, or Remove Contacts, show/
hide default options in the Settings list.
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• Tab Options: 
Launches the Today 
Plus Option screen 
showing the options 
currently assigned to 
the selected options 
list. 

5. Select new options 

as desired.

Removing Today Plus Options

You can remove options from the Favorites and Contacts options 
lists by doing the following:

1. Activate the Today Plus menu. For more information, refer 

to “Today Plus Option Lists”  on page 44.

2. In the Today screen, select the Today Plus Favorites tab or 

Contacts tab.

3. Position the cursor over the option you want to remove.

4. Press and hold . Select the Remove Item / Contact from 

Today option. The selected Item/Contact is removed from 

the displayed option list.

Showing/Hiding the Today Plus Options Lists

The Today Plus options lists display in the Today screen. To hide 
or display the options lists, do the following:

1. Activate the Today Plus menu. For more information, refer 

to “Today Plus Option Lists”  on page 44.

2. From the Today screen, press the Start key ( ) to 

activate the Start menu.

3. Select Settings ( ) ➔ Personal tab ➔ Today ( ) 

➔ Items tab.

4. Select the box adjacent to the Today Plus option. A check 

mark appears in the selected box (show Today Plus) or 

disappears from it (hide Today Plus).

5. Press  or select  to save your new setting.

Customizing the Special Function Keys
The bottom row of keys on your phone contains four Special 
Function keys. 

Special Function keys
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You can change the actions of these keys to suit your personal 
preferences. You can even assign these keys to act as other 
keys, such as the Soft keys.

Example: Reassigning the Messaging key

This procedure reassigns the Messaging key as a second Left 
soft key.

1. From the Today 

screen, press the 

Start key ( ) to 

activate the Start 

menu.

2. Select Settings 

( ) ➔ Personal 

tab ➔ Buttons 

( ). 

3. Scroll and select a Special Function key from the Select a 

button: list. 

4. Select the Assign a program: drop down list, then select 

<Left Softkey>.

5. Press  to save your setting and return to the Today 

screen. 
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Section 3: Understanding Your Phone

This section outlines many key features of your phone. It also 
describes the display icons, frequently used command keys, your 
display, and how to install your battery.

Features of Your Phone
Congratulations on your purchase of the Samsung SGH-i907. The 
SGH-i907 Microsoft software upgrade, supports thousands of 
applications. Using ActiveSync® 4.5 or later, you can keep your 
PC and device synchronized at all times. The features listed 
below are just a sample of what your SGH-i907 has to offer. You 
should read this guide to understand the many features that this 
phone supports and keep it handy for reference. 

Key Features of the SGH-i907
• Large 320 x 320 pixel, 65k color TFT screen
• Wireless Internet Capability
• Windows Mobile® 6.1 Professional
• Text Messaging (SMS)
• Multimedia Messaging (MMS)
• E-mail Message Service
• microSD™ Expansion Memory
• Utilizes Microsoft's Voice Command™ technology for voice recognition
• Voice Memo

• Built-in Bluetooth® Technology
• Built-in Wi-Fi Support
• Status/Alert LED (with adjustable alert settings)
• QWERTY Keypad
• 2.0 Megapixel Camera
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Front View of Your Phone Key Functions

1. Power ON/OFF Button: Press and hold to turn the device 

on or off. When the device is on, a short press lights or 

darkens the display. 

2. Display: Shows all the information needed to operate your 

phone. Display is touch sensitive, which lets you access 

your phone’s functions using the Stylus. 

3. Volume key: Adjusts the earpiece volume or headset 

volume in idle mode, the ringer volume in profile mode, or 

the voice volume during a call. To mute the ringer during 

an incoming call, press the Volume key up or down. To 

reject an incoming call, press the Ignore soft key or press 

and hold the Volume key up or down. This will send the call 

to your voicemail. 

4. Navigation touch pad/OK key: Lightly touch to move the 

cursor (arrow head) and to highlight choices. Short press 

to accept choices when navigating through a menu. 

5. Left Soft key (LSK): Allows you to select soft key actions 

or menu items corresponding to the bottom left line on the 

display screen.
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6. Start key: Short press to drop down or close up the Start 

menu.

7. Send key: Short press to open the dialing screen. Press to 

make or answer a call. In standby mode, press the key 

once to access the Call History. If you press and hold the 

key down, you will initiate the most recent call from the 

Call History. During a call, press and hold will launch the 

speakerphone option. During a call, a short press will place 

the call on hold or unhold.

8. Voicemail key: Press and hold to automatically dial your 

voicemail account. 

9. Built in QWERTY keypad: Allows you to enter numbers, 

letters, and characters using a full QWERTY keypad 

interface.

10. Function key: Press repeatedly to select input modes (  

and ) to type keypad punctuation marks (such as ! or 

+) or other symbols. 

11. Uppercase/Lowercase Shift key: Press repeatedly to select 

abc, Abc, or ABC text capitalization modes. 

12. MEdia Net key: Short press to launch the MEdia Net Home 

page. Press and hold to launch Microsoft Voice 

Command™ voice recognition. 

13. Calendar key: Short press to launch your calendar. 

14. Silent mode: Press and hold to place your device in silent 

mode. 

15. Microphone: The Microphone allows the other callers to 

hear you clearly when you are speaking to them.

16. Camera key: Short press to launch the Camera in your 

phone. Press and hold to activate Zoomer mode, which lets 

you magnify the screen. 

17. Messaging: A short press of the Messaging key allows 

you to access the SMS/MMS, Microsoft Office Outlook 

Mobile® E-mail or other E-mail accounts you setup. 

18. End key: Ends a call or exits a program. Press and hold 

this key for two seconds to lock the keypad. While in the 

main menu, it returns the phone to standby mode and 

cancels your input. 
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19. Right Soft key (RSK): allows you to select soft key actions 

or menu items corresponding to the bottom right line on 

the display screen. 

When you receive an incoming call, instead of answering 

the call, press the Right Soft key  to Ignore the call. 

If you press the Right Soft key  during a call, you 

access the Menu options. 

20. Back/OK key: Press to close the current menu and return 

to the previous menu or screen. Saves any changes you’ve 

made to the current menu. 

21. microSD Storage Card socket: Insert an optional 

microSD Storage Card to expand file storage space.

22. Headset/Power adapter jack/USB or data cable: Allows 

you to plug in the travel adapter (power), PC connection 

cable (data transfer), and optional headset for safe, 

convenient, hands-free conversations.

23. Earpiece: Used to listen to audio from your phone.

24. Indicator LED: Indicates status of various device functions 

(such as, incoming calls and messages, battery charging, 

Bluetooth, and Wi-Fi). 

Rear View of Your Phone

Key Functions

1. Camera lens: Used for taking pictures and videos.

2. Battery Cover: Protects the battery and the SIM card. 

.
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3. Mirror: Displays your reflection when taking pictures and 

videos. 

4. Stylus: Used to select options or functions on the tough-

sensitive display. 

Today Screen

Today Screen Functions

1. Start Menu: This drop down menu serves as the central 

launching point for applications. This menu provides 

access to a able list of programs for the user to launch, 

access to the device settings, and a way to find files and 

get help.

2. Title Bar: The Title bar at the top of the screen displays the 

active program, wireless status, and current time, and 

allows you to close screens. Click on the status icons to 

access abbreviated Connectivity, Phone, Volume, and 

Battery settings menus. 

3. Date/Day/Time: Displays the Date/Day/Time. Short click 

or select on this bar to display abbreviated Clock & Alarms 

settings. 

4. Xpress Mail: Select to access your personal or business 

e-mail.

5. Instant Messaging: Select to access your IM account.

6. Messages: Select to view text, multimedia messages, or E-

mail messages.

7. Appointments: Select to schedule appointments.

8. Device locked/unlocked: Indicates whether the device is 

locked or unlocked. If the device is unlocked, selecting this 

option locks it. If the device is locked, selecting the Left 

soft key causes the Unlock screen to appear.  
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9. Left Soft Key Command: Left soft key function.

10. Right Soft Key Command: Right soft key function.

Command Keys
Power On/Off Key

1. Press and hold the Power On/Off key ( ) [located on 

the left side of the phone (near the top)] to turn the phone 

on or off. 

2. To turn your LCD off/on, press the Power On/Off key 

( ) once until the backlight turns off/on.

Volume Up/Down Keys 

� Press and release the up or down Volume keys  to 

adjust audio volume for any screen.

Your Handset Keypad

The keys on your handset are divided into three functional 
groups: Navigation key (Finger Mouse), Alpha-numeric keypad, and 
Hot keys.

1. Navigation: The Finger Mouse allows you to access and 

scroll through menus and lists, confirm changes that 

you’ve entered, and interact with menus that appear in the 

display.

2. Hot keys: Used to launch Voice Command, enable or 

disable Silent Mode, activate the camera/camcorder, and 

more.

3. QWERTY keypad: Provides an alphanumeric character 

keypad layout for entering text, numbers, and symbols. 

4. Numeric keypad: Enter phone numbers.

Navigation Keys

Start Key

Launches or closes the Start Menu. 

Navigation Pad

Supports single-click mouse (Finger Mouse) functionality. Use the 
Finger Mouse ( ) to scroll through and highlight items, 
menus, and programs in a list or on the Internet. Once an item, 
link, or menu is highlighted, press  to select an option and to 
launch its related function. 

OK Key

Implements the function indicated in the upper right corner of a 
feature or program screen or menu. 
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Send Key

Press  at the Today screen to display the phone screen, or 
press it to dial a call after you enter a telephone number. 

End Key

Ends a call or exits a program. Press and hold this key for two 
seconds to lock the keypad. While in the main menu, it returns 
the phone to standby mode and cancels your input. 

Locking the Phone
When you lock your phone, it requires a password to return to 
normal operation. When a password is set up, the phone can be 
locked immediately or configured to lock after a specified period 
of inactivity, or when the screen blanks out.

Setting Up the Automatic Lock

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ 

Personal tab ➔ 

Lock ( ). 

3. Select the check box next 

to Prompt if device unused 

for.

4. From the Minutes drop 

down menu, select the 

amount of unused time required before you are prompted 

for a password if the phone becomes idle.

5. Select the Password type box, then select one of the 

following options:

• Simple PIN: This password must be at least four 
characters in length and can not contain a simple 
sequence such as: 0000, 1111, or 1234.

• Strong alphanumeric: This password must be at least 
seven characters in length and contain at least three of 
the following: uppercase/lowercase letters, numerals, 
and punctuation.

6. Select the Password box and use your keypad to enter the 

password you want. 

7. Select the Confirm box and re-enter the password. 
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8. Press  or select  to save your new password. 

You are prompted to confirm your changes. 

9. Select Yes to confirm. 

Setting Up a Password Hint

One way to make sure you don’t accidentally forget your 
password is to use the Hint feature. 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ 

Personal tab ➔ Lock 

( ) ➔ Hint tab. 

3. Enter a hint for your 

password into the 

dialogue box. This hint 

may be visible by others.

Note: The password hint you set will only appear after five consecutive 
incorrect password entries.

4. Press  or select  to save your hint and return to 

the previous screen.

Unlocking the Phone After a Time-out

To unlock your phone after the timer has expired:

1. Press  to 

activate the password 

screen.

2. Enter your password.

3. Press the Unlock soft 

key to unlock the 

handset.

Manually Locking the Phone

This process acts to temporarily lock the phone without the need 
to enter a password. To manually lock the phone: 

1. Press and hold the  key to manually lock the 

phone.
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The Lock icon changes as shown. 

• Unlock is then displayed as a left soft key function at the lower left 
corner of the screen.

Unlocking the Manual Phone Lock

1. From the Today screen, 

press the Unlock soft 

key. The Unlock screen 

displays. 

2. Select the Unlock 

button or press  to 

unlock the device. 

Display Icons
Various icons appear in your phone’s display or Title Bar during 
operation. The following table lists these icons as well as their 
descriptions.

Indicates signal strength. More bars mean better 
signal.

Indicates GPS is on for location. 

Indicates GPS for 911 is active.

Indicates your device is in Flight mode and your 
cellular radio is turned off (i.e. the phone is turned Off 
but the PDA is On).

Indicates the ringer for the selected profile is set to 
On.

Indicates the ringer for the selected profile is set to 
Off.
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Indicates the ringer for the selected profile is set to 
Vibrate.

Indicates your phone is charging.

Indicates the 3G high speed data transfer protocol is 
supported, which is required for video streaming and 
downloads.

Indicates a programming error. The phone can not 
connect until it is properly programmed. 

Indicates ActiveSync or a Data Session is currently in 
use.

Indicates there are no data sessions active. 

Indicates two or more message icons are displayed, 
your battery charge is low, or you missed a call.

Indicates a reminder of an upcoming calendar event.

Indicates you received a new text message. If you 
select this icon, a window displays that allows you to 
access the Inbox.

Indicates you received a new multimedia message. If 
you select this icon, a window displays that allows 
you to access the Inbox.

Indicates you received a new voicemail message. If 
you select this icon a window displays that allows you 
to listen to new voicemail messages.

Indicates you missed a call. If you select the icon a 
window displays indicating the number of calls 
missed. It also gives you the ability to view the missed 
call information.

Indicates your handset is in Speakerphone mode.

Indicates a Wi-Fi connection is inactive.

Indicates a Wi-Fi connection is available and active.
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Using a microSD Storage Card
You can insert a microSD™ card into the storage card slot and 
use the card to add additional memory to your phone, or to back 
up and transfer files and data. This type of card is designed to 
use with ultra-small mobile phones and other devices.

Note: Use only compatible storage cards with your phone. Using 
incompatible storage cards, such as Secure Digital (SD) cards, may 
damage the card, as well as the phone, and data stored on the card.

Installing the microSD Storage Card

1. Locate the memory slot on the right side of the phone and 

flip up the microSD plastic cover.

2. Orient the microSD card so the label side is facing upwards 

and the gold contact pins are not visible (see illustration).

3. Carefully insert the compatible microSD card into the 

opening and firmly push it in until you hear a click that 

indicates the card is securely installed. The card is secure 

when it is not protruding from the slot within the phone.

Indicates the Voice Command feature is active and 
awaiting a verbal command.

Indicates the current battery charge strength. 
(Icon shown fully charged.)

Indicates the current battery charge strength. 
(Icon shown fully discharged.)   

Indicates the current battery charge strength. 
(Icon shown fully discharged and will power down.)
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4. With the card now securely installed, replace the plastic 

cover over the microSD slot on the phone. 

Note: Storage cards with a storage capacity of over 16 GB will not work with 
this phone.

Removing the microSD Storage Card

1. Firmly push it in and release so that it becomes 

disengaged from the slot. The card should pop out from 

the slot.

2. Carefully grab the card and pull it out of the slot.

Programs - Installation and Removal
You can install any program created for your phone, as long as 
the phone has enough memory. The most popular place to find 
software for your phone is on the Microsoft web site (http:/
www.windowslive.com/Explore/Mobile).

Adding Programs by using Microsoft® ActiveSync®

You can install programs downloaded from the Internet or 
included on the Getting Started CD found with your Samsung 
SGH-i907 by performing a synchronization between your phone 
and your computer.

First you’ll need to determine what your phone and processor 
type are so that you can know which version of a particular 
software is required for installation.

You can download the latest version of Microsoft ActiveSync from 
the Microsoft site at: http://www.microsoft.com/windowsmobile/en-
us/help/synchronize/device-synch.mspx.

Adding a Program Directly from the Internet

First, you’ll need to determine what your phone and processor 
type is so that you know which version of the software to install.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ AT&T Mall ( ). 

http://www.windowslive.com/Explore/Mobile
http://www.windowslive.com/Explore/Mobile


29

3. Select Shop Games 

or Shop Application. 

4. Select a game or an 

application and 

follow the on-screen 

procedures to 

upload the software 

to your phone. 

Removing Programs

To remove a program perform the following:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Remove 

Programs ( ).

3. Highlight the program you want to remove and select the 

Remove button.

4. Select Yes to confirm.

5. Press  to save your changes and return to the 

previous screen.

Managing Certificates
On your phone you can add and delete public key certificates. 
You can store the following two types of certificates on your 
phone.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Certificates 

( ). 

3. Select the appropriate type of certificate tab: 

• Personal: Used to identify yourself to others.

• Intermediate: Used to identify intermediate certification 
authorities.

• Root: Used to identify root certification authorities.

4. To view information about a particular certificate, select it 

by name. The Certificate Details screen appears in the 

display listing information about the selected certificate. 

Deleting a Certificate

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Certificates 

( ). 
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3. Select the appropriate type of certificate tab: Personal, 

Intermediate, or Root. 

4. Position the cursor over the certificate you want to delete. 

5. Press and hold . Select the Delete option. 

6. Press the Yes soft key to confirm the deletion. 

Rebooting your Phone after Lockup
The Power button ( ) lets you quickly turn off the phone in 
the event of a program or application error. In this case your 
phone would appear to “freeze” and become unresponsive. 

1. Press and hold  until the power off animation 

appears in the display. 

2. Press and hold  until the power on animation 

appears in the display. 

Note: This restart action is similar to that of a “cold reboot” action on a 
computer. Your phone’s temporary memory is cleared, but information 
in permanent storage remains unchanged. 

Resetting your Phone to Factory Defaults

Note: To completely remove any personal information stored on your device, 
see “Precautions for Transfer and Disposal” on page 166.

You can reset your phone’s settings and clear all data/
applications from phone’s internal memory and/or external 
memory (optional microSD Storage Card) by using the Hard Reset 
option. This option resets your phone to its factory default 
settings, ends all applications currently running, and wipes all 
data (pictures/video/contacts) from your phone. 

Note: Although this action wipes all information and settings from your SGH-
i907, you can circumvent the deletion of important data by storing it on 
a removable microSD storage card. 

1. From the Today 

screen, press the 

Start key ( ) to 

activate the Start 

menu. 
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2. Select Settings ( ) ➔ System tab ➔ Hard Reset 

( ). The Hard Reset screen displays. 

3. Select the Hard Reset button. A confirmation screen 

displays. 

4. Select Device, enter 

the displayed 

password, then 

select the Yes button 

to remove all 

settings and data 

stored in your 

device.

5. Cycle power to the 

phone, that is, turn 

the power off and then on again. 

6. Once the phone starts, you must use the Stylus and select 

the LCD screen to begin the calibration process.

Note: You should not use your fingertips during the calibration process as 
this can improperly calibrate your device. Please use the Stylus for 
calibration of the SGH-i907.

7. Using your Stylus, select within the crosshairs that appear 

in the align screen.

8. Follow the on screen tutorials and complete the setup 

process. 

Performing a Manual Hard Reset

Important!: Caution, when performing a manual Hard Reset, the storage and 
settings initialize.

Remove your SIM card prior to performing a Manual Hard Reset 
to prevent loss of SIM-specific information. 

1. Power off the device.

2. Press and hold the H key.

3. Press the Power On key until the device starts to boot up 

(red light will flash).

4. Immediately release the power key while continuing to 

press the H key.

5. Wait for the Format Mode screen to appear.

6. Release the H key and follow the on-screen instructions.
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Section 4: Call Functions

This section describes how to make or answer calls. It also 
includes the features and functionality associated with using your 
phone, as well as explaining the voice command feature built into 
your Samsung SGH-i907. 

Turning the Phone Feature On and Off
Before using the SGH-i907's phone features, verify your phone 
features are active.

1. From the Today menu, select the Start menu.

2. Verify that the No Service icon on the Status Bar (as 

shown). 

3. Select Settings ( ) ➔ Connection tab ➔ Wireless 

Manager.

4. From the Wireless Manager menu, select Phone Off. The 

Wireless Manager screen displays. 

5. Click on Phone to toggle it On and Off.

Tip: The Wireless Manager screen allows you to turn on Wi-Fi and Bluetooth 
as well. 
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6. Press the Done soft key to exit and return to the Settings 

menu. You are now able to make and receive phone calls.

Making a Call
There are several ways to make calls on your new phone. You 
can use speed dial, voice dial, call history, or simply enter the 
desired number and press . 

Method 1 — Using the Contacts Shortcut List

To use this method, you must first do the following: 
• Enter Contact information. (For more information, refer to “Contacts”  

on page 51) 
• Add stored Contacts to your Contacts shortcut list. (For more 

information, refer to “Customizing Your Today Plus Options”  on 
page 14) 

Using the Contacts shortcut list lets you make a call while using 
just one hand. To make a call:

1. From the Today screen, select the Contacts tab. 

2. Select a contact 

button. Recent call 

information for this 

Contact displays, 

with the Contact’s 

phone number 

highlighted. 

3. Press the Call soft 

key. Your phone 

dials the selected Contact. 
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Method 2 — Using the Keypad

1. From the Today 

screen, enter the 

number using the 

keypad.

2. Press  to dial 

the number. 

Method 3 — Using the 
Contacts Soft Key

To use Method 3 - the 
Contacts soft key, you must first enter contact information. (For 
more information, refer to “Contacts”  on page 51) 

Using the Contacts soft key lets you make a call while using just 
one hand. To make a call:

1. From the Today screen, press the Contacts soft key.

2. Find and select the Contact entry you want to dial.

3. If the contact contains multiple phone numbers, highlight 

the desired number.

4. Press  to display the number in the phone screen 

and dial the number. 

Method 4 — Using the Stylus

1. From the Today screen, tap Start to activate the Start 

menu. 

2. Tap Phone ( ). A combined list of recently call numbers 

and your Contacts list displays. 

3. Tab the phone number of the person you wish to calling. A 

list of recent actions involving the selected person 

displays. 

4. Tap the Call entry to initiate the call. 

5. For other options, tap the Menu soft key to display the 

following options: 

• Open Contact / Call 

• Speed Dial 

• Save to Contacts 

• Send Text Message 

• Paste 

• Options... 

• View 

Important!: Always use the stylus when touching the screen to avoid 
scratches or damage caused by other instruments. 
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Method 5 — Using the Voice Command

1. Press and hold the MEdia Net key ( ) to activate Voice 

Command. A microphone icon ( ) displays in the Title 

bar.

Note: Voice Command must be enabled by selecting Start ➔ Settings ➔ 
Personal tab ➔ Voice Command ➔ Enable ➔ OK. (For more 
information, refer to “Voice Command”  on page 39.) 

2. After the phone beeps, say the command Call followed by 

the name of a Contacts entry, or say the command Dial 

followed by a phone number. 

Making an International Call

1. Press and hold  to insert a + character at the start of 

the international number. (The + character is automatically 

replaced with the International Dialing Code when you 

press .) 

2. Enter the country code and phone number you wish to dial. 

3. Press . 

Answering a Call
Make sure the phone is turned on. When you receive an incoming 
call, the Phone-Incoming screen displays. 

� Press the Answer soft key or press  to answer the call. 

� Press the Ignore soft key or press  to send the call to 

voicemail.

Note: When you receive a call, you can silence the ringer by pressing the 
volume key on the side of your phone.

Using the Speakerphone
During an active call, the speakerphone allows you to speak to 
others without the need to hold the phone to your ear. 

1. While in a call, press and hold  to activate the 

speakerphone. The speakerphone icon  then displays 

at the top of the screen.

2. To deactivate the speakerphone, press and hold  

again.

Displaying Your Phone Number
1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Phone ( ) ➔ Phone tab to 

display your phone number at the top of the screen. 
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3. To see all of your numbers, select the More tab, highlight 

the Own Number options, and then select Get settings... to 

open the Settings-Phone-Own Numbers screen and 

display your Voice Line number(s), Data number, and/or 

Fax number. 

4. To enter or change numbers on this screen, highlight the 

desired number, press the Edit soft key, and enter the new 

number using the keypad. 

5. Select  from the upper right of the screen to exit. 

Call History
When a call is received, made, or missed a record is saved with 
all the available information in the Call History. The Call History 
logs are: 
• All Calls: Displays all call received, sent, or missed.
• Missed: Displays any missed calls.
• Outgoing: Displays all outgoing calls made from your phone.
• Incoming: Displays all incoming calls that were answered.

Selecting a call entry displays the time, date, and duration of the 
call. 

To display the calls logs: 

1. Activate the Today Plus menu. For more information, refer 

to “Today Plus Option Lists”  on page 44

2. From the Today Plus menu, select Connection tab ➔ Phone 

( ).

The Phone screen displays the All Calls log. 

3. To show only selected types of calls, press the Menu soft 

key, then select Filter ➔ All Calls, Missed, Outgoing, or 

Incoming. The selected calls log displays in the Phone 

screen. 

4. Press  or select  to exit. 

All Calls Log and Contacts List — Send Key Method

1. From the Today screen, press . The combined calls 

log and Contacts list screen displays. 

2. To display only the All Calls log, press the Menu soft key, 

then select View ➔ All Calls. 

All Calls Log and Contacts List — Start Menu Method

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Phone ( ). The combined calls log and Contacts 

list screen displays. 
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3. To display only the calls, press the Menu soft key, then 

select View ➔ All Calls. 

Placing a Call Using Call History

1. Do one of the following:

From the Today menu, select the Phone soft key.

– or –

From the Today Plus menu, select Connection tab ➔ Phone 

( ).

The Phone screen displays the All Calls log. 

Note: If desired, display a particular calls log by pressing the Menu soft key 
and then selecting Filter ➔ All Calls, Missed, Outgoing, or Incoming. 
This option is available only from the Today Plus menu. To activate the 
Today Plus menu, see “Today” on page 76.

2. Highlight a call log entry. 

3. Press the Call soft key.

4. When finished, press . 

Creating a Contact Using Call History

1. Do one of the following:

From the Today menu, select the Phone soft key.

– or –

From the Today Plus menu, select Connection tab ➔ Phone 

( ).

The Phone screen displays the All Calls log. 

Note: If desired, display a particular calls log by pressing the Menu soft key 
and then selecting Filter ➔ All Calls, Missed, Outgoing, or Incoming. 
This option is available only from the Today Plus menu. To activate the 
Today Plus menu, see “Today” on page 76.

2. Highlight a call log entry. 

3. Press the Menu soft key and select Save to Contacts.

4. From the Contacts screen, select the <New Contact> entry.

5. Enter the contact information such as name, and number 

type. The phone number is already pre-entered. 

6. Press  or select  to save your new contact and 

return to the Today screen. 

Deleting the Call History

The call logs found within the Call History listing can be deleted 
individually or as a whole. Deleting all call entries will remove all 
currently displayed call entries. These entries are dependant on 
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the Filter used for calls log display (All Calls, Missed, Outgoing, or 
Incoming). 

Deleting Individual Call History Entries

1. Do one of the following:

From the Today menu, select the Phone soft key.

– or –

From the Today Plus menu, select Connection tab ➔ 

Phone ( ).

The Phone screen displays the All Calls log. 

Note: If desired, display a particular calls log by pressing the Menu soft key 
and then selecting Filter ➔ All Calls, Missed, Outgoing, or Incoming. 
This option is available only from the Today Plus menu. To activate the 
Today Plus menu, see “Today” on page 76.

2. Highlight a call log entry for deletion.

3. Press the Menu soft key and select Delete.

4. Select Yes to confirm the deletion. 

Deleting All Call Entries

This option is dependant on the list of currently displayed call 
logs. Only those entries displayed in your current list will be 

displayed. This option allows you to set to the initialization of the 
list saved to the call history.

For example, if your currently selected filter is only displaying 
your Missed Calls, deleting all calls in this instance would only 
delete these listed calls while leaving all remaining Incoming and 
Outgoing Call entries untouched.

Note: To delete all call log entries, you will need to activate the All Calls Filter 
and then select the Delete All Calls option. This option is available only 
from the Today Plus menu.

1. Activate the Today Plus menu. For more information, refer 

to “Today”  on page 76.

2. From the Today Plus menu, select Connection tab ➔ 

Phone ( ).

The Phone screen displays the All Calls log. 

Note: If desired, display a particular calls log by pressing the Menu soft key 
and then selecting Filter ➔ All Calls, Missed, Outgoing, or Incoming. 
This option is available only from the Today Plus menu.

3. Press the Menu soft key and select Delete All Calls.

4. Select Yes to confirm the deletion. 
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Sending a Text Message Using Call History

Text messages can be sent to other users that support SMS 
capabilities.

Note: Contact your service provider for more information on SMS messaging 
services.

1. Do one of the following:

From the Today menu, select the Phone soft key.

– or –

From the Today Plus menu, select Connection tab ➔ 

Phone ( ).

The Phone screen displays the All Calls log. 

Note: If desired, display a particular calls log by pressing the Menu soft key 
and then selecting Filter ➔ All Calls, Missed, Outgoing, or Incoming. 
This option is available only from the Today Plus menu.

2. Highlight a call log entry.

3. Press the Menu soft key and select Send Text Message.... 

The Text Message screen displays with the recipient 

already filled in.

4. Use the keypad to enter the message text. (For more 

information, refer to “Entering Text”  on page 46.) 

Note: Each text message can contain a maximum of 160 characters. Any 
characters (text) over that limit will be moved onto consecutive text 
messages to the same recipient. 

5. When you’re finished entering your message, press the 

Send soft key to send the message. (For more information, 

refer to “Messaging”  on page 57.) 

Roaming-Networks
What is Roaming

Your phone can roam on other digital networks. Roaming occurs 
when you travel outside a pre-designated coverage area. When 
in roaming is active, extra charges may apply when making or 
receiving a call. 

Note: Some features may be unavailable while roaming. Roaming also 
consumes additional power from the battery requiring more frequent 
charges. 

Voice Command
Voice CommandTM transforms your device into your own virtual 
personal assistant, letting you use your voice to look up contacts, 
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make phone calls, get calendar information, play and control 
your music, as well as start programs. 

See http://www.microsoft.com/windowsmobile/voicecommand/
default.mspx for a Voice Command demo.

Voice Command Settings

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Voice Command 

( ) to display the Voice Command screen. 

3. Select the Enable box to enable/disable the Voice 

Command feature. A checkmark displays in the box. 

Note: An unmarked box indicates the Voice Command feature is disabled.

4. Select the Password Protected box to turn password 

protection On/Off.

• A checkmark in the box indicates Password Protected is on.

• An unmarked box means indicates Password Protected is off.

5. Select the menu applications you want to access with a 

Voice Command. Choose from the following:

• Calendar 

• Contacts 

• Media 

• Messaging 

• Phone 

• Start Menu 

• Status 

• A checkmark in the boxes adjacent to an application indicates the 
Voice Command is enabled for that particular feature.

• If a selected application has available options, the Options button 
becomes active. Select the Options button to access that 
application’s available options.

• If a selected application has available notification parameters, the 
Notifications button becomes active. Select the Notifications 
button to access that application’s available notification parameters 
and make modifications if desired.

http://www.microsoft.com/windowsmobile/voicecommand/default.mspx
http://www.microsoft.com/windowsmobile/voicecommand/default.mspx
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Using the Voice Command

1. Press and hold the MEdia Net key ( ) to activate Voice 

Command. A microphone icon ( ) displays in the Title 

bar.

2. After the phone beeps, say the name of the command you 

want to perform. The Voice Commands are: 

• Call: Lets you dial a Contacts entry by saying a name saved in your 
contact list.

• Dial: Lets you dial a phone number by saying the digits in the 
telephone number.

• Lookup: Lets you retrieve contact information for any entry in your 
contacts list.

• Open: This provides you with one-step access to some or all of the 
following applications, depending on their voice enabled settings: 

– Calendar 

– Contacts 

– Media 

– Messaging 

– Phone 

– Start Menu 

– Status 

Video Share
The Video Share features allows you to place a call and share live 
or recorded video while on the call. You can initiate or receive 
video by using the following procedures. 

Enabling/Disabling Video Share

To enable or disable Video Share, use the following steps:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings 

( ) ➔ Personal 

tab ➔ Video Share 

( ) to display the 

Video Share screen. 

3. Select the Service 

box to enable/disable 

the Video Share 

feature. A 

checkmark displays in/disappears from the box. 
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Initiating and Receiving a Video Share Session

To initiate and receive a Video Share session use the following 
steps:

1. Dial the number and press .

2. Once the call is answered, if you're both capable of Video 

Share, a “Video Share Ready” icon displays on the 

screen. 

3. Press the Menu soft key, then select Video Share.

4. A pop-up message displays. Select Live or Recorded 

Video. 

5. If you selected Recorded Video, you can view the files in 

My Stuff ➔ My Documents ➔ My Videos.

6. Select the file you want to share. 

7. If the number is already listed as a Contact, the device 

displays the name corresponding with the number. A 

Notification “<Name/Number> wants to share video 

with you. Accept the connection?” displays. 

In case of unknown number, “<Number> wants to share 

video with you. Accept the connection?” displays.

8. Press the Yes soft key to accept the connection or the No 

soft key to decline it.

9. When the recipient accepts the video share, “Establishing 

a Video Connection” displays to both the sender and the 

recipient.

A Recording Started pop-up displays showing the memory 

available for the video. 

10. During a Video Share session, the following display above 

the soft key options:

Tip: Press the End key to stop the Video Share. When the cursor is on the 
Stop icon, press  or the Left soft key. 

Stop: press this key to stop the video share feature.

Brightness: press this key to adjust the brightness 
for the video.

Mute: Press this key to turn the audio off.

Spkr Off: the Left soft key displays Speaker On or 
Speaker Off. 
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Section 5: Menu Navigation

This section explains the menu navigation for your phone. Menus 
and sub-menus are accessed by using the Finger Mouse or 
Stylus.

Finger Mouse
Finger Mouse lets you select the navigation functioning of the 
Navigation Pad. You can choose the 4-way navigation mode or 
the mouse mode. The mouse mode option allows you to set 
mouse speed, timeout and cursor shape.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu.  

2. Select Settings ( ) ➔ System tab ➔ Finger Mouse 

( ) to open the Finger Mouse screen. 

The following navigation (Action) methods are available:

• 4-way Navigation: When selected, you navigate screens and 
menus by touching the Navigation Pad Up, Down, Left, and Right. 
Lets you select highlighted options by pressing the center of the 
Navigation Pad.

• Mouse: When selected, you navigate screens and menus by 
moving a finger lightly across the surface of the Navigation Pad. 
Additional options are:

– Mouse speed: Adjust the speed of the “mouse” action. 
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– Mouse timeout: Sets the “Mouse timeout” time limit. When the 
mouse is inactive for this period of time, the mouse deactivates on 
screen.

– Mouse cursor shape: Allows you to select a cursor icon (shape) from 
a selectable list.

3. Select the new value(s) for the Mouse speed, Mouse 

timeout, and Mouse cursor shape.

4. Press  or select  to save your new settings and 

return to the previous screen.

Note: From the home screen, you can toggle the Finger Mouse option on or 
off by pressing and holding the  key, and then pressing .

Accessing a Menu Function in the 4-Way Navigation Mode

1. Navigate screens and menus by touching the Navigation 

Pad Up, Down, Left, and Right. 

2. Select highlighted options by pressing the center of the 

Navigation Pad.

3. To exit the menu without changing the settings, press the 

 key or select .

Accessing a Menu Function in the Mouse Mode

1. Navigate screens and menus by moving a finger lightly across the 

surface of the Navigation Pad. 

2. Select highlighted options by pressing the center of the 

Navigation Pad.

3. To exit the menu without changing the settings, press the 

 key or select .

Today Plus Option Lists
The Today Plus options are another way to access applications 
from the Today screen without navigating through the main menu 
icons and sub menus. There are four available Today Plus option 
lists (Connection, Favorites, Contacts, and Settings) accessed by 
selecting their respective tabs.

To enable the Today Plus 
option lists:

1. From the Today 

screen, press the 

Start key ( ) to 

activate the Start 

menu. 
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2. Select Settings ( ) ➔ Personal tab ➔ Today ( ) 

➔ Items tab. The Today items screen displays.

3. Select the Today Plus box to enable/disable the Today Plus 

option lists. A checkmark displays in the box. 

Note: An unmarked box indicates the Today Plus feature is disabled.

4. Press  to save 

your setting. 

5. Press  or 

select  to return 

to the Today screen. 

The Today Plus 

option lists appear in 

the Today screen. 

Navigating the Today Plus Options Lists

To navigate using the Today Plus options lists: 

1. From the Today screen, select the desired Today Plus tab 

(Connection, Favorites, Contacts, or Settings). The 

associated Today Plus options list appears. 

2. Select the desired option. The associated option screen 

appears. 

Navigating Using the Title Bar Icons

The status icons that display in the title bar are also shortcuts to 
related features and functions of your handset. 

To use the status icons as shortcuts: 

� From the Today screen, select an available icon. The 

associated menu or screen displays. 

Some available icons are: 

• Message: Calls up the Messaging notification. 

• Connectivity: Gives you access to the Wireless Manager and to the 
Start ➔ Settings ➔ Connections tab menu. 

• Phone: Gives you access to the Wireless Manager and to the Start 
➔ Settings ➔ Personal tab ➔ Phone screen. 

• Volume: Displays the Volume pop-up, letting you set the phone 
and headset volumes. 

• Power: Displays the Start ➔ Settings ➔ System tab  ➔ 
Power screen. 
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Section 6: Entering Text

This section outlines how to select the desired text input mode 
when entering characters into your Samsung SGH-i907. 

Built-in QWERTY Keypad
Your SGH-i907 has a built-in standard typing keypad, commonly 
called QWERTY, below the display. Using this keypad, you can 
type letters, punctuation, numbers, and other special characters 
into text entry fields or other applications available on your 
handset. 

Text Entry - Input Method
There are four different character input methods available:
• Block Recognizer
• Keyboard (built-in QWERTY keypad or touch screen keypad) 
• Letter Recognizer
• Transcriber

Each of these methods allow you to input alphanumeric 
characters and symbols into the device. In addition to these input 
methods, there are other options such as Word Completion 
associated with the input selected. 

To access the Input Method settings: 

1. From the Today 

screen, press the 

Start key ( ) to 

activate the Start 

menu. 

2. Select Settings 

( ) ➔ Personal 

tab ➔ Input 

( ) ➔ Input 

Method tab. The Settings-Input screen appears. 

3. Select the preferred Input Method setting. 

4. Press  or select  to save your setting. 
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Changing the Input Method

To change the text input method from within a text entry field: 

1. Select the keyboard 

icon ( ). A 

touch-sensitive 

keyboard displays. 

2. Select the Up arrow 

beside the keyboard 

icon ( ). The 

following options 

display in a pop-up: 

• Options: Displays the Settings Input screen. (For more information, 
refer to “Keyboard”  on page 47.) 

• Block Recognizer ( ) 

• Keyboard ( ) 

• Letter Recognizer ( ) 

• Transcriber ( ) 

3. Select the desired input method. The keyboard icon ( ) 

is replaced with the associated input method icon. 

4. To remove the touch-sensitive keyboard, select the 

keyboard icon ( ). 

Block Recognizer

This input method uses the traditional writing area box split in the 
middle. This method allows you to enter characters using single 
strokes. 

The left side is used to write letters and the right side is for 
number entry. Symbols and common functions are located in 
other smaller boxes located to the right of the writing box area. 
There are no options associated with this type of input method.

Keyboard

This input method lets you use the built-in QWERTY keypad or a 
touch screen keyboard and the stylus to input characters. The 
keyboard entry method has the following options:
• Large keys
• Small keys
• Use gestures for the 

following keys: allows 
you to use touch point 
shortcuts to indicate the 
following keyboard 
actions:
– Space
– Shift+key
– Backspace
– Enter
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To select larger or smaller keys, simply select the button next to 
the desired option.

The gestures feature allows you to replace keys used on the 
keyboard for space, backspace, shift+key, and enter by drawing 
a gesture or motion. The large key option must be selected for 
this option to display. 

Letter Recognizer

This option allows you to enter text using the stylus and your own 
handwriting (natural character strokes). The screen is divided 
into three different areas. A capital letter area, small letter area, 
and a number area. Characters are entered by printing letters in 
each area. The character is then analyzed and typed on the 
screen automatically. 

� Select the Options... button to access the following options 

associated with this method:

• Quick stroke

• Right to left crossbar

• Allow accented characters

Transcriber

The transcriber option is similar to the letter recognizer, except 
instead of entering characters into a designated area, you can 
enter entire words and sentences using the stylus and your own 
handwriting (cursive), print, or mixed formats. Transcriber 
supports both printing and cursive writing styles and then 
automatically types the information on the screen. 

Text Entry - Word Completion
Word completion settings determine if words are automatically 
displayed after entering a defined number of characters on the 
screen. 

The following options are available:
• Suggest words when entering text
• Suggest after entering (space or 1-7 letters)
• Suggest (1-4) word(s)
• Add a space after word 
• Clear Stored Entries
• Enable Auto Correct

To access the Word Completion settings:
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1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Input ( ) 

➔ Word Completion tab. 

3. To enable this 

feature, select the 

Suggest words when 

entering text box. A 

checkmark appears 

in the box, indicating 

Word Completion is 

enabled. 

Note: Selecting the box adjacent to each item can either enable (check) or 
disable (uncheck) the items. 

4. Select the Suggest after entering drop down list and choose 

the minimum number of letters a word must contain before 

a word is suggested. 

5. Select the Suggest # word(s) drop down list and choose the 

numbers of words the device will suggest once the word 

completion parameters are met.

6. To enter an empty space after each recognized word, 

select Add a space after word. 

7. To enable the auto correction feature which dynamically 

corrects for spelling errors and other mistakes, select 

Enable Auto Correct.

8. Press  or select  to save your settings. 

Text Entry - Options

Note: These option settings only apply when writing or recording is 
supported. 

To access these options:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 
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2. Select Settings 

( ) ➔ Personal 

tab ➔ Input 

( ) ➔ Options 

tab. The following 

input options are 

available:

• Voice recording 
format 

• Default zoom level 
for writing 

• Default zoom level for typing 

• Capitalize first letter of sentence 

• Scroll upon reaching the last line 

3. Select each option's associated box or field and make your 

desired changes. 

Note: Selecting the box adjacent to each item can either enable (check) or 
disable (uncheck) the items.

4. Press  or select  to save your settings. 
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Section 7: Contacts

This section describes how to manage your daily contacts by 
storing someone’s name and number in your phonebook.

Understanding Your Contacts
This feature is used to save important information about your 
friends, colleagues, or business acquaintances. The Contacts 
screen allows you to save the person’s:

Working with your Contacts
In addition to the information available in contacts, you can also 
record or write a note associated with the contact. All of this 
information can be synchronized with a PC or Laptop using the 
Microsoft ActiveSync application. For more information, refer to 
“Synchronization”  on page 115. 

• Name • Company Telephone

• Picture • Work2 & Home2 Telephone

• Company • Radio Telephone

• Department • IM2 & IM3

• Job Title • E-mail2 & E-mail3

• File as • Assistant

• Work Telephone, Fax & Address • Assistant Telephone

• IM • Manager

• E-mail • Government ID

• Mobile Telephone • Account

• Ring tone • Customer ID

• Web page • Birthday

• Office Location • Anniversary

• Home Telephone & Address • Spouse

• Categories • Children

• Other Addresses

• Pager

• Car Telephone

• Home Fax
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Add a New Contact

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Contacts 

( ) to display the 

Contacts screen.

3. Press the New soft 

key, then select 

Outlook Contact. The 

Contacts information 

screen displays.

4. Enter your contact 

information into the 

fields provided using the keypad. (For more information, 

refer to “Entering Text”  on page 46.) 

5. Press  or select  to save your new settings and 

return to the previous screen.

Find a Contact

To locate a specific contact, you can use the find feature. Find 
allows you to enter the first few letters of the contact entry and 
then display the results on the screen. To find a contact:

1. From the Today screen, press the Contacts soft key. The 

Contacts screen displays.

2. Select the Enter a name... field and use the keypad to 

enter the first few characters of the contact entry. With 

each consecutive character, the list of matching contacts 

becomes more refined. 

3. If needed, scroll through this list of matching contacts until 

you find the desired contacts entry.

Edit a Contact

1. Find the desired contact. (For more information, refer to 

“Find a Contact.”)

2. Press the Menu soft key and select Edit.

3. From the available list of contact information, select a field 

and update the desired information. 

4. Press  or select  to save your new settings and 

return to the previous screen.
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Delete a Contact

1. Find the desired contact. (For more information, refer to 

“Find a Contact”  on page 52.) 

2. Press the Menu soft key and select Delete Contact.

3. Select the Yes button from the Delete Contact pop-up to 

confirm the deletion.

Make a Call from Contacts

1. Find the desired contact. (For more information, refer to 

“Find a Contact”  on page 52.) 

2. Select the contact to display its information.

3. Press the Call soft key to place a call to the selected 

contact.

Send a Contact Entry via Bluetooth

Your SGH-i907 lets you exchange contact information wirelessly 
with other Bluetooth enabled devices. 

1. Find the desired contact. (For more information, refer to 

“Find a Contact”  on page 52.) 

2. Press the Menu soft key and select Send Contact ➔ 

Beam. Your device begins to search for a compatible 

Bluetooth device is its communication range. 

3. Select the device(s) you wish to transmit to. When the 

contact has been successfully transferred, the selected 

device displays Done. 

4. Press  or select  to exit and return to the 

previous screen. 

Receiving a Contact Entry via Bluetooth

To set your SGH-i907 to accept incoming Bluetooth 
transmissions:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings 

( ) ➔ 

Connections tab ➔ 

Bluetooth ( ) ➔ 

Mode tab.

3. Select the Turn on 

Bluetooth check box 

and the Make this 

device visible to other 

devices check box. A check mark will display in each box. 
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4. Press  or select  to save your new settings and 

return to the previous screen.

Adding Notes to Contacts
Notes allow you to attach either a recorded audio file or attach a 
written note to a saved contact entry. When you view the 
summary screen on the contact, you can view or listen to any 
notes that are associated with the contact.

Adding a Note

1. Find the desired contact. (For more information, refer to 

“Find a Contact”  on page 52.) 

2. Select the contact to display its information.

3. Press the Menu soft key and select Edit ➔ Notes tab. 

4. Enter the note using the desired entry method. (For more 

information, refer to “Entering Text”  on page 46.) 

5. After the note has been successfully entered, select  

to save your note and return to the previous screen. 

Deleting a Note

1. Find the desired contact. (For more information, refer to 

“Find a Contact”  on page 52.) 

2. Select the contact to display its information.

3. Press the Menu soft key and select Edit ➔ Notes tab. 

4. Press the Menu soft key and select Edit ➔ Select All. 

5. Press the Menu soft key and select Edit ➔ Clear.

6. Press  or select  to exit and return to the 

previous screen. 
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Speed Dial Contacts
Speed dial can be used to dial contacts that you talk to the most. 
Speed dial allows you to press up to two numeric keys to dial to 
the contact. Memory locations 2-99 are available for speed 
dialing. 

Note: Location 1 is pre-configured to dial your voicemail and can not be 
altered.

Shortcut Method

To assign a speed dial location: 

1. Find the desired contact. (For more information, refer to 

“Find a Contact”  on page 52.) 

2. Select the contact to display its information. 

3. Press the Menu soft 

key and select Add to 

Speed Dial... The 

Speed Dial screen 

displays with the 

next available Speed 

Dial location in the 

Location field. 

4. If desired, select the 

Location field's up or down arrows to assign this contact to 

another available speed dial location (2 – 99).

5. Press  or select  to save the Speed Dial 

assignment and return to the previous screen. 

Start Menu Method

To assign a speed dial location:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Phone ( ). 

3. Press the Menu soft key and select Speed Dial. The Speed 

Dial list displays. 
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4. Press the Menu soft key and select New. The Contacts list 

displays. 

5. Find the desired contact. (For more information, refer to 

“Find a Contact”  on page 52.) 

6. Select the contact. The Speed Dial screen appears in the 

display. 

7. Select the Location field's up or down arrows to assign this 

contact to an available speed dial location (2 – 99).

8. Press  or select  to save the Speed Dial 

assignment and return to the previous screen. 
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Section 8: Messaging

This section discusses the types of messages you can send and 
receive, how to set up your phone to work with E-mail, and how 
to send and receive Email messages using different types of 
connections. 

Types of Messages
Text and Multimedia Messages

Your SGH-i907 is capable of sending Text (SMS) messages and 
Multimedia [picture or video (MMS)] messages. You send Text 
and Multimedia messages by simply entering the phone number 
of the recipient in the To: field when creating a new message. 

E-mail Messages

Your SGH-i907 is capable of sending E-mail in two ways: directly, 
through an Internet Protocol (IP) account, or indirectly, by using 
Microsoft ActiveSync™ to exchange Email through your PC. 

Retrieving a Message
When you receive a new text, picture, or video message, the 
message ringer sounds (unless turned off) and the message 
displays in a preview pane. 

Note: The Text Message Notification  icon displays on the top of the 
screen. 

1. To remove the preview pane from the Today screen, 

press . 

2. To re-open and display the message in the preview pane, 

press the Notification soft key. 

3. To reply to the displayed message, press the Reply soft 

key. 

Read Text Messages Options

Several message features are available when reading a text 
message.

� While reading a received text message, press the Menu soft 

key. The following options are available:

• Delete: Deletes the message.

• Forward: Send a copy of this message to another recipient. 

• Insert: Add Picture, Sound, Or Video files to any reply to this 
message. 

• My Text: Add pre-composed text to any reply to this message. 

• Save to Drafts: Saves a copy of any reply to this message in the 
Drafts folder. 

• Spell Check: Check the spelling of any reply text to this message. 
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• Close: Returns you to the Inbox folder contents screen. 

• Message Options: Inactive. 

• Copy to SIM: Lets you save a copy of the message to your SIM 
card.

Read Multimedia Message Options

Several message features are available when reading a 
Multimedia message.

� While reading a received Multimedia message, press the Menu 

soft key. The following options are available:

• Delete: Delete this message.

• Reply: Send a Text or Multimedia message reply to the sender. 

• Reply All: Send a Text or Multimedia message reply to all recipients 
of the message.

• Forward: Allows you to forward the message to another number or 
email address.

• Mark as Unread: Lets you mark the message as unread. Unread 
messages are boldfaced on the message list. 

• Save to Contacts: Save sender’s number to your Contact list. 

• Save as Bookmark: Save a URL included in this message as a 
bookmark. 

• Save as Multimedia Msg. Temp...: Save this message as a pre-
composed, Multimedia message template for later reuse. 

• Attached Files...: View and/or save attached picture file and/or 
sound file, or video file. 

• Multimedia Msg. Options...: Set Sending, Receiving, Profile, 
Compose options for Multimedia message. 

• Properties: Displays Message Info screen containing Subject, 
Send Date, From, Size, Priority, Expiry, Type, and Read Report 
information. 

Accessing Message Folders
1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Messaging 

( ) ➔ 

Messages ( ). 

The Messages 

screen displays 

showing the 

contents of a 

Messages folder (in 

this case, the Inbox 

folder). 
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3. Select folder name 

at the top, left of the 

Messages screen. A 

drop-down menu 

displays showing a 

menu tree that lists 

Messaging account 

types and lists 

folders for the 

Messages account. 

The available Messages folders are: 

• Deleted Items: Stores messages that you delete from the other 
folders. This lets you recover messages that were erased 
accidentally. 

• Drafts: Lets you store messages for later completion and/or reuse. 

• Inbox: Stores your incoming (received) messages. 

• Outbox: Stores your outgoing messages until they are sent. 

• Sent Items: Stores your outgoing messages that have been sent.

(For information about Outlook E-mail folders, refer to the 

Microsoft Outlook user manual.) 

4. To display the contents of a folder, select it in the drop-

down menu. 

Received Text Message Options

Several message features are available for received text 
messages.

1. From the Messages Inbox folder screen, highlight a text 

message and press the Menu soft key. The following 

options are available:

• New: Lets you create a new Text or Multimedia message.

• Reply: Sends a reply to the sender and/or all other recipients, or 
forwards this message to other people.

• Delete: Moves this message to the Deleted Items folder. 

• Move...: Lets you move this message to other folders.

• Delete All: Deletes all messages (unread and read) from the Inbox 
folder. 

• Delete All Read: Deletes all messages you have read from the 
Inbox folder. 

• Go To: Lets you switch to another message folder or message 
account. Select one of the following: 

– Folders 
– Messages
– Outlook E-mail
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• Tools
– Sort By: Lets you sort messages by one of the following criteria: 

Message Type, From, Received, or Subject. 
– Manage Folders...: Lets you create or modify a message folder.

– Empty Deleted Items: Allows you to permanently delete all items in 
the Deleted Items folder.

– Clear “Messages”: Deletes all items in the Inbox and Sent Items 
folder.

– New Account...: Allows you set-up a new e-mail account.

– Options...: Allows you to change the options for the Messaging. 

• Select Messages: Select All messages, All Below this message, or 
Several messages to which other functions will be applied. 

• Send/Receive: Select to send or receive new e-mail messages. 

• Multimedia Msg. Options...: For more information, refer to 
“Configuring Multimedia Message Parameters”  on 
page 62. 

Received Multimedia Messages Options

Several message features are available for received Multimedia 
messages.

1. From the Messages Inbox folder screen, highlight a 

Multimedia message and press the Menu soft key. The 

following options are available:

• New: Lets you create a new Text or Multimedia message.

• Reply: Sends a reply to the sender and/or all other recipients, or 
forwards this message to other people.

• Delete: Moves this message to the Deleted Items folder. 

• Move...: Lets you move this message to other folders.

• Delete All: Deletes all Multimedia messages (unread and read) 
from the Inbox folder. 

• Delete All Read: Deletes all Multimedia messages you have read 
from the Inbox folder. 

• Go To: Lets you switch to another message folder or message 
account. Select one of the following: 

– Folders 
– Messages
– Outlook E-mail

• Tools
– Sort By: Lets you sort messages by one of the following: Message 

Type, From, Received, or Subject.
– Manage Folders...: Lets you create or modify a message folder.

– Empty Deleted Items: Lets you permanently delete all items in the 
Deleted Items folder.

– Clear “Messages”: Deletes all items in the Inbox and Sent Items 
folder.

– New Account...: Allows you set-up a new e-mail account.

– Options...: Allows you to change the options for the Messaging. 
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• Select Messages: Select All messages, All Below this message, or 
Several messages to which other functions will be applied. 

• Send/Receive: Select to send or receive new e-mail messages.

• Multimedia Msg. Options...: For more information, refer to 
“Configuring Multimedia Message Parameters”  on 
page 62. 

Configuring Message Parameters
1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Messaging ( ) ➔ Messages ( ). The 

Messages screen displays showing the contents of a 

Messages folder. 

3. Press the Menu soft key, then select Tools ➔ Options. The 

following tabs appear in the display: 

• Accounts: Lets you 
review/change 
settings and 
signatures for your 
Messaging accounts 
or for a new account. 
You can also enable/
disable the “account 
picker” screen. 

• Message: Lets you 
change message 
options. Select the box 
of the options you 
would like to turn on or off. 

• Address: Applies to E-mail only. 

• Storage: Shows the amount of Main Memory is free, the amount 
of Storage Card memory is free (when inserted), and the Current 
size of attachments. Also lets you select when the phone empties 
deleted messages from memory. 

4. Press  or select  to save your new settings and 

return to the previous screen.
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Configuring Multimedia Message Parameters

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Messaging ( ) ➔ Messages ( ). The 

Messages screen displays showing the contents of a 

Messages folder. 

3. Press the Menu soft key, then select Multimedia Msg. 

Options... The following tabs appear in the display: 

• Sending: Lets you set delivery options and delivery reporting 
options for Multimedia messages. 

• Receiving: Lets you specify how your phone reacts to incoming 
Multimedia messages. 

• Profile: Lets you select, create, and edit communication profiles for 
exchanging Multimedia messages with your carrier’s messaging 
server. 
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• Compose: Lets you select Message Class and Creation Mode 
settings for composing Multimedia messages. 

• About: Displays version information for Samsung’s Multimedia 
Message software. 

4. Press  or select  to save your new settings and 

return to the previous screen.

Sending Messages
Creating and Sending Text Messages

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Messaging ( ) ➔ Messages ( ). The 

Messages screen displays showing the contents of a 

Messages folder (in this case, the Inbox folder). 

3. Press the Menu soft 

key, then select New 

➔ Text Message. 

The Messages 

composition screen 

displays. 

4. Enter multiple phone 

number or E-mail 

addresses of 

recipient(s) in the To field. 

• Use the keypad to place a semicolon between numbers, if there is 
more than one recipient. 



Messaging       64

5. Select the message text input field and use the keypad to 

enter the text content of your message. (For more 

information, refer to “Entering Text”  on page 46.) 

Note: There is a 160-character limit for text messages. If you send a text 
message with more than 160 characters, the message is truncated 
after the first 160 characters and the remaining characters are then 
sent in consecutive messages until the entire message text has been 
sent. Charges may apply in accordance with the sender's and the 
recipient's calling plans.

6. For additional message options, press the Menu soft key. 

The following options are available: 

• Add Recipient: Add Contacts entries.

• Check Names: Check contacts for the name of the recipient. 

• Insert: Insert a Picture, Sound, or Video file into your message. This 
automatically changes a Text message to a Multimedia message. 

• My Text: Add pre-composed text to this message. 

• Save to Drafts: Saves the message to the draft folder.

• Spell Check: Spell check your message.

• Cancel Message: Cancels the new message.

• Message Options: Inactive.

7. Press the Send soft key to transmit your message to the 

selected recipients. 

Spell Checking a Text Message

1. While creating a Text message (see “Creating and Sending 

Text Messages” on page 63), press the Menu soft key and 

select Spell Check. 

Words that are not present in the Spell Check dictionary 

files are highlighted, and available word choices are 

presented in a list.

2. From this list of alternate words, select either:

• An alternate word

• Ignore: to ignore the currently selected word.

• Ignore All: to ignore all remaining misspelled words in the text 
message.

• Add: To add the currently highlighted word into the Spell Check’s 
dictionary.

3. When the spell check is complete, select  to return to 

the message.

Note: The Spell Check feature is not available for Multimedia messages.
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Checking Names Within a Text Message

� While creating a Text message (see “Creating and Sending 

Text Messages” on page 63), press the Menu soft key and 

select Check Names. 

Recipient names currently used within the To filed are 

verified against the current Contacts list and e-mail 

addresses are reviewed to verify they conform with the 

standard E-mail formats. 

Creating and Sending Multimedia Messages

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Messaging ( ) ➔ Messages ( ). The 

Messages screen displays showing the contents of a 

Messages folder. 

3. Press the Menu 

soft key, then 

select New ➔ 

Multimedia 

Message. The 

Multimedia 

Message 

composition 

screen displays. 

4. Enter the phone 

number or E-mail addresses of up to ten recipient(s) in the 

To field. 

• Use the keypad to place a semicolon between numbers, if there is 
more than one recipient. 

5. Select the Subject field and use the keypad to enter a 

subject for your message. 

6. Select the message text input field and use the keypad to 

enter the text content of your message. (For more 

information, refer to “Entering Text”  on page 46.) 
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7. To add existing photos, music files, or video clips to your 

message or to launch the Camera or Sound Recorder to 

take or record new files and add them to your message, 

select the appropriate icon(s) on the bottom line of the 

Multimedia Message composition screen. 

8. To access additional Multimedia message options, press 

the Menu soft key. The following options are available: 

• Preview: Allows you to preview the new MMS message prior to 
delivery.

• Add Recipient: Add Contacts entries or numbers from the recent 
Calls log.

• Insert: Allows you to attach both pre-existing or new files to the 
new MMS message: Picture, Sound, Video, New Picture, New 
Sound, New Video, and Text and Template.

• Attach: Attach your vCard, vCalendar, or a File. 

• Edit Page: Add, delete, reorder, change the text style used on, or 
change the duration of pages in a multi-page message. 

• Save to: Allows you to save the current Multimedia message as a 
Draft or a Template.

• Cancel Message: Allows you to save the current message as a 
draft and exit the message composer.

• Multimedia Msg. Options: For more information, refer to 
“Configuring Multimedia Message Parameters”  on 
page 62. 

• Toolbar: Enable or disable the message composer toolbar. 

9. Press the Send soft key to transmit your message to the 

selected recipients. 

Note: Charges may apply in accordance with the sender's and the recipient's 
calling plans. 

Using My Text Messages
My Text Messages consist of 9 pre-composed text message 
phrases you can quickly insert into the body of a new message or 
as a response to a received message without having to type a 
message. These default messages are: 
• What are you up to?
• Just checking in...
• Where are you?
• Check this out!
• I’ll be right there.
• I’m running late.
• I’ll get back to you.
• Urgent! Please reply ASAP.
• Let’s catch up soon.
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Inserting My Text in a Message

1. Create a new message. (For more information, refer to 

“Sending Messages”  on page 63.) 

2. Press the Menu soft key and select My Text.

3. Select a desired message from the list. The selected 

message is then inserted into the body of the message. 

4. Complete your message. (For more information, refer to 

“Sending Messages”  on page 63.) 

5. Press the Send soft key to transmit your message to the 

selected recipients. 

Editing My Text

1. Create a new message. (For more information, refer to 

“Sending Messages”  on page 63.) 

2. Press the Menu soft key and select My Text ➔ Edit My Text 

Messages.... A list of editable Text Messages displays.

3. Select a pre-existing Text Message entry. 

4. Use the keypad (or use the stylus and the virtual keyboard) 

to edit the text. (For more information, refer to “Entering 

Text”  on page 46.) 

5. Select  to save your changes and return to the 

message.

Accessing E-mail
E-mail Account Setup

You can configure the SGH-i907 to send and receive E-mail using 
Microsoft Outlook, ActiveSync, and a PC or using an ISP account. 

Setting Up an Outlook E-mail Account

� Install ActiveSync on your PC and set up a Standard 

Partnership, so you can send/receive E-mail. (For more 

information, refer to “Setting Up and Configuring ActiveSync”  

on page 116.) 

Setting Up an Internet Service Provider (ISP) Account

You can use your SGH-i907 to access the Internet for E-mail 
using a connection through your Wireless Carrier or using a Wi-Fi 
connection (For more information, refer to “Connections 
Settings”  on page 81.) 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 
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2. Select Messaging 

( ) ➔ Setup 

E-mail.

3. Enter your E-mail 

address and 

password into the 

appropriate fields 

and press the Next 

soft key. 

4. You are prompted to 

let your handset 

automatically obtain 

E-mail settings. 

• If this account is to 
access a public ISP 
E-mail server, press 
the Next soft key. 

• If this account is to 
access a private 
E-mail server (such as 
your employer’s), disable this function by selecting the checkbox 
next to the prompt. The check mark disappears. Then, press the 
Next soft key. 

Note: For private E-mail servers, you will be prompted for specific 
information about the server. 

- Server URL or IP address 
- Server access authentication (nearly always required and usually 
   the same as your account ID and password) 
- Whether the server requires SSL (Secure Sockets Layer) 
- Type of connection used to access the server 

Contact the server operators or your ISP for this information. 

5. You are notified when setup is complete. (For ISP servers, 

you are prompted to select an automatic contact interval.) 

Using Microsoft Outlook for E-mail

Using Microsoft Outlook, E-mail is composed off-line and is sent 
to the intended recipient(s) the next time you synchronize using 
ActiveSync. 

Note: For more information on how to wirelessly synchronize your e-mail, 
refer to the Wireless Sync documentation included within the 
ActiveSync Companion CD. 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Messaging ( ) ➔ Outlook E-mail. 

3. Review your received E-mail as needed.
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4. To create an send E-mail, press the Menu soft key, and 

select New. The E-mail composition screen displays. 

5. Enter the E-mail address in the To field. 

6. Select the Subject field and enter a subject. 

7. Select the message text field and enter the content of your 

E-mail message.

8. When you’re finished, press the Send soft key. 

Using an ISP for E-mail

You can configure the SGH-i907 to use an Internet Service 
Provider (ISP) or your network at work to send E-mail directly 
from the SGH-i907 without connecting to your PC through 
ActiveSync. 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Messaging ( ) ➔ your E-mail account. 

3. Review your received E-mail as needed. 

4. To create and send E-mail, press the Menu soft key, and 

select New. The E-mail composition screen displays. 

5. Enter the E-mail address in the To field. 

6. Select the Subject field and enter a subject. 

7. Select the message text field and enter the content of your 

E-mail message.

8. When you’re finished, press the Send soft key. 

Outlook E-mail Folders

There are five message 
folders Outlook E-mail 
directory (see adjacent 
image). 

The folders and their 
functions are similar to the 
folders in the Messages 
directory, except for 
Outbox. 

Using ActiveSync, E-mail is 
stored in the Outbox until 
you synchronize with your PC. 

Using an ISP, E-mail is stored in the Outbox folder until message 
sending is complete. 

The following is a list of Outlook E-mail messaging folders and 
their functions.
• Deleted Items: sent to the Deleted Items folder. Once messages are 

removed from the Deleted Items folder, they are permanently erased.
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• Drafts: contains all messages that were not completed and saved to 
send at a later date.

• Inbox: all incoming messages arrive and are stored in the Inbox until 
deleted. If memory is full, new messages are rejected. Delete older 
messages to free up space for incoming messages. 

• Outbox: the Outbox stores unsent messages until they send.
• Sent Items: keeps a record of all sent messages from your device. 

Configuring E-mail Parameters

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Messaging ( ) ➔ Messages ( ). The 

Messages screen displays showing the contents of a 

Messages folder. 

3. Press the Menu soft key, then select Tools ➔ Options. The 

following tabs appear in the display: 

• Accounts: Lets you review/change settings and signatures for 
your Messaging accounts or for a new account. You can also 
enable/disable the “account picker” screen. 

• Message: Lets you 
change message 
options. Select the box 
of the options you 
would like to turn on or 
off. 

• Address: Lets you 
check E-mail address 
information using the 
address books. Select 
the Add button to add 
address books to the 
phone. These 
additional address books provide more available E-mail addresses. 

• Storage: Shows the amount of Main Memory is free, the amount 
of Storage Card memory is free (when inserted), and the Current 
size of attachments. Also lets you select when the phone empties 
deleted messages from memory. 

4. Select  to save your changes and return to the 

previous screen. 
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Section 9: Changing Your Settings

This section explains how to either set or change many of the 
settings available on your Samsung SGH-i907. 

Device Settings Menus
The Settings menus for your SGH-i907 phone allow you to 
configure or change how many of your phone’s features or 
functions appear or work. Some of the settings on these menus 
are associated with shortcuts or hot keys on your phone and can 
be quickly accessed for your convenience. 

Settings that are not easily associated with other applications or 
features of your phone are discussed here. They are not listed in 
a specific order; however, some settings are grouped with topics 
that include them. 

If you don’t see a setting that you are looking for discussed here, 
check the Index that begins on page 167, for a complete listing 
of all settings for your phone. 

Personal Settings
Button Assignments

For more information, refer to “Customizing the Special Function 
Keys”  on page 15. 

Function Key Settings

You can assign particular letter keys to launch an application or 
function when you press and hold , then press a letter key. 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings 

( ) ➔ Personal 

tab ➔ FN Key 

Settings ( ). FN 

Key Settings screen 

displays. 

3. Select the Show List 

button. The Edit 

screen displays. 

4. Select a button to be assigned a program. The Assignment 

for the button should be “None”. 

5. Select the ... button. The Select program screen displays. 
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6. Highlight the program you wish to launch with the selected 

letter key, then press the Select soft key. The Edit screen 

displays. 

7. Press  or select  to save your new setting. 

Input Setting

For more information, refer to “Entering Text”  on page 46. 

Lock

For more information, refer to “Setting Up the Automatic Lock”  
on page 23. 

Menus

This settings screen lets you select which links appear in the 
Start menu. 

Phone Settings

This series of screens lets 
you specify settings for the 
Phone functions of your 
SGH-i907. 

1. From the Today 

screen, press the 

Start key ( ) to 

activate the Start 

menu. 

2. Select Settings 

( ) ➔ Personal tab ➔ Phone ( ). Phone options 

are divided into the following tabs:

• Phone: Select the desired sounds associated with the phone. 

• Services: Enable, disable, and select parameter values for phone-
related network services. 

• Network: Find, select, and register your phone to a wireless 
network. 

• Security: Enable or disable PIN-controlled access to your phone. 
Also lets you change your PIN. 

• More: Enable, disable, and select parameter values for additional 
phone-based services and/or phone-related network services. 
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Phone Tab — Phone Ringer Options

You can select several different phone ringer sounds for the SGH-
i907. You can also change the ring type and its tone. To access 
these settings:

1. From the Settings – Phone screen, select the Phone tab.

2. Select the Ring type drop down arrow, then select the ring 

type you want. 

3. Select the Ring tone drop down arrow, then select the 

ringer sound you want. 

Tip: To hear the ring tone, use the player controls located to the right of the 
Ring tone drop down box. Select the arrow to play the tone, select the 
square to stop.

4. Select the Keypad drop down arrow and select:

• Short tones: When you press keypad key, a short tone is played.

• Long tones: When press a keypad key, a long tone is played.

• Off: No tones are played when keypad key is pressed.

5. Press  or select  to save your new settings and 

return to the previous screen.

Services Tab

The Services tab lets you 
configure the phone-
related network services.

Note: Before configuring any or all of these services, you should verify that 
you are subscribed to these services with your Wireless Carrier. 

To access the service settings:

1. From the Settings – Phone screen, select the Services tab.

2. Change or set the following options:

• Call Barring: Lets you set conditions for Blocking incoming calls (All 
calls, When roaming, Off) and/or Blocking outgoing calls (All calls, 
International, International except to home country, Off). 

• Caller ID: Lets you choose to whom your SGH-i907 will send your 
caller ID (Everyone, No one, Only to contacts). 
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• Call Forwarding: Lets you choose to forward incoming calls to your 
Voicemail or other number that you enter, and lets you set 
conditions under which incoming calls will be forwarded (No 
answer, Unavailable, Busy). 

• Call Waiting: Lets you choose whether or not to be alerted when 
you have a waiting incoming call. 

• Voicemail and Text Messages: Lets you change the access 
numbers for your Carrier’s Text message service center and 
Voicemail server. 

Note: These numbers are automatically setup when you receive your phone. 
You will probably not need to change them unless otherwise instructed 
by your carrier. 

3. Highlight the service you want to review or change, then 

select the Get Settings... button. 

4. Select new value(s) for the selected service, as needed. 

Note: For more information, refer to “Network Services”  on page 125. 

5. Press  or select  to save your new settings and 

return to the previous screen. 

Network Tab

1. From the Settings – 

Phone screen, select 

the Network tab. The 

Phone screen 

changes to show the 

Current network with 

which your phone is 

registered. 

2. To register with another available network, select the Find 

Network button. 

3. Press  or select  to save your new settings and 

return to the previous screen.

Security Tab

The Security tab lets you choose lock your phone and require that 
the PIN (Personal ID Number) must be entered to use it. The 
Security tab also lets you change the PIN, as needed.
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1. From the Settings – 

Phone screen, select 

the Security tab. The 

Phone screen 

changes to show 

your phone’s current 

automatic lock 

status. 

2. To lock/unlock your 

phone, select the Require PIN when phone is used check 

box. A check mark in the box indicates your phone is 

locked. 

3. To change your PIN, select the Change PIN button, then 

follow the prompts that display to complete the change.

4. Press  or select  to save your new PIN and 

return to the previous screen.

More Tab

The More tab lets you review and change a number of phone 
service-related settings on your phone. 

To access the phone settings:

1. From the Settings – 

Phone screen, select 

the More tab. The 

Phone screen 

changes to show a 

list of phone-service 

related settings. 

2. Change or set the 

following options: 

• Fixed Dialing: Lets you Enable/Disable FDN (Fixed Dialing Number) 
service. Also shows Contact entries stored as FDNs. 

• Change PIN2: Lets you change the PIN2 (Second Personal ID 
Number). Also shows the number of allowed change attempts 
remaining. 

• SIM Lock: Lets you Enable/Disable locked access to your SIM card. 

• CB Messages: Lets you Enable/Disable reception of CB (Cell 
Broadcast) messages, specify what message text Language(s) you 
will accept, and specify the Channel(s) from which you will accept. 
CB messages. Also lets you Add, Edit, and Delete CB messaging 
Channels to the list. 

• Auto Answer: Lets you choose how quickly (Off or after 3 sec., 5 
sec., or 10 sec.) your phone automatically answers incoming calls. 
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Note: Auto Answer only functions when your phone is in handsfree mode. 

• SDN: Lists the Service Dialing Numbers (SDNs) — such as, 
emergency numbers, customer service numbers, and directory 
inquiries — assigned by your Wireless Provider. 

Note: This menu is available only when your SIM card supports Service 
Dialing Numbers. 

• Own Number: Lists your numbers including up to two Voice Line 
numbers (by default, Voice Line 1 shows your mobile number), a 
Data number, and Fax number. You can edit any number in this list. 

3. Highlight the phone setting you want to review or change, 

then select the Get settings... button. 

4. Select or enter new value(s) for the selected phone setting, 

as needed. 

5. Press  or select  to save your new settings and 

return to the previous screen.

Today

The Today screens let you set an appearance Theme for the 
Today screen, and let you determine the Items to be displayed on 
the Today screen. 

System Settings
About

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ About ( ). 

Select the following tabs to display the desired 

information: 

• Version tab: Displays important device information, including the 
type of processor and the amount of memory. 

• Device ID tab: Displays the name used to identify the device to 
other computer.

• Copyrights tab: Displays information about copyrights.

3. Press  or select  to return to the previous 

screen.

Backlight

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Backlight 

( ) to access the various backlight usage parameters.

• Battery Power tab: Allows you to set the backlight on/off 
parameters.



77

• External Power tab: Allows you to set the backlight power save 
parameters that function when an external power source (such as a 
wall or car charger) is connected to your phone. 

• Keyboard tab: Allows you to set the keyboard backlight 
parameters.

• Brightness tab: Allows you to adjust the backlight brightness 
settings.

3. Press  or select  to save your changes and 

return to the previous screen. 

Certificates

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Certificates 

( ) to access information about different certificate 

type, select one of the following tabs:

• Personal: Used to identify yourself to others.

• Intermediate: Used to identify intermediate certification 
authorities.

• Root: Used to identify root certification authorities.

3. Press  or select  to save your changes and 

return to the previous screen. For more information, refer 

to “Managing Certificates”  on page 29.

Clock & Alarms

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Clocks & Alarms 

( ) to access the following time settings: 

Tip: You can also access the Clocks & Alarms screen by Time and Date 
display in the Today screen. 

• Time tab: Allows you to configure and assign the time and date for 
both your local and visiting regions. 

• Alarms tab: Displays the list of currently configured alarms and 
allows you to activate/deactivate a specific alarm entry from the list.

• More tab: Provide you with the options to Display the clock on the 
title bar in all programs, to Sound alarms even when the device 
is set to silent or vibrate, and for Time zone updating 
Automatically, Manually only, or when Prompted first (after you 
change the Time tab settings and press  or select ). 

3. Press  or select  to save your changes and 

return to the previous screen.
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Encryption

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Encryption 

( ) to open the Encryption screen. 

3. To enable encryption of information stored on microSD 

storage cards, select the Encrypt files when placed on a 

storage card check box. A check mark appears in the box. 

4. Press  or select  to save your changes and 

return to the previous screen.

Error Reporting

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Error Reporting 

( ) to open the Error Reporting screen. 

3. Select Enable error reporting to let your device collect 

operation information and, in the event of an error, pass it 

along to Microsoft. 

4. Press  or select  to save your changes and 

return to the previous screen.

Note: Enabling this option may incur data usage charges. 

External GPS

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ External GPS 

( ) to open the GPS Settings screen. The following tabs 

are available: 

• Programs: Lets select the GPS program port that programs on you 
phone will use to obtain GPS data. 

• Hardware: Lets you select the GPS hardware port to which your 
GPS device is connected, and then select the Baud rate at which 
your phone will communicate with the GPS device. 

• Access: Lets you enable/disable Windows Mobile management of 
resident program access to the GPS data by selecting/unselecting 
the Manage GPS automatically (recommended) check box.

3. Select the desired tab. 

4. Select new value(s) for the selected tab, as needed. 

5. Press  or select  to save your new settings and 

return to the previous screen.
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Finger Mouse

Finger Mouse lets you select the navigation functioning of the 
Navigation Pad. For more information, refer to “Finger Mouse”  
on page 43.

Memory

1. From the Today screen, press the Start key ( ) to 

activate the Start menu.

2. Select Settings ( ) ➔ System tab ➔ Memory 

( ) to open the Memory screen and select from one 

of the following information tabs:

• Main: Displays the Total, In use, and Free memory available on the 
phone for Storage and Programs. 

• Storage Card: Displays the Total, In use, and Free memory 
available on an optional microSD card for Storage. 

3. Select the desired tab and review the displayed 

information.

4. You can search for large files for possible deletion by 

selecting Find at the bottom of the Memory screen. The 

Search screen displays.

• Enter a Windows-style file name pattern and press the Search soft 
key. 

• Review the files returned to the screen for later deletion. 

5. Press  or select  to return to the previous 

screen.

Power

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Power ( ). For 

more information, refer to “Checking Battery Charge”  on 

page 7.

3. Press  or select  to return to the previous 

screen.

Regional Settings

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Regional 

Settings ( ) to open the Regional Settings screen 

where you can alter the following settings:

• Region tab: Displays the appearance of regional information based 
on the currently selected region.

• Number tab: Allows you to adjust regional numeric display settings.

• Currency tab: Allows you to adjust regional currency settings.
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• Time tab: Allows you to adjust the time format.

• Date tab: Allows you to adjust the date format.

3. Press  or select  to save your new settings and 

return to the previous screen.

Remove Programs

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Remove 

Programs ( ) to open the Remove Programs screen.

3. Highlight the programs you want to remove and then select 

the Remove button. For more information, refer to “Adding 

a Program Directly from the Internet”  on page 28.

4. Select Yes to confirm.

5. Press  or select  to save your new settings and 

return to the previous screen.

Screen

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Screen ( ) to 

open the Screen Settings screen where you can alter the 

following settings:

• Alignment tab: Allows you to assign the display orientation of the 
screen information and use the Align Screen feature to calibrate 
the touch screen.

• Clear Type tab: Allows you to choose whether the text on screen 
displays with smooth edges.

• Text Size tab: Allows you to change the size of the text displayed on 
screen to make it easier to read. Increasing the size of the text will 
reduce the amount of information displayed on the screen at any 
one time.

Version

Version displays important device information such as S/W 
Version (PDA, PHONE), Bluetooth and Wi-Fi versions. 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ System tab ➔ Version ( ).
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Connections Settings
Bluetooth

About Bluetooth

Bluetooth is a short-range wireless communications technology 
capable of exchanging information over a distance of about 30 
feet without requiring a physical connection.

Unlike infrared, you don't need to line up the devices to beam 
information with Bluetooth. If the devices are within a range of 
one another, you can exchange information between them, even 
if they are located in different rooms.

Bluetooth Service Profiles

Actually, the Bluetooth specification is a protocol that describes 
how the short-range wireless technology works, whereas 
individual profiles describe the services supported by individual 
devices. Profiles reduce the chance that different devices will not 
work together.
• For more information, refer to “Bluetooth Service Profiles”  on 

page 129.

Toggling Bluetooth On/Off

When the Bluetooth radio is turned on, you can use the Bluetooth 
features available. When the Bluetooth radio is turned off, you 
cannot send or receive information via Bluetooth. To save battery 
life or in situations where radio use is prohibited, such as airline 
traveling, you can turn off the Bluetooth wireless technology.

1. From the Today menu, select Start ➔ Settings  ➔  

Connections tab ➔ Wireless Manager.

The Wireless Manager screen displays.

2. Select Bluetooth to toggle Bluetooth On or Off. 

Note: Select the All button to toggle the active state of all three components 
simultaneously (Wi-Fi, Bluetooth, and Phone).

Bluetooth Off Bluetooth On
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3. Press the Menu soft key to display the following options:

• Disconnect Cellular Data

• Wi-Fi Settings

• Bluetooth Settings

• Phone Settings

4. Press the Done soft key to return to the Today Plus menu. 

You can now connect Bluetooth devices your SGH-i907.

Bluetooth Settings

The Bluetooth wireless technology settings menu provides the 
ability to view and change the device name, show the visibility, 
and set the security for the device.

For more information, refer to “Bluetooth Settings”  on page 130.

Adding a Bluetooth Device

The Bluetooth pairing process allows you to establish trusted 
connections between your phone and other Bluetooth devices.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu.

2. Select Settings ( ) ➔Connections tab ➔ Bluetooth 

( ).

3. Prepare your external Bluetooth device for communication 

and detection.

4. Select the Devices tab and select Add new device from the 

on screen list. Your phone displays a list of discovered 

Bluetooth devices that were detected within its 

communication range.

5. Select the device you wish to pair with and press the Next 

soft key.

6. Enter the numeric passcode and press the Next soft key. 

You are then notified the pairing is in progress.

7. Press the Done soft key to complete the process.

Connections

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ Connections 

( ) ➔ Advanced tab. 

3. To select the networks programs use to access the Internet 

or private networks, select the Select Networks button, 

then select the networks to be used. 
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4. To enable and select dialing rules for accessing networks 

and reduce the number of live connections, select the 

Dialing Rules... button. 

5. To specify any addressing exceptions used in intranets 

programs access, select the Exceptions... button. 

6. Press  or select  to save your new settings and 

return to the previous screen.

USB Connection Mode

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ USB 

Connection Mode ( ) to open the USB Connection screen 

and select from one of the following connection methods: 

• ActiveSync: Enables synchronization of your phone with your PC.

• Mass Storage: With a Storage Card inserted, enables a PC to store 
files directly onto your phone.

• Modem: Enables a PC to communicate through your phone acting 
as a wireless modem.

3. Press  or select  to save your new setting and 

return to the previous screen.

USB to PC

USB to PC allows you to change the type of USB connection your 
devices uses when having problems connecting to ActiveSync.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ USB to PC 

( ).

3. To correct connection problems when synchronizing your 

phone and PC with ActiveSync, select the Enable advanced 

network functionality check box. A check mark displays in 

the box. 

4. Press  or select  to save your new setting and 

return to the previous screen.

Wi-Fi

A Wi-Fi connection can be established by:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ Wi-Fi ( ) 

to open the Configure Wireless Networks screen.
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3. From the Wireless tab, filter the list of available networks 

by selecting the Networks to access field, then selecting a 

search parameter:

• All Available

• Only access points

• Only computer-to-computer

4. To add a new connection, press the Menu soft key and 

select Add New, or to edit the parameters, select an 

available connection. 

5. Enter a Network name for the new network connection, 

then select from the following options:

• Select one of the following security connection presets from the 
Connects to drop down: 

– Select The Internet if the network connects to the Internet (does not 
use proxy settings). 

– Select Work if the network does not connect to the Internet (uses proxy 
settings).

• If the network has SSID broadcasting disabled (is “hidden”), select 
This is a hidden network. 

• If the connection is for an ad-hoc network, select the This device is 
a device-to-device (ad-hoc) connection box.

6. Press the Next soft key to continue onto the Authentication 

and Data Encryption information. Use the information 

provided by your Network administrator to complete this 

section and press the Next soft key to continue.

7. Complete the process by selecting the appropriate security 

protocol parameters from the EAP type drop-down menu.

8. Press the Finish soft key to complete the process.

9. Select the Network Adapters tab to select a My network 

card connects to: (The Internet or Work) and modify an 

adapter from the list provided.

Wireless Manager

Wireless Manager allows you to turn on/off the following 
services, Wi-Fi, Bluetooth and Phone. You can also access 
Wireless Manager from the Today screen.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ Wireless 

Manager ( ). For more information, refer to “Toggling 

Bluetooth On/Off”  on page 81.
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Sound Settings
PDA/Phone Ringer Volume

You can set the volume for 
both PDA notifications and 
phone volume. To adjust 
these volumes, follow 
these steps:

1. Select the  icon 

located at the top of 

your screen. A menu 

displays with sliders 

to adjust both the 

PDA and phone ringer volumes.

2. Using the stylus, select the desired level on the slider 

located under Volume. The left slider controls the PDA 

volume and the right slider controls the ringer volume.

3. Select the  icon again to exit.

Note: You can also press and hold the slider tab and move it back and forth 
along the slider using the stylus.

Sounds and Notifications

The Sounds and Notifications settings allows you to select the 
actions for which you hear sounds and how to notify you when 
different events occur.

To view the sounds and notifications screen, follow these steps:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Sounds & 

Notifications ( ) ➔ Sounds tab.

3. Activate sound notifications for any of the following events 

by selecting:

• Events (warnings, system events)

• Programs and Notifications (alarms, reminders)

• Screen taps (Soft or Loud)

• Hardware buttons (Soft or Loud)

Note: When you enable a sound, your phone plays tones to notify you that an 
event has occurred. Refer to the following section below for a 
complete list of events for which you can select sounds.
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4. Select the Notifications tab to assign specific audio files (or 

vibrate) to play for specific applications or actions. Sounds 

can be set for each of the following events:

• Phone: Incoming Call

• ActiveSync: Begin sync

• ActiveSync: End sync

• Beam: Auto receive

• Connection disconnected

• Connection established

• Messaging: New e-mail message

• Messaging: New text message

• Phone: Missed call

• Phone: Voicemail

• Reminders

• Wireless network detected

5. Select  to save your changes and exit.

Setting an Event Notification

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Sounds & 

Notifications ( ) ➔ Notifications tab.

3. Select the event (other than “Phone: Incoming Call”) from 

the Event drop down menu. (For more information, refer to 

“Setting Your Phone’s Incoming Ringtone”  on page 86.) 

4. Select Play sound and/or Vibrate.

Note: You can also use Sounds & Notifications to set the ring type and ring 
tone settings of your phone. 

5. Select the check box next to Play sound to then designate a 

notification sound for that event from the provided drop 

down list. To sample the sound file, select the  button.

6. Select  to save your changes and exit.

Setting Your Phone’s Incoming Ringtone

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Sounds & 

Notifications ( ) ➔ Notifications tab.

3. Select Phone: Incoming Call from the Event drop down 

menu.
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4. Select the Ring type field and select the type of desired 

ringer/vibration combination from the drop down menu.

• The available notification options for this type of event are: Ring, 
Increasing ring, Ring once, Vibrate, Vibrate and ring, Vibrate 
then ring, or None.

5. Select the Ring tone field and select an available ringtone.

6. Select the Play button (below the Ring tone field) to play a 

sample of the currently selected ring tone. Press the Stop 

button to stop the sample playback.

7. Select  to save the new phone ringtone and type then 

return to the previous screen.

Turn Phone Volume Off

You can turn the ringer off, or you can select one of the other 
Ring tone options, such as Vibrate, Vibrate and ring, or Vibrate 
then ring.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Phone ( ).

3. Select the drop down arrow next to Ring type and select 

one of the Vibrate options or select None.

4. Select  to exit.

Screen Tap Vibration

In addition to event notifications and incoming call ringtones, you 
can also set the vibration length for screen taps. The phone 
defaults to On with a short vibration mode enabled, however, you 
can turn this feature off, or modify the vibration length by doing 
the following:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Sounds & 

Notifications ( ) ➔ Vibrations tab.

3. Select the Screen taps checkbox to disable the vibration for 

screen taps.

– or –

4. Select Short, Medium, or Long to modify the length of the 

screen tap vibration.

Setting a Phone Password
For more information, refer to “Locking the Phone”  on page 23. 
The password option allows you to enable or disable a password. 
The available settings are:
• Simple PIN: This password must be at least four characters in length 

and can not contain a simple sequence such as: 0000, 1111, or 1234.
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• Strong alphanumeric: This password must be at least seven 
characters in length and contain at least three of the following: 
uppercase/lowercase letters, numerals, and punctuation.

When a password is configured, there is a “Prompt if device 
unused for” option that allows a length of time range from 0 
minutes - 24 hours. When this option is set, you can continue to 
use the SGH-i907 until the screen turns off due to inactivity. If the 
device is inactive for a greater amount of time than specified in 
this setting, a password must be entered when you turn the 
device back on. 

To set the password:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Lock ( ). 

3. Select the check box next to Prompt if device unused for.

4. Select the Minutes drop down menu and select the amount 

of unused time required before you are prompted for a 

password if the phone becomes idle.

5. Select the Password type box and select either Simple PIN 

or Strong alphanumeric.

6. Select the Password box and use either your QWERTY 

keypad or keypad to enter the password you want. 

Re-enter the password in the Confirm box. 

7. Select , then select Yes to confirm. 
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Section 10: Microsoft Mobile Applications

This section introduces applications included with your phone. 
You can view different document formats with the document 
viewing tool, access word processing and spreadsheets 
documents, and even instant message others using the 
preloaded applications on your Samsung SGH-i907.

Mobile Applications
The SGH-i907 is an integrated communication device with the 
power of a mobile phone and the intelligence of a PC. The 
SGH-i907 is loaded with familiar Microsoft® Office Mobile, like 
Pocket Outlook, Pocket Internet Explorer, MSN® Messenger, 
Windows® Media™ Player for SGH-i907, Word Mobile & Excel, 
and several specialty applications. 

Microsoft Mobile Applications
Internet Explorer

You can use Internet Explorer to view web pages in two different 
ways: 
• By downloading pages and then performing an ActiveSync operation.
• By connecting to the Internet Directly via your wireless data 

connection.

While browsing you can also download new files and programs. 

Launch Internet Explorer

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Internet Explorer ( ).

Note: Microsoft Pocket IE does not support all browser functions supported 
by a PC. Therefore, browser functions might not work properly in some 
Internet sites.

Save Favorites

When you find a web page that contains useful or interesting 
information, it can be saved as a favorite.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Internet Explorer ( ).

3. Enter the web address into the Address field and select 

. 

4. Press the Menu soft key and select Add to Favorites....

5. Select the Name field and use one of the text entry 

methods to enter a bookmark name.
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6. Select the Create in field and choose a bookmark storage 

location (Mobile Favorites).

7. Select Add to store the bookmark and return to the web 

page.

- or -

Press  or select  to save the information and 

return to the active web page.

Office Mobile
Excel Mobile

Excel Mobile works with Microsoft Excel on your computer to 
give you easy access to copies of your workbooks. You can 
create new workbooks or copy workbooks from your computer to 
your handset. Synchronize workbooks between your computer 
and your handset to ensure that you have the most up-to-date 
content in both locations. Excel Mobile also provides fundamental 
spreadsheet tools, such as formulas, functions, sorting, and 
filtering.

Create a New Workbook

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Office Mobile ( ) ➔ Excel Mobile ( ). 

• If there are no workbooks on this device, a new workbook 
automatically displays. 

• If there are existing workbooks on this device, the file access screen 
displays. To create a new workbook, press the New soft key. 

3. Construct your spreadsheet(s). (For more information, refer 

to “Entering Text” on page 46 and to the Excel User Guide.) 

4. When you are finished, press  or select  to save 

your workbook and exit. 

Note: You can open only one workbook at a time. If you try to open a second, 
you are asked to save the first workbook. 

Delete a Workbook

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Office Mobile ( ) ➔ Excel Mobile ( ). The 

file access screen displays. 

3. Move the cursor over the workbook you want to delete, 

then press and hold . A pop-up menu displays. 

4. Select Delete. You are prompted to confirm the deletion. 

5. Select the Yes button to confirm the deletion. 
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Beaming a Workbook

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Office Mobile ( ) ➔ Excel Mobile ( ). The 

file access screen displays. 

3. Move the cursor over the workbook you want to beam, 

then press and hold . A pop-up menu displays. 

4. Select Beam File.... 

5. Select the device to which you want to beam the 

workbook. 

6. When finished, press  or select  to exit the 

screen. 

OneNote Mobile

OneNote Mobile is a digital notebook that allows you to gather, 
store, and manage information in a single location.

Create a Note

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Office Mobile ( ) ➔ OneNote Mobile ( ). The 

file access screen displays. 

• If there are no notes on this device, a new note automatically 
displays. 

• If there are existing notes on this device, the file access screen 
displays. To create a new note, press the New soft key. 

3. Construct your note(s). (For more information, refer to 

“Entering Text” on page 46 and to the OneNote User 

Guide.) 

4. Press Menu to select formating options.

5. When you are finished, press  or select  to save 

your note and exit. 

PowerPoint Mobile

PowerPoint Mobile works with Microsoft PowerPoint on your 
computer to give you easy access to copies of your 
presentations. You can create new presentations or copy 
presentations from your computer to your handset. Synchronize 
presentations between your computer and your handset to 
ensure that you have the most up-to-date content in both 
locations. 

Show a Presentation

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 
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2. Select Office Mobile ( ) ➔ PowerPoint Mobile ( ). 

The file access screen displays. 

3. If needed, select the folder where the presentation you 

wish to show resides. 

4. Select the desired presentation to begin showing it. 

• To advance to the next slide, press . 

• To end the slide show, press and hold , then select End Show. 

Delete a Presentation

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Office Mobile ( ) ➔ PowerPoint Mobile ( ). 

The file access screen displays. 

3. If needed, select the folder where the presentation resides. 

4. Move the cursor over the presentation you want to delete, 

then press and hold . A pop-up menu displays. 

5. Select Delete. You are prompted to confirm the deletion. 

6. Select the Yes button to confirm the deletion.

Word Mobile

Word Mobile works with Microsoft Word on your computer to give 
you easy access to copies of your documents. You can create 
new documents or copy documents from your computer to your 
handset. Synchronize the documents between your computer 
and your handset to ensure you have the most up-to-date 
content in both locations.

Use Word Mobile to create documents, such as letters, meeting 
minutes, and trip reports. 

Create a New Document

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Office Mobile ( ) ➔ Word Mobile ( ). 

• If there are no documents on this device, a new document 
automatically displays. 

• If there are existing documents on this device, the file access 
screen displays. To create a new document, press the New soft 
key. 

3. Enter text using the desired character input method. (For 

more information, refer to “Entering Text”  on page 46.) 
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4. When finished, press  or select  to save and 

exit. 

– or – 

Press the Menu soft key, then select File ➔ Save As... to 

save your document with a specific name, folder, type, and 

location. 

You can open one document at a time. If you try to open a second 
document, you are asked to save the first document. 

You can save a document in any one of the following formats:
• Word Document (*.docx)
• Word Template (*.dotx)
• Rich Text Format (*.rtf)
• Plain Text (*.txt)

Accessing Word Mobile options

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Office Mobile ( ) ➔ Word Mobile ( ).

• If there are no documents on this device, a new document 
automatically displays. 

• If there are existing documents on this device, the file access 
screen displays. 

3. Press the Menu soft key and select Options.... The following 

options are available:

Note: While viewing a document, access the Options menu by pressing the 
Menu soft key, then selecting Tools ➔ Options... 

• Default template - Allows you to select Meeting Notes, Memo, 
Phone Memo, To Do, Word 97–2003 document, and Word 
Document as the default document. 

• Save to - Allows you to select Main memory as the default 
document storage card.

• Display in list view - Allows you to display Word files, Rich Text 
Files, Plain Text Files, All Known File Types.

4. When finished, select  to save and exit.

Delete a Document

To delete a Word Mobile document:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select  Office Mobile ( ) ➔ Word Mobile ( ).

3. Select the folder where the document resides. 

4. Move the cursor over the document you want to delete, 

then press and hold . A pop-up menu displays. 

5. Select Delete. You are prompted to confirm the deletion. 
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6. Select the Yes button to confirm the deletion.

Beaming a Document

To beam a document to another Windows Mobile device user:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Office Mobile ( ) ➔ Word Mobile ( ).

3. Select the folder where the document resides

4. Move the cursor over the document you want to beam, 

then press and hold . A pop-up menu displays. 

5. Select Beam File.... 

6. Select the device to which you want to beam the 

document. 

7. Press  or select  when finished to exit the 

screen.

Windows Media Player
Use Microsoft Windows Media Player® to play digital audio and 
video files that are stored on your device or downloaded from the 
internet. You can play files in either Windows Media or MP3 
format, including files with extensions: .wma, .wmv, and .mp3.

Launch Media Player

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ AT&T Music ( ) ➔ 1 Windows 

Media ( ).

Load Media Player files

Media player files must be copied to the handset using the 
ActiveSync application or copied or saved to a microSD card 
(maximum 16 GB). The files are copied to the Local Content 
folder on the handset after the ActiveSync operation. 

To load a file:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ AT&T Music ( ) ➔ 1 Windows 

Media ( ).

3. Press the Menu soft key and then select Library.

4. Use the File System screen to locate your desired 

multimedia file. 
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5. Select the desired file from the list and press the Play soft 

key. The Widows Media screen displays and the selected 

file plays. 

Media Player Controls

The following settings are 
available in the media 
player:
• Select Play ( ) to listen to 

a file. The Play icon turns 
into the Pause icon ( ) 
once the file begins playing. 

• Select Rewind ( ) and 
Fast Forward ( ) during 
playback or while paused to 
skip back to the beginning of the current file and to skip ahead to the 
end. Select either control a second time to begin playback of a 
preceding or succeeding file in the current folder. 

• This slider control above the control icons adjusts the playback 
progress of the selected file.

• The volume controls (  and ) adjust the sound level during 
playback.

• Select Mute ( ) to toggle between mute on and off. 

Playlist

Windows Media player allows you to configure personal playlists 
with your favorite music or video files. Playlists group media 
content and store the location of media content, whether the 
location is your computer, a network, or the Internet. Playlists 
typically have an .asx file extension.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ AT&T Music ( ) ➔ 1 Windows 

Media ( ).

3. Press the Menu soft key, then select Library ➔ My Playlists.

4. Select a file and select the Play soft key.

Camera and Video
This menu allows you to take new Pictures or record new Videos 
using your phone’s camera. You can also view saved pictures and 
videos. 

Take Pictures

1. Press the Camera key ( ). 
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 The camera viewfinder screen displays. 

2. Press the Menu soft key to choose the specific camera 

options and settings. 

3. Select an option or setting, then select a value. 

• Options 

– Mode: Camera, Camcorder. 

– Shooting mode: Single Shot, Multi Shot, Mosaic Shot, Night Shot, 
Panorama Shot. 

– Size: 1600x1200, 1280x960, 1024x768, 640x480, and 320x240. 

– Timer: Off, 2 seconds, 5 seconds, 10 seconds. 

– White balance: Automatic, Daylight, Cloudy, Tungsten, Fluorescent. 

– Effect: No Effect, Black and White, Sepia, Green, Aqua, Negative. 

– Video Share: Makes a voice call and launches Video Share. (For more 
information, refer to “Video Share”  on page 41.) 

• Settings (1/2) 
– Camera timeout: 1 min, 2 min, or 3 min. 

– Automatic save: Turn Auto Save Off or On. 

– Quality: Super fine, Fine, Normal, Economy. 

– Multi-shot number: 3 shots, 6 shots, or 9 shots. 

– Default storage: My device or Storage card (microSD – optional). 

• Settings (2/2) 
– Shutter sound: The sound you hear when you press  or  

or select  to take a photo. Select shutter one, shutter two, 
crystal, dingdong, great, or ok.

– Brightness sound: The sound you hear when you increase or 
decrease picture brightness. Select bright one or Off. 

– Zoom sound: zoom one or Off. 
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– Recording sound: The sound you hear when you press  or 
 or select  to start/stop video recording. Select musical one, 

musical two, or woman one. 

– Version: Shows the version of the Samsung Camera software. 

4. You can also access the camera options and settings by 

selecting the respective icons on the viewfinder screen: 

5. Press  or  or select  to take a picture. 

6. Select the Cancel button to delete the current photo and 

take another, or select the Save button to store the picture 

to the gallery. 

Record a Video

1. Press the Camera 

key on the right side 

of the phone. The 

camera is now 

active. 

2. Select  ➔ 

 to 

activate the 

camcorder.

Mode: Indicates Camera mode. Select to switch 
between Camera mode and Camcorder mode. 

Shooting Mode: Indicates Single Shot mode. 
Select to switch between Single shot, Multi 
shot, Mosaic shot, Night shot, Panorama Shot. 

Size: Indicates 1600x1200 resolution. Select to 
switch between 1600x1200, 1280x960, 
1024x768, 640x480, and 320x240.

Timer: Indicates Timer is off. Select to switch 
between Off, 2 seconds, 5 seconds, 
10 seconds.

White Balance: Indicates White Balance is set to 
automatic. Select to switch between Auto, 
Daylight, Cloudy, Tungsten, and Fluorescent.

Default Storage: Indicates whether photos are 
to be saved to phone memory (as shown) or to 
an optional Storage Card. 

Available Memory: Displays the amount of 
memory available to store photos.
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3. Press the Menu soft key to choose the specific camcorder 

settings. 

4. Select an option or setting, then select a value. 

• Options 

– Mode: Camera, Camcorder. 

– Size: 320x240 or 176x144. 

– Timer: Off, 2 seconds, 5 seconds, 10 seconds. 

– White balance: Auto, Daylight, Cloudy, Tungsten, and Fluorescent

– Effect: No Effect, Black and White, Sepia, Green, Aqua, Negative. 

– On/Off: Enables/disables sound recording. 

– Video Share: Makes a voice call and launches Video Share. (For more 
information, refer to “Video Share”  on page 41.) 

• Settings (1/2) 
– Camera timeout: 1 min, 2 min, or 3 min. 

– Automatic save: Turn Auto Save Off or On. 

– Quality: Super fine, Fine, Normal, Economy. 

– Multi-shot number: 3 shots, 6 shots, or 9 shots. 

– Default storage: My device or Storage card (microSD – optional). 

• Settings (2/2) 
– Shutter sound: The sound you hear when you press  or  

or select  to take a photo. Select shutter one, shutter two, 
crystal, dingdong, great, or ok.

– Brightness sound: The sound you hear when you increase or 
decrease video brightness. Select bright one or Off. 

– Zoom sound: zoom one or Off. 

– Recording sound: The sound you hear when you press  or 
 or select  to start/stop video recording. Select musical 

one, musical two, or woman one. 

– Version: Displays Samsung Camera software version. 

5. You can also access the camcorder options and settings by 

selecting the respective icons on the viewfinder screen: 

Mode: Indicates Camcorder mode. Select to 
switch between Camera mode and Camcorder 
mode. 

Size: Indicates 320x240 resolution. Select to 
switch between 320x240 and 176x144. 

Timer: Indicates Timer is off. Select to switch 
between Off, 2 seconds, 5 seconds, 
10 seconds. 

White Balance: Indicates White Balance is set to 
automatic. Select to switch between Auto, 
Daylight, Cloudy, Tungsten, and Fluorescent. 

Sound: Indicates sound recording is on. Select 
to switch from On to Off. 
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6. Press  or  or select  to record a video. 

7. Select the Cancel button to delete the current video and 

take another, or select the Save button to store the video to 

the gallery.

Pictures

My Pictures stores images taken with your phone.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ My Stuff ( ) ➔ My 

Documents ➔ My Pictures.

3. Select an image from the My Pictures screen.

4. Press the Menu soft key to display the following options for 

that image:

• Play Slide Show: Allows you to view a series of pictures from the 
currently selected folder. 

• Send: Lets you send the image in a Multimedia Msg., in an e-mail, 
over a Bluetooth connections, or to HP’s Snapfish web site. 

• Set as: Sets the image as Today Background or Caller ID.

• Delete: Erases the picture from the gallery. 

• Crop: Lets you crop the selected image.

• Edit Image: Allows you to Cut, Copy, Paste, Select/Deselect, 
Select All, Select None, Rename, or place the image or video in a 
new folder. You can Flip, Rotate, and Resize the image, and change 
Brightness, Contrast, and Effect.

• Print via Bluetooth: Allows you to print the selected image on a 
Bluetooth enabled printer.

• Properties: Provides the Name, File Type, Dimensions, File Size, 
Date Created. 

• Slide Show Options... Sets slide show to Repeat (On) or not (Off), 
slide view Duration (3 Sec, 5 Sec, or 10 Sec), Transition Effect [No 
effect, Wipe (right, left, up, or down), Cover (right, left, up, or down), 
BindHorz, BindVert, Stretch (right, left, up, or down), Strew (random, 
right, left, up, or down), Clock (right or left), Show (ellipse or 
diamond), or Random], and/or Show direction (Forward, Backward, 
or Random). 

Default Storage: Indicates whether videos are to 
be saved to phone memory (as shown) or to an 
optional Storage Card. 

Available Memory: Displays the amount of 
memory available to store videos.
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Videos

Video stores video taken with your phone.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ My Stuff ( ) ➔ My Documents 

➔ My Videos.

3. Highlight a video from the Videos screen.

4. Press the Menu soft key to display the following options for 

that video:

• Send: Lets you send the image in a Multimedia Msg. or over a 
Bluetooth connection. 

• Set as: Sets the video as Today Background, Caller ID, or Ringtone.

• Delete: Erases the video from the gallery. 

• Edit: Allows you to Cut, Copy, Paste, Select/Deselect, Select All, 
Select None, Rename, or create a New Folder for the video.

• Sort by: Allows you to sort the videos by Name, Date, or Size.

• Add to Now Playing: Adds the highlighted video to the Now 
Playing list.

• Properties: Provides the Name, Type, Size, Date, and Length.

• Slide Show Options: Allows you to set the slide show to Repeat, 
change the Duration, choose Transition Effects, and change the 
Show Direction.

Application Management
Your SGH-i907 is powered by Windows MobileTM 6.1 Software 
for SGH-i907 Phone Edition, which allows installation and 
removal of any SGH-i907-compatible application on your device. 
SGH-i907 applications can be downloaded from the web, or 
purchased at retail outlets.

Install New Applications

When a new application is downloaded from the web or installed 
using a CD, the files are transferred to the mobile device via 
ActiveSync. ActiveSync checks if enough memory is available 
before installing a program. To free up memory, simply remove 
old programs or delete unused files. For more information, refer 
to “Synchronization”  on page 115. 

Delete an Application

Some applications are large and take up space on your handset. 
To help manage space and memory requirements for other 
software that may need to be installed, you can delete any 
application not required for your device to operate correctly. To 
delete an application:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu.

2. Select Settings ( ) ➔ System tab ➔ Remove Programs 

( ).
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3. Select the program from the list and select the Remove 

button. For more information, refer to “Remove Programs”  

on page 80.

4. Select Yes to confirm.

5. Select  to save your changes and return to the 

previous screen. 

Task Manager

Windows MobileTM 6.1 includes a mobile version of Task 
Manager that lets you review the applications running on your 
handset and, if needed, stop them running. 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs 

( ) ➔ 

Applications ( ) 

➔ Task Manager 

( ). The Task 

Manager screen 

displays.

3. To end a task, highlight the task and press the End Task 

soft key.

4. Press the Menu soft key to access the following options:

• Switch To: switches to and displays the selected application.

• End All Tasks: ends all the tasks that are running.

• View: Allows you to view Applications or Processes.

• Sort By: Allows you to sort how applications are viewed, by 
Memory, CPU, or Name.

• Refresh: Refreshes the screen display.

• Exit: Exits the Task Manager screen.

5. Press  or select  when finished to exit the 

screen.

Help
The Help menu provides basic on-line assistance which answers 
most of the common issues users encounter while using this 
device.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu.

2. Select Help ( ).?
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3. Select Contents.

The Table of Contents displays.

4. Touch a subject in the Table of Contents to launch the 

associated Help content.

– or –

5. Touch Search and select the Search for drop-down menu to 

select a subject in which to search. Select the Type 

dropdown and select a type of information in which to 

search.

6. Touch Search.

The result of the search displays in the Results field.
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Section 11: Personal Organizer

The topics in this section allow you to schedule appointments, 
view the calendar, create task lists, set an alarm, perform simple 
math calculations, and setup up your phone so you can 
synchronize your files and folders with your desktop.

Today Screen
The Today screen is used to provide SGH-i907 overview 
information. When the handset is initially turned on, the Today 
screen displays the following:

1. Start Menu

2. Title Bar

3. Digital Clock

4. Day and Date

5. Get Xpress Mail shortcut

6. Instant Messaging shortcut

7. Messaging icon (Messaging shortcut) 

8. Appointments shortcut

9. Device locked/unlocked (If the device is unlocked, 

selecting this option locks it. If the device is locked, 

selecting the Left soft key causes the Unlock screen to 

appear.)

10. Phone soft key (launches Phone list)

11. Contacts soft key (launches Contacts list)

1

2

3

5

6

7

8

9

4

10 11
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Date and Time Settings

Clock settings can be accessed from the Today screen by 
selecting the on-screen clock. Clock settings allow you to set the 
current time, time zone, date for either your home or visiting 
location.

1. From the Today screen, select the clock. The Clock & 

Alarms screen displays. 

2. Select the Time tab 

and activate either 

the Home or Visiting 

field. 

3. Select the time zone 

using the adjacent 

drop down arrow. 

4. From the time field, 

select the up or 

down arrow to set the current time.

5. From the date field, select the drop down arrow to set the 

current date.

6. Press  or select  to save the information and 

exit.

Note: The time on the SGH-i907 handset does not automatically change 
when you travel to another time zone. To ensure that you don’t miss 
appointments, change your clock setting to Visiting and then select the 
appropriate time zone.

Scheduling an Alarm 
Your phone has three alarm clocks that can be configured to ring 
daily at a desired time. To set up the alarm clock:

1. From the Today screen, select the clock. The Clock & 

Alarms screen displays. 

2. Select the Alarms 

tab.

3. Select the box next 

to the desired alarm. 

A check mark 

appears in the box. 

4. Select the days of 

the week the desired 

alarm will be active. 

To select multiple days, select each entry in turn, 

highlighting it. 
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5. Select the time to display the time settings. Select the up 

or down arrows provided for each part of the time (Hour, 

Minute, AM/PM) to select the desired time.

Note: Select the AM or PM to cycle between them.

6. Press  or select  to store the new time. 

7. Press  or select  again to save the alarm and 

exit.

Wireless Manager

The Wireless Manager displays the status of the Phone, Wi-Fi, 
and Bluetooth.

� To use the Wireless Manager, do one of the following: 

• From the Today screen, select Start ➔ Settings ➔  
Connections tab ➔ Wireless Manager. 

– or –

• Activate the Today Plus screen, then select the Wireless 
Manager section of the display to turn features on 
individually or all at once.

The Wireless Manager screen displays. 

Wi-Fi Status

The Wireless Manager Wi-Fi Status indicators let you know if Wi-
Fi is turned On or Off. For more information about the Wi-Fi 
connections, see “Bluetooth and Wi-Fi Services” on page 129.

Bluetooth Status

The Wireless Manager’s Bluetooth Status indicators let you know 
if Bluetooth is turned On or Off. For more information about the 
Bluetooth connections, see “Bluetooth and Wi-Fi Services” on 
page 129.
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Owner Information

Owner Information is where you can store information on the 
owner or user of the device. Name, Company, Address, 
Telephone, E-mail, and Notes information fields are available.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Owner 

Information ( ). The Owner Information screen displays. 

3. Select each field to activate it, then enter your information 

into the respective fields. 

4. Select the Notes tab and enter any personal notes 

applicable to the owner.

5. Select the Options tab and configure whether you would 

like to display the Identification information and Notes while 

the phone is active.

6. Press  or select  to save your information and 

return to the previous screen.

Calendar
The calendar allows you to create appointments and reminders 
for the day, week, month, or year.

Appointments and Events

An entry in the calendar is called an appointment or reminder. 
When you schedule an entry, a description displays on the time 
line, and the duration is set to 15 minutes by default. You can 
easily change the start time and duration for any event. You can 
schedule the following types of events in the calendar:
• Timed appointments, such as birthdays and meetings, which have a 

specific date, start, and end time.
• Untimed reminders, such as holidays, and anniversaries. These occur 

on a particular date but have no specific start or end times; they 
appear at the top of the list of times in a shaded area. You can 
schedule more than one untimed event on the same date.

• Repeating appointments, such as a weekly meeting that is held on the 
same day at the same time each week.

• Continuous appointments, such as a vacation or three-day conference.
• All day events, which reflect the default length of the day as set by the 

user.

Scheduling an Appointment

You can schedule timed appointments for the current date or for 
future dates. 

To schedule a timed appointment for the current date:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 
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2. Select Calendar ( ). 

3. Press the Menu soft key, then select New Appointment.

4. Enter the Subject of the appointment or press the drop 

down arrow to display a list of selectable preset subject 

from which to choose.

5. Select the Location field and enter the location information, 

if necessary.

6. Select the Starts and Ends fields for date and select a 

respective date from the on screen calendar.

7. Select the Starts and Ends fields for time and enter a 

respective time for the beginning and ending time for the 

appointment.

8. Select Yes or No from the All Day setting field.

Note: If Yes is selected in All Day the time is automatically removed in the 
start and end times to indicate that there is no time limit. 

9. Select the Occurs box to select the frequency of this 

events’ occurrence.

10. Select the Reminder box and select either None or Remind 

Me. If the Remind Me option was selected, enter the 

amount of time before your event which the phone should 

begin reminding you.

11. Select Categories and select either Business, Holiday, 

Personal or Seasonal. 

• You can also add a new category, by selecting the New soft key. 
Use the keyboard to enter the name and select the Done soft key 
when finished.

12. Select the Attendees field to invite others to the 

appointment from your contacts. Contacts must have an E-

mail address to be added as an attendee.

13. Select the Status field and select either Free, Tentative, 

Busy, or Out of Office as your displayed status during the 

event.

14. Select the Sensitivity field and select either Normal, 

Personal, Private, or Confidential to denote the status of 

this appointment/event.

15. Press  or select  to save your new appointment 

and return to the previous screen. 
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Change the Calendar View

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Calendar ( ). The Calendar defaults to the 

Agenda view. 

3. Press the Left soft key to toggle and show other views 

such as:

• Agenda - Displays a list of the current day’s appointments.

• Day - Displays the current day with the times of any appointments 
blocked out.

• Week - Displays an entire work week’s appointment schedule 
(Monday thru Friday).

• Month - Displays entire month’s appointment schedule.

• Year - Displays entire year’s appointment schedule. Appointment 
dates are highlighted to indicate events on that day.

4. Press  or select  to exit and return to the 

previous screen.

Calendar Options

Calendar options allow you to select what day of the week your 
calendar starts upon, whether you view a 5-day, 6-day, or 7-day 
week, options for reminders, and more. 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Calendar ( ). 

3. Press the Menu soft key, then select Tools ➔ Options to 

open the Calendar Options screen.

4. Select the Start in field to select a start up calendar view 

from the drop down menu. When the Calendar application 

is launched, this will be its initial display mode. For more 

information, refer to “Change the Calendar View”  on 

page 108.

5. Select the 1st day of week field to select the day that you 

want the calendar to start on, either Sunday or Monday.

6. Select the Week view field to select from either a 5-day, 6-

day, or 7-day week.
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7. To display more details regarding the length of time for 

each event by viewing half hour slots, select the check box 

adjacent to the Show half hour slots option.

8. To show the number of the week in your calendar, select 

the check box adjacent to the Show week numbers option.

9. To set the reminder parameters for new calendar items, 

select the Appointments tab, then select the check box 

adjacent to the Set reminders for new items option.

10. Select the reminder time and increment from the drop 

down boxes beneath Set reminders for new items option.

11. Select and highlight those icons you wish to be displayed 

in the calendar for particular reminders.

12. Send meeting requests via field’s only option is the default 

method for sending meeting requests: Outlook E-mail.

13. Press  or select  to save your settings and 

return to the calendar.

Tasks List
A task is something that needs to be done in a certain amount of 
time and requires a reminder once the deadline has been 
reached. Once a task is complete, it can be checked off and 
another task can be started. A task list can be set up to keep 
track of tasks. Tasks can also be prioritized, so that higher 
priority items are finished first.

Create a New Task

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Tasks 

( ).

3. Press the Menu soft key, then select New Task.

4. Enter the Subject for the task. 

– or – 

Select the drop down arrow to display a list of selectable 

preset subjects from which to choose.

5. Select the Priority field and select either: High, Normal, or 

Low.

6. Select the Status box and select Not Completed or 

Completed.
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7. Select the Starts box and from the on screen calendar, 

select the starting date.

8. Select the Due box and from the on screen calendar, select 

the ending date.

9. Select the Occurs box and select how often the task 

reoccurs.

10. If you would like a reminder of when the task is due, select 

the Reminder box and select Remind me.

• You will also need to select the corresponding date and time field to 
setup a a date for the early reminder to begin its notification. 

11. Select Categories and select either Business, Holiday, 

Personal or Seasonal. 

• You can also add a new category, by selecting the New soft key. 
Use the keyboard to enter the name and select the Done soft key 
when finished.

12. Select the Sensitivity box and select either: Normal, 

Personal, Private, or Confidential.

13. Press  or select  to save the task.

When the task is saved, it is added to the task list. The task list 
allows you to sort the tasks based on priority level, subject, start 
date, due date, or status.

Mark a Task Complete

When a task is completed, a checkmark is used to indicate the 
item has been completed.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Tasks 

( ).

3. Locate the desired task from the list, and select the check 

box located to the left of the task entry. 

Task Options

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Tasks 

( ).

3. Press the Menu soft key, then select Options. The following 

task options are available in the task list:

• Set reminders for new items - If this option is selected, an alert is 
automatically created when a new task is created.

• Show start and due dates - If this option is selected, the start and 
due date displays in the task list.
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• Show Tasks entry bar - If this option is selected, a bar is placed at 
the top of the screen to allow you to create a new task without 
navigating through the menu. For more information, refer to “The 
Task Entry Bar”  on page 111.

The Task Entry Bar

The task entry bar option automatically places a bar at the top of 
the screen to allow you to create a new task without navigating 
through the menu. You simply select the bar and enter a name to 
create a new task. This option does not put in any start or end 
times. To enter any additional information you need to edit the 
task.

Activate the Entry Bar

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Tasks 

( ).

3. Press the Menu soft key, then select Options ➔ Show 

Tasks entry bar box. 

4. Press  or select  to save your change.

Editing a Task

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Tasks 

( ).

3. Select the desired task from the task list to open it.

4. Select the Edit soft key to launch the Task tab and begin 

updating the information. For more information, refer to 

“Create a New Task”  on page 109.

5. When finished, press  or select  to save the 

updates and exit.

Adding a Note to a Task

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Tasks 

( ).

3. Select the desired task from the task list to open it.

4. Select the Edit soft key to launch the Task tab.

5. Select the Notes tab and enter text.
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6. When finished adding the note, press  or select  

to save and exit.

Deleting a Task

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Tasks 

( ).

3. Select and hold the desired task from the list and select 

Delete Task.

- or -

Press the Menu soft key and select Delete Task.

4. Select Yes to confirm the deletion of the selected task.

Beaming a Task

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Tasks 

( ).

3. Select and hold the desired task from the list and select 

Beam Task.

- or -

Press the Menu soft key and select Beam Task. 

4. From the list of detected devices, select the preferred 

device to begin the beaming/upload process.

5. When the task is successfully transferred, Done displays 

on the screen.

6. When finished, press  or select  to exit.

Notes
Quickly capture thoughts, reminders, ideas, drawings, and phone 
numbers with Notes. Notes can be attached to contacts, 
appointments, messages, and tasks. Notes can be either 
recorded or written. For more information, refer to “Adding a 
Note to a Task”  on page 111.

Recording an Audio Note

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Notes 

( ). 
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3. Press the New soft key. 

4. Press the Menu soft key, and select View Recording Toolbar. 

The recording toolbar then displays at the bottom of the 

Notes screen.

5. Select  to start recording, and then select  to 

stop.

Record Yourself During a Call

During a call you can record yourself speaking to another caller, 
so you can save directions or a phone number. 

1. Make a call to the desired person.

2. During the conversation, press the Menu key, then select 

Create Note. 

3. Press the Menu soft key, and select View Recording Toolbar.

4. Press Record ( ) begin recording. 

5. When finished, press Stop ( ) to stop recording. 

6. End the call.

Note: The call needs to be disconnected to listen to the recording. If the call 
is still connected, there is no audio. 

7. To listen to the recording, select the entry from the notes 

list. 

Write a Note

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Notes 

( ). 

3. Press the New soft key. 

4. Compose your note, then press  or select  to 

save your note and return to the previous screen. 

Delete a Note

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Notes 

( ). 

3. Select and hold the note you want to delete from the list 

and select Delete.

– or – 

Select the note to open it, select the Menu soft key, select 

Delete.
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4. Select Yes to confirm the deletion.

Note Options

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ Notes 

( ). 

3. Press the Menu soft key and select Options... to access the 

following Note options:

• Default mode - This option allows you to select a default note entry 
mode: Writing or Typing.

• Default template - Allows you to select a Blank Note, Meeting 
Notes, Memo, Phone Memo, or To Do as the default note type.

• Save to - Allows you to select Main memory or a Storage Card as 
the default note storage location.

• Record button action - Allows you to choose what action is taken 
by pressing the record icon: Switch to Notes or Stay in current 
program.

4. Press  or select  to save your changes and 

return to the previous screen.

Calculator
The calculator allows you to perform general mathematical 
functions, such as addition, subtraction, multiplication, and 
division. You can use the calculator to perform basic calculations, 
store and retrieve values, and display the last series of 
calculations.

Using the Calculator

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Organizer ( ) ➔ 

Calculator ( ).

3. Select your desired numbers and functions.

4. When finished, press  or select  to exit.
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Section 12: Synchronization

This section describes Using Microsoft® ActiveSync®, you can 
synchronize data on your desktop computer with the data on 
your phone. Synchronization compares the data on your phone 
with your desktop computer and updates both your phone and 
computer with the latest data.

Note: Access the Microsoft web site (http://www.microsoft.com/
windowsmobile/activesync/activesync45.mspx) to download Active Sync 
4.5 or later.

Active Sync
With ActiveSync, you can:
• Keep Contacts, Calendar, Tasks, or Inbox data up-to-date by 

synchronizing your phone with Microsoft® Outlook data on your 
desktop computer.

• Copy (rather than synchronize) files between your phone and desktop 
computer.

• Control the moment when synchronization occurs by selecting a 
synchronization mode.

• Select data types to be synchronized and control the amount of 
synchronized data.

ActiveSync - System Requirements

To use ActiveSync 4.5 your computer must meet the following 
hardware and software requirements:
• Vista, Microsoft Windows XP, Windows 2000, Windows Millennium 

Edition, or Windows NT Workstation 4.0 with SP6 or later.
• Microsoft Internet Explorer 6.0 or later. 
• Hard-disk drive with 12 to 65 MB of available hard-disk space (actual 

requirements will vary based on selection of features and user's 
current system configuration). 

• USB port (1.0 or higher).
• A CD-ROM drive. 
• VGA or compatible video graphics adapter at 256 colors or more. 

Installing Microsoft ActiveSync® on your computer

Before beginning synchronization, you must install 
Microsoft®ActiveSync® on your computer.

1. Insert the Getting Started CD into the computer’s CD drive.

2. Click the Setup and Installation link from the onscreen disc 

menu.

http://www.microsoft.com/windowsmobile/activesync/activesync45.mspx
http://www.microsoft.com/windowsmobile/activesync/activesync45.mspx
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3. Click the Install button to begin installation. 

Tip: You can also download the latest version of ActiveSync from the 
Microsoft web site, http://www.microsoft.com/windowsmobile/en-us/help/
synchronize/device-synch.mspx.

Important!:  If the ActiveSync option is grayed out, the application is already 
installed. Uninstall any previously installed version before 
completing this installation.

4. Launch the setup program and follow the instructions on 

the screen. When installation completes, the 

Synchronization Setup Wizard connects your phone to the 

computer, to set up a partnership.

Note: When installation completes, the ActiveSync icon displays on the 
taskbar.

Note: Synchronization automatically begins the first time your device is 
connected to your computer.
All the selected synchronization items are copied from your computer 
to your device, and Windows Explorer creates a shortcut to the Mobile 
drive.

Setting Up and Configuring ActiveSync 

1. After you’ve installed ActiveSync, connect one end of the 

USB data cable to the jack on the upper right side of your 

phone and the other end to a USB port on your computer. 

Your computer assigns a different profile to each device 

that is connected to it through the ActiveSync application.

2. Select Next to setup the sync partnership between the PC 

and your device.

+

http://www.microsoft.com/windowsmobile/activesync/activesync45.mspx
http://www.microsoft.com/windowsmobile/activesync/activesync45.mspx
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3. Enter a unique name for your device and click Next. 4. Select or deselect the desired applications that you wish to 

synchronize, then click Next.
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5. Click the square to allow wireless data connections on 

your device while connected to your computer. If selected 

a checkmark will display in the box.

6. Click Finish.
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7. The SGH-i907 and the PC should perform the first 

ActiveSync. This may take some time, depending on the 

amount of information that needs to be synchronized.

Customizing Connection Settings

To establish a connection between your computer and the phone, 
you must enable the connections you want to use in the 
ActiveSync® program. By default, all connections are enabled.

1. From the ActiveSync® window on your computer, select 

File ➔ Connection Settings...

2. Change the connection settings.

Note: If your phone is not connected to the computer, click this button to 
establish a connection.

3. Click on OK.
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Synchronizing Information

To begin synchronization, connect your phone to your computer. 
The Microsoft® ActiveSync® window on your computer 
automatically displays and synchronization starts.

Once the synchronization is completed, the phone stays 
connected to the computer. If any change is made, Microsoft® 
ActiveSync® automatically will begin synchronization. 

To begin synchronization manually on your phone. 

� From the Today screen, select Start ➔ Programs ➔ ActiveSync, 

then press the Sync soft key. 

You can open the phone’s file directory from your PC by clicking 
Explore in the Microsoft ActiveSync window. You can then copy 
files quickly and easily from the phone to the computer, or from 
the computer to the phone. 

Note: To synchronize Bluetooth devices with a compatible computer, the 
computer must have the Bluetooth stack for Windows XP Service 
Pack 2. 

Customizing Synchronization Settings

You can set various setting options for synchronization with a 
computer and a server, and set the synchronization schedule.

First, you must terminate the connection between your phone 
and computer. Disconnect the USB data cable or remove the 
phone from the Bluetooth range. 

Changing PC Settings on Your Phone

1. From the Today screen, select Start ➔ Programs ➔ 

ActiveSync. 

2. Press Menu soft key, then select Options. 

3. Highlight Windows PC. 

4. Select the Settings button. 

5. Change the computer name, as needed. 

If your phone is not 

connected to the 

computer, click this 

button to establish 

a connection.



121

6. To set how to handle a data conflict between the phone 

and computer and to set an event logging type, make your 

selections in the If there is a conflict and Event logging 

fields. 

7. Select .

Setting Server Synchronization

You can synchronize information automatically as items arrive 
only if your company is running Microsoft Exchange Server with 
Exchange ActiveSync®. 

Configuring an Exchange Server connection

1. From the Today screen, select Start ➔ Programs ➔ 

ActiveSync. 

2. Press Menu soft key, then select Configure Server... The Edit 

Server Settings screen displays. 

3. Enter the Server address. 

4. To use a SSL protocol for server access, select This server 

requires an encrypted (SSL) connection.

5. Press the Next soft key. The User Information screen 

displays. 

6. Enter your Microsoft Exchange User name, Password, and 

Domain. 

7. To save the password for subsequent accesses, select 

Save password. 

8. Press the Next soft key. 

9. Select data types to synchronize. 

10. When you are done, press the Finish soft key.

Changing the Synchronization Schedule
You can schedule synchronization with the Microsoft® Exchange 
Server on two separate times. Use the peak time schedule to 
synchronize during working hours or other times when you 
experience higher mail volumes. Use the off-peak time schedule 
to synchronize during times when you experience lower mail 
volumes.

1. From the Today screen, select Start ➔ Programs ➔ 

ActiveSync. 

2. Press Menu soft key, then select Schedule... The Schedule 

screen displays. 
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3. Set each option:

• To synchronize periodically during peak times, select a frequency of 
synchronization in the Peak times field. 

• Select frequency of synchronization in the Off-peak times field to 
synchronize periodically during off-peak times. 

4. Select one of the available options.

• To use the peak time and off-peak time setting while roaming, 
select Use above settings when roaming.

• To synchronize each time you send an e-mail, select Send/
receive when I click Send. 

5. To set the days and hours for peak time, select Adjust peak 

times to fit your schedule. The Peak Times screen displays. 

6. Set each option: 

• Select individual Peak days. 

• Select a Start Time. 

• Select an End Time. 

7. Select  when you are finished. You are returned to the 

Schedule screen. 

8. Select  to return to the ActiveSync screen. 

Connecting Your Phone to a Computer

To connect the phone to your computer, you can choose one of 
the following ways:
• Using a USB data cable
• Using a Bluetooth connection

Using a USB data cable

Connect one end of the USB data cable to the jack on the bottom 
of the phone and the other end to the USB port on your computer.

Note:  Your phone must be set for Microsoft® ActiveSync® to use a USB 
connection. Select Start > Programs > ActiveSync > Menu > 
Connections..., then select Synchronize all PCs using this connection 
and set USB. 

The connection is established and the Microsoft® ActiveSync® 
window displays. The synchronization automatically begins.

Connecting using Bluetooth Wireless Technology

To use ActiveSync® via Bluetooth wireless technology, you need 
to configure the settings for both your PC and your handset.
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PC Configuration

1. Add a COM port in the Bluetooth application you use on 

your PC. 

2. In ActiveSync, select File ➔ Connection Settings. The 

Connection Settings window pops-up. 

3. Check Allow connections to one of the following:, then 

choose the COM port added in Step 1. 

PDA Configuration

1. Establish a Bluetooth connection between your device and 

your PC.

2. Select Yes in the Bluetooth ActiveSync dialog box that 

displays, “(Your PC) supports synchronizing using Bluetooth. 

Would you like to designate it as an ActiveSync partner?”

3. On your phone, from the Today screen, elect Start ➔ 

Programs ➔ ActiveSync. 

4. Press the Menu soft key, then select “Connect via 

Bluetooth.” 

Windows Mobile Device Center 6.1 for Windows 
Vista
The Microsoft Windows Mobile Device Center enables you to set 
up new partnerships, synchronize content, and manage music, 
pictures, and video with Windows Mobile powered devices 
(Windows Mobile 2003 or later). The Windows Mobile Device 
Center is only supported on Windows Vista.

Windows Mobile Device Center helps you to quickly set up new 
partnerships, synchronize business-critical information such as 
e-mail, contacts and calendar appointments, easily manage your 
synchronization settings, and transfer business documents 
between your device and PC. 

The Windows Mobile Device Center simplifies managing media 
between your Windows Mobile powered device and your PC. With 
the picture acquisition wizard, you can easily tag and transfer all 
of the pictures from your Windows Mobile powered device to 
your PC’s Windows Photo Gallery.
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System Requirements

Windows Mobile Device Center is currently only available for the 
following versions of Microsoft Windows Vista™. 
• Windows Vista™ Ultimate
• Windows Vista™ Enterprise
• Windows Vista™ Business
• Windows Vista™ Home Premium
• Windows Vista™ Home Basic
• Microsoft® Outlook® 2007, Microsoft Outlook XP, and Microsoft 

Outlook 2003 messaging and collaboration clients
• Microsoft® Office 2003
• Microsoft® Outlook® XP, Microsoft® Outlook® 2003, and Microsoft® 

Outlook® 2007 messaging and collaboration clients are required for 
synchronization of e-mail, contacts, tasks and notes to a Personal 
Computer.

Installing Windows Mobile Device Center 

If your PC is running Windows Vista, your synchronization 
settings will be managed through the Windows Mobile Device 
Center. For instruction on downloading Windows Mobile Device 
Center visit http://www.microsoft.com/windowsmobile/
devicecenter.mspx.
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Section 13: Network Services

This section details how 
you can set up the network 
services supported by your 
carrier. Some of these 
services may not be 
available due to coverage 
area or service plans. If you 
have any questions, please 
contact your service 
provider. 

To access Network Services: 

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Personal tab ➔ Phone ( ) ➔ 

Services tab. A list of available network services displays. 

Call Barring
If your Wireless Carrier 
supports this service, it lets 
you permit or block 
incoming or outgoing calls. 

Note: For more information, contact your Wireless Carrier. 

1. In the network services menu, highlight Call Barring, then 

select the Get Settings... button. 

2. To permit or Block incoming calls, select one of the 

following values: 

• All calls 

• When roaming 

• Off 

3. Block outgoing calls: 
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• All calls 

• International 

• International except to home country 

• Off 

4. Press  or select  to save your new settings and 

return to the previous screen. 

Caller ID
This service lets you choose 
whether and to whom your 
service provider's network 
will send your caller ID 
information (your phone 
number). 

1. In the network 

services menu, 

highlight Caller ID, 

then select the Get Settings... button. 

2. To block or Provide your caller ID, select one of the 

following recipients: 

• Everyone 

• No one 

• Only to contacts 

3. Press  or select  to save your new settings and 

return to the previous screen. 

Call Forwarding
This network service lets 
you choose whether (and 
under what conditions) to 
forward your incoming calls 
to another phone number or 
to Voicemail. 

1. In the network 

services menu, 

highlight Call 

Forwarding, then select the Get Settings... button. 

2. To forward your incoming calls unconditionally: 

• Select the Forward all incoming phone calls option. A check 
mark appears in the associated check box. The Forward phone 
calls only if: options are disabled and any check marks disappear 
from the associated check boxes. 

• Enter a Contacts entry name or a phone number, or select 
Voicemail. 



127

3. To forward your incoming calls only under particular 

conditions: 

• If enabled, select the Forward all incoming phone calls option. 
The check mark disappears from the associated check box and the 
option becomes disabled. 

• Select any or all of the Forward phone calls only if: options (No 
answer, Unavailable, and/or Busy). A check mark appears in the 
associated check box for each of the selected options. 

• For each option, enter a Contacts entry name or a phone number, 
or select Voicemail. 
– For the No answer option, select a Forward after: time (5 – 30 

seconds). 

4. Press  or select  to save your new settings and 

return to the previous screen. 

Call Waiting
This service lets you choose 
whether or not to be alerted 
during a call when you 
receive another, waiting 
incoming call. 

1. In the network 

services menu, 

highlight Call Waiting, 

then select the Get 

Settings... button. 

2. To change your Call Waiting setting, select one of the 

following options: 

• Notify me — An alert tone plays and a message pops-up to notify 
you during a call of an additional, waiting call. 

• Do not notify me — You are not notified during a call of additional 
calls, which are forwarded to Voicemail. 

3. Press  or select  to save your new settings and 

return to the previous screen. 
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Voicemail and Text 
Messages
This service lets you 
change the access 
numbers for your Carrier’s 
Text message service 
center and Voicemail 
server. 

Note: These numbers are automatically setup when you receive your phone. 
You will probably not need to change them unless otherwise instructed 
by your carrier. 

1. In the network services menu, highlight Voicemail and Text 

Messages, then select the Get Settings... button. 

2. To change the access numbers, select one of the following 

options: 

• Text messages service center 

• Voicemail 

3. Press  or select  to save your new settings and 

return to the previous screen. 



129

Section 14: Bluetooth and Wi-Fi Services

This section explains the Bluetooth wireless technology and 
Wireless Fidelity (Wi-Fi) features available with your Samsung 
SGH-i907, as well as certain connection related details 
necessary for configuring your phone to work with these 
services.

About Bluetooth Wireless Technology
Bluetooth wireless technology provides short range wireless 
communication exchange over a distance of about 30 feet 
without requiring a physical connection.

Unlike infrared, you don't need to line up the devices to beam 
information using Bluetooth. If the devices are within a range of 
one another, you can exchange information between them, even 
if they are located in different rooms.

Your SGH-i907 allows you to beam files, appointments, tasks, 
and contact cards between common devices or you can use 
Bluetooth wireless technology enabled peripherals to integrate 
with your device.

Bluetooth Service Profiles

Actually, the Bluetooth specification is a protocol that describes 
how the short-range wireless technology works, whereas 
individual profiles describe the services supported by individual 
devices. Profiles reduce the chance that different devices will not 
work together.

Your phone supports the following profile service:
• HSP: Headset Profile 
• HFP1.5: Hands-Free Profile 1.5 
• SPP: Serial Port Profile (AT Commands)
• PAN: Personal Area Networking Profile
• A2DP: Advanced Audio Distribution Profile
• AVRCP: Audio/Video Remote Control Profile
• OBEX: Object Exchange Profiles

• OPP: Object Push Profile

• BPP: Basic Printing Profile

• GAVDP: Generic Audio/Video Distribution Profile
• AVDTP: Audio/Video Distribution Profile
• AVCTP: Audio/Video Control Transport Protocol Profile
• HID: Human Interface Device
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Bluetooth Settings

The Bluetooth wireless technology settings menu provides the 
ability to view and change the device name, show the visibility, 
and set the security for the device.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ Bluetooth 

( ) to review the various settings tabs:

• Devices: Select Add new device to search for nearby Bluetooth 
devices. Select on a device to modify it’s settings.

• Mode: To activate the Bluetooth functionality, select the Turn on 
Bluetooth box (a check mark displays in the box). To make your 
device visible to other Bluetooth devices, select the corresponding 
box.     
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• COM Ports: After pairing with a device, use this filed to setup a 
COM port by selecting a New Outgoing Port. For additional options, 
select and hold an existing port.

• Headset Manager: Allows you to configure the parameters for the 
bluetooth headset.

Bluetooth Modes
Bluetooth operates in two modes: On/Off and Discoverable 
Modes.

On/Off Mode

When the Bluetooth radio is turned on, you can use the Bluetooth 
wireless technology features available in the SGH-i907. When the 
Bluetooth radio is turned off, you cannot send or receive 
information via Bluetooth. To save battery life or in situations 

where radio use is prohibited, such as airline traveling, you can 
turn off Bluetooth wireless technology in your device.

Turning Bluetooth On/Off

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ Bluetooth 

( ) ➔ Mode tab.

3. Select or clear the “Turn on Bluetooth” check box. The 

Bluetooth radio is turned on or off depending on your 

selection.

4. Press  or select  to save your changes and 

return to the previous screen.

Discoverable Mode

When your device is discoverable, other devices will 
automatically detect it while searching for compatible Bluetooth 
wireless technology enabled devices with which to connect. Your 
phone must be on and you have to turn on the embedded 
Bluetooth radio.

When the discoverable mode is active, a message displays when 
another device attempts to establish a bond or connect with your 
phone. You must accept the incoming beam to exchange data or 
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information with other compatible Bluetooth wireless technology 
enabled devices. 

Making your SGH-i907 Discoverable

To set your phone to be discoverable by other devices, follow 
these steps:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ Bluetooth 

( ) ➔ Mode tab.

3. Place a checkmark in the “Turn on Bluetooth” check box 

by selecting the screen.

4. Place a checkmark in the “Make this device visible to 

other devices” check box.

Other common devices can now detect your device and 

attempt to beam information to it, establish a connection, 

or use a Bluetooth service.

5. Press  or select  to save your changes and 

return to the previous screen.

Note: If you do not want your handset to be discoverable, clear the “Make 
this device visible to other devices” check box.

Pairing
Pairing is a relationship that you create between your SGH-i907 
and another Bluetooth wireless technology enabled devices to 
exchange information in a secure manner. Pairing involves 
entering the same Passkey on the two devices sharing a bond. 
Once a bond is created between devices, the devices do not have 
to be discoverable to exchange information; however, each 
device must have its Bluetooth radio on.

Once you pair with another device, you can exchange information 
and eliminate the need to discover one another or to enter 
security features like a common Passkey.

Pairing a Bluetooth Device

You can pair your device and another device that has Bluetooth 
wireless technology. Once you do this, Bluetooth doesn't need to 
be in discoverable mode in order for you to beam information 
between the two devices; the Bluetooth radio only needs to be 
turned on. For more information, refer to “Adding a Bluetooth 
Device”  on page 82.
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1. Make sure that the two devices are within range of one 

another and that Bluetooth discoverable mode is enabled 

on both devices.

2. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

3. Select Settings ( ) ➔ Connections tab ➔ Bluetooth 

( ) ➔ Devices tab and select Add new device from the 

on screen list. Your phone will then display a list of 

discovered Bluetooth devices that were detected within its 

communication range.

4. Select the device you wish to pair with and press the Next 

soft key.

5. Enter a Passkey or PIN, which should be between 1 and 16 

characters, and press the Next soft key. You are then 

notified the pairing is in progress.

Note: If you are pairing your device with another wireless handset or with a 
personal computer, you must enter the same Passkey on both devices. 

6. Press the Done soft key to complete the process.

Accepting a Bond

1. Make sure that Bluetooth is turned on and the device is 

discoverable.

2. When prompted to bond with the another device, press the 

Yes soft key.

3. Enter the numeric passcode/passkey and press the Next 

soft key. You are then notified the pairing is in progress.

4. Press the Done soft key to complete the process.

Renaming a Bond

The name of each bond can be changed, if necessary, by 
following these steps:

1. Make sure that the two devices are within range and that 

Bluetooth is discoverable on both devices.

2. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

3. Select Settings ( ) ➔ Connections tab ➔ Bluetooth 

( ) ➔ Devices tab.

4. Select the bond you want to rename.

5. In the Display Name field, enter a new name for the bond.
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6. Select the Save soft key to save your changes and return to 

the previous screen.

Bluetooth Hands-Free Device
1. Pair the SGH-i907 and the Bluetooth Hands-free device. 

For more information, refer to “Pairing a Bluetooth Device”  

on page 132.

2. To designate the device as a Hands-free device, select and 

hold the device in the list, then select Set as Hands-free in 

the pop-up menu. 

Using Bluetooth Hands-Free Device

Some or all of the features below are available when using your 
Bluetooth Hand-free device. 

– Voice recognition using the built-in “Voice Commands” 
application.

– Last number redial
– Call holding and call switching
– Caller ID display
– End a call
– Switching to a private call

Note: For specific information about the features available with your Hands-
free device, refer to the user manual.

Bluetooth Virtual Serial Port
There are many Bluetooth wireless technology devices that 
support the Bluetooth serial profile, such as GPS. You can use the 
SGH-i907 Bluetooth virtual serial port to make Bluetooth serial 
connection with such devices.

Setting Bluetooth Virtual Serial Port

1. Create a Bluetooth bond between your SGH-i907 and the 

device you want to use. For information on creating a 

bond, see “Pairing” on page 132.

2. If the device supports the serial port profile, this message, 

“(Device) support synchronizing using Bluetooth. Would you 

like to designate it as an ActiveSync partner?” displays.

3. Select No if you don't want to make an ActiveSync 

connection via the Bluetooth Virtual Serial Port.

4. After establishing a bond with the device, select New 

Outgoing Port on the COM Ports tab under Bluetooth 

settings.
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5. Select the device and then select the Next soft key.

6. Select the port, and then press  or select .

Connecting a Virtual Serial Port Device

The port you selected above can now be used in other 
applications available on your SGH-i907. For example, you can 
choose the port for communication when using a Bluetooth GPS 
application. 

ActiveSync via Bluetooth Wireless Technology
To use ActiveSync® via Bluetooth wireless technology, you need 
to configure the settings for both your PC and your SGH-i907.
• For more information, refer to “Synchronization”  on page 115. 

About Wi-Fi
Wi-Fi is wireless networking that provides access to local area 
networks without using network cabling, and it is faster and has 
a greater range than Bluetooth wireless technology. Wi-Fi can 
achieve connection speeds of up to 54 Mbps (depending on 
conditions at any given location), which easily allows you to 
share large files or quickly surf the internet with your SGH-i907.

Note: Wireless Fidelity (Wi-Fi) is a WLAN based on the 802.11 protocol, 
which transmits and receives in the 2.4 GHz frequency ISM band. The 
SGH-i907 supports the 802.11b/g protocol stack.

Note: The SGH-i907 may not be operable with all wireless access points.

Wi-Fi allows you to:
• Access the internet
• Access your corporate network
• Use hotspots provided by hotels or airports while traveling
• Send and receive email quickly

Enabling Wi-Fi
To turn Wi-Fi on in your SGH-i907, follow these steps:

1. From the Today menu, select Start ➔ Settings.

2. Select Connection tab ➔ Wireless Manager ( ).

The Wireless Manager screen displays.
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3. Select the Wi-Fi (Off) button. The button changes to Wi-Fi 

(On).

4. Press  or select  to save your changes and 

return to the previous screen.

Important!: Using Wi-Fi consumes a lot of battery power. 

Automatically Connecting to a Network
If one or more networks are present, the Wi-Fi icon ( ) displays 
on the Title Bar of the Today screen and a list of the available 
networks pops-up at the bottom of the screen. 

1. Select the SSID (Service Set Indentifier) for the network 

you want. 

2. Select The Internet if the network connects to the Internet 

(does not use proxy settings) or Work (uses proxy 

settings). 

3. If you are prompted for a Network or Security key, enter it 

and select Connect. 

Manually Entering Network Settings
A wireless network can be added when a network is detected 
(the Wi-Fi icon displays in the Title Bar), or you can add the 
network manually by entering setting information.

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ Wi-Fi ( ) to 

open the Configure Wireless Networks screen. 

3. Select the Search for Networks option. 

Wi-Fi Off Wi-Fi On
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4. From the Wireless tab, filter the list of available networks 

by selecting within the Networks to access field and 

selecting a search parameter:

• All Available

• Only access points

• Only computer-to-computer

5. To manually add a Network to the list, press Menu, then 

select the Add New... option at the top of the list. The 

Configure Wireless Network screen displays. 

• Enter the name of the Network. 

• Select a Connects to: value 

– Select The Internet if the network connects to the Internet (does not 
use proxy settings) or Work (uses proxy settings).

• If this is a hidden network (that is, does not broadcast it’s SSID), 
select the This is a hidden network check box. 

• If this is an ad-hoc connection (device-to-device), select the This is 
a device-to-device (ad hoc) connection check box. 

6. Select the Next soft key to continue onto the Authentication 

and Data Encryption information. Use the information 

provided by your Network administrator to complete this 

section.

7. To connect to an available Wi-Fi network, select and hold 

the SSID (name) of the Wi-Fi network you want, then select 

Connect from popup menu. 

8. Select the Network Adapters tab to select a security 

connection preset.

9. Select a security connection preset from the My network 

card connects to: drop down menu.

• Select The Internet if the network connects to the Internet (does 
not use proxy settings) or Work (uses proxy settings).
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Changing Connection Information
Using either the Wireless or Network Adapters tabs under 
“Network Card,” you can change your connection information. If 
your Wi-Fi network encrypts data with a security key (WEP) or 
you need WPA authentication to connect to your Wi-Fi network, 
you can set the configurations under Wireless tab. The Network 
Adapters tab allows you to choose whether you use a fixed IP or 
the DHCP (Dynamic Host Control Protocol).

To get the connection information for the Wi-Fi network you are 
connected to, follow these steps:

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Settings ( ) ➔ Connections tab ➔ Wi-Fi ( ) to 

open the Configure Wireless Networks screen.

3. Select the Network Adapters tab.

4. The current connection property displays in the My network 

card connects to:, and displays as either The Internet or 

Work.

• Select The Internet if the network connects to the Internet (does 
not use proxy settings) or Work (uses proxy settings).

5. If your Wi-Fi network encrypts data with a security key 

(WEP) or you need WPA authentication to connect your Wi-

Fi network, you can set the configuration on the Wireless 

tab.

6. Select the adapter you wish to change or configure.

7. From the screens that follow, set or change the settings, 

and press  or select  to save your changes. 
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Section 15: Multimedia

This section outlines the available gaming options and 
accessories for your phone.

Accessories
Your SGH-i907 supports many accessories that make your phone 
truly unique. You can add an optional Hands Free Kit to allow you 
to operate your phone while you drive, and your phone has 
Bluetooth technology that allows you to transmit files, contacts, 
or download information from other compatible devices.

Storage Card Slot (microSD)
The microSD Storage Card slot on the right side of the handset is 
for use with a microSD™ (Secure Digital) card. microSD cards 
come in a variety of sizes and can hold up to 16GB of data. 
Download and use applications and more using the enhanced 
storage capacity of the SD card.

Transferring data to the microSD card from a PC

1. Insert the microSD card (label side up) into the slot on the 

right side of the handset. The label side should be facing 

upward (that is, facing toward you).

2. Connect the handset into the PC using an optional USB 

Data Cable and synchronize the device with your PC via 

ActiveSync.

3. Open Windows Explorer then highlight the application or 

folder that you wish to transfer to the microSD card.

4. Highlight and copy the file(s) or folder(s) to your computer’s 

clipboard.

5. Using the ActiveSync menu, click the Explore icon to open 

the Mobile Device folder.

6. Double-click on the My Windows Mobile-Based Device 

folder.

7. Double-click the Storage Card folder to open. Any contents 

of the microSD card appear in the display.

8. Locate the folder or sub folder where you wish to paste the 

files that you’ve copied.

9. Press Ctrl-V on your computer to paste the files or folders 

on your computer’s clipboard to the your handset’s Storage 

Card.
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Use the microSD card

Once you’ve transferred files from your computer to the microSD 
card using ActiveSync, you can access applications that were 
transferred to your microSD card.

For example, if you’ve transferred any multimedia files onto your 
microSD card that are compatible with Windows Media Player, 
simply open Windows Media Player and select the media file that 
you wish to play. There is no need to look or browse your phone 
for the microSD card. The microSD card is recognized when it is 
installed.

Games
There are six games included with your SGH-i907. These games 
are listed in the Games folder under Programs. You can download 
other games and add these to your Java folder. 

Note: Games can be downloaded from the Internet and stored on your phone. 
Instructions from the game download site should inform you of the 
location (folder) in which to store the application on your phone.

Brain Challenge Vol.2 Demo

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Games ( ) ➔ BRAIN 

CHALLENGE VOL.2 DEMO ( ).

3. You are prompted to activate sound for this game. 

To activate game sounds, select Yes. 

4. To begin play, press  then select from a displayed list 

of options.

• Choose from: START DEMO, TRAINING ROOM, MY STATS, BUY 
FULL VERSION, PLAY MORE GAMES, and OPTIONS (for additional 
game options).
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5. Press  or select  to exit the current game and 

return to the previous screen. 

Bubble Breaker

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Games ( ) ➔ Bubble Breaker 

( ).

3. To begin play, press the New Game soft key. 

4. Select Yes to confirm the commencement of a new game.

5. Press Menu soft key and then select Options to display the 

options screen for the current game.

• Choose from: Play Sounds, Confirm End Game, Display Bursts, 
Guest Mode, Game Style, and Breaker Set.

6. Update your selected options then press  or select 

 to return to the game.

7. Press  or select  to exit the current game and 

return to the previous screen.

Ms. Pac-Man

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Games ( ) ➔ Ms. PAC-MAN 

by Namco.
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3. You are prompted to allow the game to use the network to 

validate that you have purchased the game. To play the 

demo version of the game, select “Don’t allow for this 

session”, then press the OK soft key.

4. You are prompted to retry purchase verification. To run the 

demonstration version of the game, press the Demo soft 

key. 

5. You are prompted to activate sound for this game. 

To activate game sounds, select the Yes soft key.

6. To start the game, press the Menu soft key then select 

from a displayed list of options.

• Choose from: BUY MS. PAC-MAN, NEW GAME, OPTONS (for 
additional game options), HELP, GET PAC-MAN DEMO, MORE 
NAMCO GAMES, and QUIT. 

7. Update your selected options, then select NEW GAME ➔ 

START to start play.

8. Press  or select  to exit the current game and 

return to the previous screen. 

Sims 2

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Games ( ) ➔ Sims 2 

( ).

3. You are prompted to allow the game to use the network to 

validate that you have purchased the game. To play the 

demo version of the game, select “Don’t allow for this 

session”, then press the OK soft key.

4. You are prompted to retry purchase verification. To run the 

demonstration version of the game, press the Continue soft 

key. 

5. A list of options displays.
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• Choose from: New game, Load game, Sound On, Help, About, 
and Quit. 

6. Update your selected options, then select New game to 

start play.

7. Press  or select  to exit the current game and 

return to the previous screen.

Solitaire

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 

2. Select Programs ( ) ➔ Games ( ) ➔ Solitaire ( ).

3. Press the Menu soft key and select New Game to 

commence a new game. Play is ready to begin.

4. Press the Menu soft key and then select Options to display 

the options screen for the current game.

• Choose from: Draw, Scoring, Time game, Display status, and Keep 
cumulative score.

5. Update your selected options then press  or select 

 to return to the game.

6. Press  or select  to exit the current game and 

return to the previous screen. 

WSOP Pro Challenge Poker

1. From the Today screen, press the Start key ( ) to 

activate the Start menu. 
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2. Select Programs ( ) ➔ Games ( ) ➔ WSOP Pro 

Challenge Poker ( ).

3. You are prompted to allow the game to use the network to 

validate that you have purchased the game. To play the 

demo version of the game, select “Don’t allow for this 

session”, then press the OK soft key.

4. You are prompted to activate sound for this game. 

To activate game sounds, select Yes. 

5. A list of options displays.

• Choose from: CAREER, VERSUS, SETTINGS, MORE GAMES, 
HELP, NEW PLAYER, ABOUT, and EXIT. 

6. Update your selected options, then select VERSUS to start 

play. 

7. Press  or select  to exit the current game and 

return to the previous screen. 
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Section 16: Health and Safety Information

This section outlines the safety precautions associated with using 
your phone. These safety precautions should be followed to 
safely use your phone.

Health and Safety Information
Exposure to Radio Frequency (RF) Signals

Certification Information (SAR)

Your wireless phone is a radio transmitter and receiver. It is 
designed and manufactured not to exceed the exposure limits for 
radio frequency (RF) energy set by the Federal Communications 
Commission (FCC) of the U.S. government. 

These FCC exposure limits are derived from the 
recommendations of two expert organizations, the National 
Counsel on Radiation Protection and Measurement (NCRP) and 
the Institute of Electrical and Electronics Engineers (IEEE). 

In both cases, the recommendations were developed by scientific 
and engineering experts drawn from industry, government, and 
academia after extensive reviews of the scientific literature 
related to the biological effects of RF energy.

The exposure limit set by the FCC for wireless mobile phones 
employs a unit of measurement known as the Specific 
Absorption Rate (SAR). The SAR is a measure of the rate of 

absorption of RF energy by the human body expressed in units of 
watts per kilogram (W/kg). The FCC requires wireless phones to 
comply with a safety limit of 1.6 watts per kilogram (1.6 W/kg). 

The FCC exposure limit incorporates a substantial margin of 
safety to give additional protection to the public and to account 
for any variations in measurements. 

SAR tests are conducted using standard operating positions 
accepted by the FCC with the phone transmitting at its highest 
certified power level in all tested frequency bands. Although the 
SAR is determined at the highest certified power level, the actual 
SAR level of the phone while operating can be well below the 
maximum value. This is because the phone is designed to 
operate at multiple power levels so as to use only the power 
required to reach the network. In general, the closer you are to a 
wireless base station antenna, the lower the power output.

Before a new model phone is available for sale to the public, it 
must be tested and certified to the FCC that it does not exceed 
the exposure limit established by the FCC. Tests for each model 
phone are performed in positions and locations (e.g. at the ear 
and worn on the body) as required by the FCC. For body worn 
operation, this phone has been tested and meets FCC RF 
exposure guidelines when used with an accessory that contains 
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no metal and that positions the handset a minimum of 1.5 cm 
from the body. 

Use of other accessories may not ensure compliance with FCC RF 
exposure guidelines.

The FCC has granted an Equipment Authorization for this mobile 
phone with all reported SAR levels evaluated as in compliance 
with the FCC RF exposure guidelines. The maximum SAR values 
for this model phone as reported to the FCC are:

GSM 850:
• Head:  0.710 W/Kg.
• Body-worn: 1.02 W/Kg.

GSM 1900:
• Head:  0.518 W/Kg.
• Body-worn: 0.569 W/Kg.

WCDMA 850:
• Head: 0.713 W/Kg.
• Body-worn: 0.529 W/Kg.

WCDMA 1900:
• Head: 1.30 W/Kg.
• Body-worn: 0.563 W/Kg.

SAR information on this and other model phones can be viewed 
online at http://www.fcc.gov/oet/ea. To find information that 

pertains to a particular model phone, this site uses the phone 
FCC ID number which is usually printed somewhere on the case 
of the phone. 

Sometimes it may be necessary to remove the battery pack to 
find the number. Once you have the FCC ID number for a 
particular phone, follow the instructions on the website and it 
should provide values for typical or maximum SAR for a particular 
phone. Additional product specific SAR information can also be 
obtained at www.fcc.gov/cgb/sar. 

Samsung Mobile Products and Recycling
Samsung cares for the environment and encourages its 
customers to recycle Samsung mobile phones and genuine 
Samsung accessories.

Go to: https://fun.samsungmobileusa.com/recycling/index.jsp for more 
information.

UL Certified Travel Adapter
The Travel Adapter for this phone has met applicable UL safety 
requirements. Please adhere to the following safety instructions 
per UL guidelines.

FAILURE TO FOLLOW THE INSTRUCTIONS OUTLINED MAY LEAD 
TO SERIOUS PERSONAL INJURY AND POSSIBLE PROPERTY 
DAMAGE.

http://www.fcc.gov/oet/ea
http://www.fcc.gov/cgb/sar
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IMPORTANT SAFETY INSTRUCTIONS - SAVE THESE 
INSTRUCTIONS.

DANGER - TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, 
CAREFULLY FOLLOW THESE INSTRUCTIONS.

FOR CONNECTION TO A SUPPLY NOT IN NORTH AMERICA, USE 
AN ATTACHMENT PLUG ADAPTOR OF THE PROPER 
CONFIGURATION FOR THE POWER OUTLET. THIS POWER UNIT IS 
INTENDED TO BE CORRECTLY ORIENTATED IN A VERTICAL OR 
HORIZONTAL OR FLOOR MOUNT POSITION.    

Consumer Information on Wireless Phones
The U.S. Food and Drug Administration (FDA) has published a 
series of Questions and Answers for consumers relating to radio 
frequency (RF) exposure from wireless phones. The FDA 
publication includes the following information:

What kinds of phones are the subject of this update?

The term wireless phone refers here to hand-held wireless 
phones with built-in antennas, often called “cell,” “mobile,” or 
“PCS” phones. These types of wireless phones can expose the 
user to measurable radio frequency energy (RF) because of the 
short distance between the phone and the user's head. These RF 
exposures are limited by Federal Communications Commission 
safety guidelines that were developed with the advice of FDA and 
other federal health and safety agencies.

When the phone is located at greater distances from the user, the 
exposure to RF is drastically lower because a person's RF 
exposure decreases rapidly with increasing distance from the 
source. The so-called “cordless phones,” which have a base unit 
connected to the telephone wiring in a house, typically operate at 
far lower power levels, and thus produce RF exposures well 
within the FCC's compliance limits.

Do wireless phones pose a health hazard?

The available scientific evidence does not show that any health 
problems are associated with using wireless phones. There is no 
proof, however, that wireless phones are absolutely safe. 
Wireless phones emit low levels of radio frequency energy (RF) in 
the microwave range while being used. They also emit very low 
levels of RF when in the stand-by mode. 

Whereas high levels of RF can produce health effects (by heating 
tissue), exposure to low level RF that does not produce heating 
effects causes no known adverse health effects. Many studies of 
low level RF exposures have not found any biological effects. 
Some studies have suggested that some biological effects may 
occur, but such findings have not been confirmed by additional 
research. In some cases, other researchers have had difficulty in 
reproducing those studies, or in determining the reasons for 
inconsistent results.
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What is FDA's role concerning the safety of wireless 
phones?

Under the law, FDA does not review the safety of radiation-
emitting consumer products such as wireless phones before they 
can be sold, as it does with new drugs or medical devices. 
However, the agency has authority to take action if wireless 
phones are shown to emit radio frequency energy (RF) at a level 
that is hazardous to the user. In such a case, FDA could require 
the manufacturers of wireless phones to notify users of the 
health hazard and to repair, replace or recall the phones so that 
the hazard no longer exists.

Although the existing scientific data do not justify FDA regulatory 
actions, FDA has urged the wireless phone industry to take a 
number of steps, including the following:
• Support needed research into possible biological effects of RF of the 

type emitted by wireless phones;
• Design wireless phones in a way that minimizes any RF exposure to 

the user that is not necessary for device function; and
• Cooperate in providing users of wireless phones with the best possible 

information on possible effects of wireless phone use on human 
health.

FDA belongs to an interagency working group of the federal 
agencies that have responsibility for different aspects of RF 

safety to ensure coordinated efforts at the federal level. The 
following agencies belong to this working group:
• National Institute for Occupational Safety and Health 
• Environmental Protection Agency
• Federal Communications Commission
• Occupational Safety and Health Administration
• National Telecommunications and Information Administration

The National Institutes of Health participates in some interagency 
working group activities, as well.

FDA shares regulatory responsibilities for wireless phones with 
the Federal Communications Commission (FCC). All phones that 
are sold in the United States must comply with FCC safety 
guidelines that limit RF exposure. FCC relies on FDA and other 
health agencies for safety questions about wireless phones.

FCC also regulates the base stations that the wireless phone 
networks rely upon. While these base stations operate at higher 
power than do the wireless phones themselves, the RF 
exposures that people get from these base stations are typically 
thousands of times lower than those they can get from wireless 
phones. 

Base stations are thus not the primary subject of the safety 
questions discussed in this document.
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What are the results of the research done already?

The research done thus far has produced conflicting results, and 
many studies have suffered from flaws in their research 
methods. Animal experiments investigating the effects of radio 
frequency energy (RF) exposures characteristic of wireless 
phones have yielded conflicting results that often cannot be 
repeated in other laboratories. A few animal studies, however, 
have suggested that low levels of RF could accelerate the 
development of cancer in laboratory animals. However, many of 
the studies that showed increased tumor development used 
animals that had been genetically engineered or treated with 
cancer-causing chemicals so as to be pre-disposed to develop 
cancer in absence of RF exposure. Other studies exposed the 
animals to RF for up to 22 hours per day. These conditions are 
not similar to the conditions under which people use wireless 
phones, so we don't know with certainty what the results of such 
studies mean for human health.

Three large epidemiology studies have been published since 
December 2000. Between them, the studies investigated any 
possible association between the use of wireless phones and 
primary brain cancer, glioma, meningioma, or acoustic neuroma, 
tumors of the brain or salivary gland, leukemia, or other cancers. 
None of the studies demonstrated the existence of any harmful 
health effects from wireless phones RF exposures. 

However, none of the studies can answer questions about long-
term exposures, since the average period of phone use in these 
studies was around three years.

What research is needed to decide whether RF exposure 
from wireless phones poses a health risk?

A combination of laboratory studies and epidemiological studies 
of people actually using wireless phones would provide some of 
the data that are needed. Lifetime animal exposure studies could 
be completed in a few years. However, very large numbers of 
animals would be needed to provide reliable proof of a cancer 
promoting effect if one exists. Epidemiological studies can 
provide data that is directly applicable to human populations, but 
ten or more years' follow-up may be needed to provide answers 
about some health effects, such as cancer. 

This is because the interval between the time of exposure to a 
cancer-causing agent and the time tumors develop - if they do - 
may be many, many years. The interpretation of epidemiological 
studies is hampered by difficulties in measuring actual RF 
exposure during day-to-day use of wireless phones. Many 
factors affect this measurement, such as the angle at which the 
phone is held, or which model of phone is used.



Health and Safety Information       150

What is FDA doing to find out more about the possible 
health effects of wireless phone RF?

FDA is working with the U.S. National Toxicology Program and 
with groups of investigators around the world to ensure that high 
priority animal studies are conducted to address important 
questions about the effects of exposure to radio frequency 
energy (RF).

FDA has been a leading participant in the World Health 
Organization international Electromagnetic Fields (EMF) Project 
since its inception in 1996. An influential result of this work has 
been the development of a detailed agenda of research needs 
that has driven the establishment of new research programs 
around the world. The Project has also helped develop a series of 
public information documents on EMF issues.

FDA and Cellular Telecommunications & Internet Association 
(CTIA) have a formal Cooperative Research and Development 
Agreement (CRADA) to do research on wireless phone safety. 
FDA provides the scientific oversight, obtaining input from 
experts in government, industry, and academic organizations. 

CTIA-funded research is conducted through contracts to 
independent investigators. The initial research will include both 
laboratory studies and studies of wireless phone users. The 
CRADA will also include a broad assessment of additional 

research needs in the context of the latest research 
developments around the world.

What steps can I take to reduce my exposure to radio 
frequency energy from my wireless phone?

If there is a risk from these products - and at this point we do not 
know that there is - it is probably very small. But if you are 
concerned about avoiding even potential risks, you can take a 
few simple steps to minimize your exposure to radio frequency 
energy (RF). Since time is a key factor in how much exposure a 
person receives, reducing the amount of time spent using a 
wireless phone will reduce RF exposure.
• If you must conduct extended conversations by wireless phone every 

day, you could place more distance between your body and the source 
of the RF, since the exposure level drops off dramatically with distance. 
For example, you could use a headset and carry the wireless phone 
away from your body or use a wireless phone connected to a remote 
antenna.

Again, the scientific data do not demonstrate that wireless 
phones are harmful. But if you are concerned about the RF 
exposure from these products, you can use measures like those 
described above to reduce your RF exposure from wireless phone 
use.
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What about children using wireless phones?

The scientific evidence does not show a danger to users of 
wireless phones, including children and teenagers. If you want to 
take steps to lower exposure to radio frequency energy (RF), the 
measures described above would apply to children and 
teenagers using wireless phones. Reducing the time of wireless 
phone use and increasing the distance between the user and the 
RF source will reduce RF exposure.

Some groups sponsored by other national governments have 
advised that children be discouraged from using wireless phones 
at all. For example, the government in the United Kingdom 
distributed leaflets containing such a recommendation in 
December 2000. 

They noted that no evidence exists that using a wireless phone 
causes brain tumors or other ill effects. Their recommendation to 
limit wireless phone use by children was strictly precautionary; it 
was not based on scientific evidence that any health hazard 
exists.

Do hands-free kits for wireless phones reduce 
risks from exposure to RF emissions?

Since there are no known risks from exposure to RF emissions 
from wireless phones, there is no reason to believe that hands-
free kits reduce risks. Hands-free kits can be used with wireless 
phones for convenience and comfort. These systems reduce the 

absorption of RF energy in the head because the phone, which is 
the source of the RF emissions, will not be placed against the 
head. On the other hand, if the phone is mounted against the 
waist or other part of the body during use, then that part of the 
body will absorb more RF energy. Wireless phones marketed in 
the U.S. are required to meet safety requirements regardless of 
whether they are used against the head or against the body. 
Either configuration should result in compliance with the safety 
limit.

Do wireless phone accessories that claim to shield 
the head from RF radiation work?

Since there are no known risks from exposure to RF emissions 
from wireless phones, there is no reason to believe that 
accessories that claim to shield the head from those emissions 
reduce risks. Some products that claim to shield the user from RF 
absorption use special phone cases, while others involve nothing 
more than a metallic accessory attached to the phone. Studies 
have shown that these products generally do not work as 
advertised. Unlike “hand-free” kits, these so-called “shields” 
may interfere with proper operation of the phone. The phone may 
be forced to boost its power to compensate, leading to an 
increase in RF absorption. In February 2002, the Federal trade 
Commission (FTC) charged two companies that sold devices that 
claimed to protect wireless phone users from radiation with 
making false and unsubstantiated claims. 
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According to FTC, these defendants lacked a reasonable basis to 
substantiate their claim.

What about wireless phone interference with 
medical equipment?

Radio frequency energy (RF) from wireless phones can interact 
with some electronic devices. For this reason, FDA helped 
develop a detailed test method to measure electromagnetic 
interference (EMI) of implanted cardiac pacemakers and 
defibrillators from wireless telephones. This test method is now 
part of a standard sponsored by the Association for the 
Advancement of Medical instrumentation (AAMI). The final draft, 
a joint effort by FDA, medical device manufacturers, and many 
other groups, was completed in late 2000. This standard will 
allow manufacturers to ensure that cardiac pacemakers and 
defibrillators are safe from wireless phone EMI. FDA has tested 
wireless phones and helped develop a voluntary standard 
sponsored by the Institute of Electrical and Electronic Engineers 
(IEEE). This standard specifies test methods and performance 
requirements for hearing aids and wireless phones so that no 
interference occurs when a person uses a compatible phone and 
a compatible hearing aid at the same time. This standard was 
approved by the IEEE in 2000.

FDA continues to monitor the use of wireless phones for possible 
interactions with other medical devices. Should harmful 

interference be found to occur, FDA will conduct testing to assess 
the interference and work to resolve the problem.

Additional information on the safety of RF exposures from various 
sources can be obtained from the following organizations 
(Updated 12/1/2006):
• FCC RF Safety Program:

http://www.fcc.gov/oet/rfsafety/
• Environmental Protection Agency (EPA):

http://www.epa.gov/radiation/
• Occupational Safety and Health Administration's (OSHA):

http://www.osha.gov/SLTC/radiofrequencyradiation/index.html
• National Institute for Occupational Safety and Health (NIOSH):

http://www.cdc.gov/niosh/homepage.html
• World Health Organization (WHO):

http://www.who.int/peh-emf/
• International Commission on Non-Ionizing Radiation Protection:

http://www.icnirp.de
• National Radiation Protection Board (UK):

http://www.hpa.org.uk/radiation
•  US Food and Drug Administration:

http://www.fda.gov/cellphones

Road Safety
Your wireless phone gives you the powerful ability to 
communicate by voice, almost anywhere, anytime. But an 

http://www.fcc.gov/oet/rfsafety/
http://www.epa.gov/radiation/
http://www.osha.gov/SLTC/radiofrequencyradiation/index.html
http://www.cdc.gov/niosh/homepage.html
http://www.hpa.org.uk/radiation
http://www.icnirp.de
http://www.hpa.org.uk/radiation
http://www.fda.gov/cellphones
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important responsibility accompanies the benefits of wireless 
phones, one that every user must uphold.

When driving a car, driving is your first responsibility. When using 
your wireless phone behind the wheel of a car, practice good 
common sense and remember the following tips:

1. Get to know your wireless phone and its features, such as 

speed dial and redial. If available, these features help you 

to place your call without taking your attention off the road.

2. When available, use a hands-free device. If possible, add 

an additional layer of convenience and safety to your 

wireless phone with one of the many hands free 

accessories available today.

3. Position your wireless phone within easy reach. Be able to 

access your wireless phone without removing your eyes 

from the road. If you get an incoming call at an 

inconvenient time, let your voicemail answer it for you.

4. Let the person you are speaking with know you are driving; 

if necessary, suspend the call in heavy traffic or hazardous 

weather conditions. Rain, sleet, snow, ice and even heavy 

traffic can be hazardous.

5. Do not take notes or look up phone numbers while driving. 

Jotting down a “to do” list or flipping through your address 

book takes attention away from your primary 

responsibility, driving safely.

6. Dial sensibly and assess the traffic; if possible, place calls 

when you are not moving or before pulling into traffic. Try 

to plan calls when your car will be stationary. If you need to 

make a call while moving, dial only a few numbers, check 

the road and your mirrors, then continue.

7. Do not engage in stressful or emotional conversations that 

may be distracting. Make people you are talking with 

aware you are driving and suspend conversations that 

have the potential to divert your attention from the road.

8. Use your wireless phone to call for help. Dial 9-1-1 or other 

local emergency number in the case of fire, traffic accident 

or medical emergencies. 
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9. Use your wireless phone to help others in emergencies. If 

you see an auto accident, crime in progress or other 

serious emergency where lives are in danger, call 9-1-1 or 

other local emergency number, as you would want others 

to do for you.

10. Call roadside assistance or a special non-emergency 

wireless assistance number when necessary. If you see a 

broken-down vehicle posing no serious hazard, a broken 

traffic signal, a minor traffic accident where no one 

appears injured, or a vehicle you know to be stolen, call 

roadside assistance or other special non-emergency 

number.

“The wireless industry reminds you to use your phone safely when 
driving.”

For more information, please call 1-888-901-SAFE, or visit our 
web-site www.ctia.org.

Important!: If you are using a handset other than a standard numeric keypad, 
please call 1-888-901-7233.

Provided by the Cellular Telecommunications & Internet 
Association.

Responsible Listening

Caution!: Avoid potential hearing loss.

Damage to hearing occurs when a person is exposed to loud 
sounds over time. The risk of hearing loss increases as sound is 
played louder and for longer durations. Prolonged exposure to 
loud sounds (including music) is the most common cause of 
preventable hearing loss. Some scientific research suggests that 
using portable audio devices, such as portable music players and 
cellular telephones, at high volume settings for long durations 
may lead to permanent noise-induced hearing loss. This includes 
the use of headphones (including headsets, earbuds, and 
Bluetooth or other wireless devices). Exposure to very loud sound 
has also been associated in some studies with tinnitus (a ringing 
in the ear), hypersensitivity to sound and distorted hearing.

Individual susceptibility to noise-induced hearing loss and 
potential hearing problem varies. Additionally, the amount of 
sound produced by a portable audio device varies depending on 
the nature of the sound, the device settings, and the headphones 
that are used. As a result, there is no single volume setting that is 
appropriate for everyone or for every combination of sound, 
settings and equipment. 

You should follow some commonsense recommendations when 
using any portable audio device:

http://www.ctia.org/
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• Set the volume in a quiet environment and select the lowest volume at 
which you can hear adequately.

• When using headphones, turn the volume down if you cannot hear the 
people speaking near you or if the person sitting next to you can hear 
what you are listening to.

• Do not turn the volume up to block out noisy surroundings. If you 
choose to listen to your portable device in a noisy environment, you 
noise-cancelling headphones to block out background environmental 
noise. By blocking background environment noise, noise cancelling 
headphones should allow you to hear the music at lower volumes than 
when using earbuds.

• Limit the amount of time you listen. As the volume increases, less time 
is required before you hearing could be affected.

• Avoid using headphones after exposure to extremely loud noises, such 
as rock concerts, that might cause temporary hearing loss. Temporary 
hearing loss might cause unsafe volumes to sound normal.

• Do not listen at any volume that causes you discomfort. If you 
experience ringing in your ears, hear muffled speech or experience 
any temporary hearing difficulty after listening to your portable audio 
device, discontinue use and consult your doctor.

You can obtain additional information on this subject from the 
following sources:

 
American Academy of Audiology

11730 Plaza American Drive, Suite 300

Reston, VA 20190

Voice: (800) 222-2336

Email: info@audiology.org

Internet: http://www.audiology.org

National Institute on Deafness and Other Communication Disorders

National Institutes of Health

31 Center Drive, MSC 2320

Bethesda, MD 20892-2320

Voice: (301) 496-7243

Email: nidcdinfo@nih.gov

Internet: http://www.cdc.gov/niosh/topics/noise/default.html

http://www.audiology.org
http://www.cdc.gov/niosh/topics/noise/default.html
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Operating Environment
Remember to follow any special regulations in force in any area 
and always switch your phone off whenever it is forbidden to use 
it, or when it may cause interference or danger. 

When connecting the phone or any accessory to another device, 
read its user's guide for detailed safety instructions. Do not 
connect incompatible products.

As with other mobile radio transmitting equipment, users are 
advised that for the satisfactory operation of the equipment and 
for the safety of personnel, it is recommended that the 
equipment should only be used in the normal operating position 
(held to your ear with the antenna pointing over your shoulder if 
you are using an external antenna).

Using Your Phone Near Other Electronic Devices
Most modern electronic equipment is shielded from radio 
frequency (RF) signals. However, certain electronic equipment 
may not be shielded against the RF signals from your wireless 
phone. Consult the manufacturer to discuss alternatives.

Implantable Medical Devices

A minimum separation of six (6) inches should be maintained 
between a handheld wireless phone and an implantable medical 
device, such as a pacemaker or implantable cardioverter 
defibrillator, to avoid potential interference with the device.

Persons who have such devices:
• Should ALWAYS keep the phone more than six (6) inches from their 

implantable medical device when the phone is turned ON;
• Should not carry the phone in a breast pocket;
• Should use the ear opposite the implantable medical device to 

minimize the potential for interference;
• Should turn the phone OFF immediately if there is any reason to 

suspect that interference is taking place;
• Should read and follow the directions from the manufacturer of your 

implantable medical device. If you have any questions about using 
your wireless phone with such a device, consult your health care 
provider.

National Institute for Occupational Safety and Health

Hubert H. Humphrey Bldg.

200 Independence Ave., SW

Washington, DC 20201

Voice: 1-800-35-NIOSH (1-800-356-4647)

Internet: http://www.cdc.gov/niosh/topics/noise/default.html

http://www.cdc.gov/niosh/topics/noise/default.html
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For more information see:

http://www.fcc.gov/oet/rfsafety/rf-faqs.html

Hearing Aid Compatibility with Mobile Phones

Some digital wireless phones may interfere with some hearing 
aids. In the event of such interference, you may wish to consult 
your hearing aid manufacturer to discuss alternatives.

Other Medical Devices

If you use any other personal medical devices, consult the 
manufacturer of your device to determine if it is adequately 
shielded from external RF energy. Your physician may be able to 
assist you in obtaining this information. Switch your phone off in 
health care facilities when any regulations posted in these areas 
instruct you to do so. Hospitals or health care facilities may be 
using equipment that could be sensitive to external RF energy.

Vehicles

RF signals may affect improperly installed or inadequately 
shielded electronic systems in motor vehicles. Check with the 
manufacturer or its representative regarding your vehicle. You 
should also consult the manufacturer of any equipment that has 
been added to your vehicle.

Posted Facilities

Switch your phone off in any facility where posted notices require 
you to do so.

Potentially Explosive Environments
Switch your phone off when in any area with a potentially 
explosive atmosphere and obey all signs and instructions. Sparks 
in such areas could cause an explosion or fire resulting in bodily 
injury or even death.

Users are advised to switch the phone off while at a refueling 
point (service station). Users are reminded of the need to observe 
restrictions on the use of radio equipment in fuel depots (fuel 
storage and distribution areas), chemical plants or where blasting 
operations are in progress.

Areas with a potentially explosive atmosphere are often but not 
always clearly marked. They include below deck on boats, 
chemical transfer or storage facilities, vehicles using liquefied 
petroleum gas (such as propane or butane), areas where the air 
contains chemicals or particles, such as grain, dust or metal 
powders, and any other area where you would normally be 
advised to turn off your vehicle engine.

Emergency Calls
This phone, like any wireless phone, operates using radio 
signals, wireless and landline networks as well as user-

http://www.fcc.gov/oet/rfsafety/rf-faqs.html
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programmed functions, which cannot guarantee connection in all 
conditions. Therefore, you should never rely solely on any 
wireless phone for essential communications (medical 
emergencies, for example).

Remember, to make or receive any calls the phone must be 
switched on and in a service area with adequate signal strength. 
Emergency calls may not be possible on all wireless phone 
networks or when certain network services and/or phone 
features are in use. Check with local service providers.

To make an emergency call:

1. If the phone is not on, switch it on.

2. Key in the emergency number for your present location (for 

example, 911 or other official emergency number). 

Emergency numbers vary by location.

3. Press the  key.

If certain features are in use (call barring, for example), you may 
first need to deactivate those features before you can make an 
emergency call. Consult this document and your local cellular 
service provider.

When making an emergency call, remember to give all the 
necessary information as accurately as possible. Remember that 
your phone may be the only means of communication at the 

scene of an accident; do not cut off the call until given 
permission to do so.

Restricting Children's access to your Phone

Your phone is not a toy. Children should not be allowed to play 
with it because they could hurt themselves and others, damage 
the phone or make calls that increase your phone bill.

FCC Notice and Cautions
FCC Notice

The phone may cause TV or radio interference if used in close 
proximity to receiving equipment. The FCC can require you to 
stop using the phone if such interference cannot be eliminated.

Vehicles using liquefied petroleum gas (such as propane or 
butane) must comply with the National Fire Protection Standard 
(NFPA-58). For a copy of this standard, contact the National Fire 
Protection Association, One Batterymarch Park, Quincy, MA 
02269, Attn: Publication Sales Division.

Cautions

Any changes or modifications to your phone not expressly 
approved in this document could void your warranty for this 
equipment, and void your authority to operate this equipment. 
Only use approved batteries, antennas and chargers. The use of 
any unauthorized accessories may be dangerous and void the 
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phone warranty if said accessories cause damage or a defect to 
the phone.

Although your phone is quite sturdy, it is a complex piece of 
equipment and can be broken. Avoid dropping, hitting, bending 
or sitting on it.

Other Important Safety Information
• Only qualified personnel should service the phone or install the phone 

in a vehicle. Faulty installation or service may be dangerous and may 
invalidate any warranty applicable to the device.

• Check regularly that all wireless phone equipment in your vehicle is 
mounted and operating properly.

• Do not store or carry flammable liquids, gases or explosive materials in 
the same compartment as the phone, its parts or accessories.

• For vehicles equipped with an air bag, remember that an air bag 
inflates with great force. Do not place objects, including both installed 
or portable wireless equipment in the area over the air bag or in the air 
bag deployment area. If wireless equipment is improperly installed and 
the air bag inflates, serious injury could result.

• Switch your phone off before boarding an aircraft. The use of wireless 
phone in aircraft is illegal and may be dangerous to the aircraft's 
operation.

• Failure to observe these instructions may lead to the suspension or 
denial of telephone services to the offender, or legal action, or both.

Product Performance
Getting the Most Out of Your Signal Reception

The quality of each call you make or receive depends on the 
signal strength in your area. Your phone informs you of the 
current signal strength by displaying a number of bars next to the 
signal strength icon. The more bars displayed, the stronger the 
signal.

If you're inside a building, being near a window may give you 
better reception.

Understanding the Power Save Feature

If your phone is unable to find a signal after searching, a Power 
Save feature is automatically activated. If your phone is active, it 
periodically rechecks service availability or you can check it 
yourself by pressing any key.

Anytime the Power Save feature is activated, a message displays 
on the screen. When a signal is found, your phone returns to 
standby mode.

Understanding How Your Phone Operates

Your phone is basically a radio transmitter and receiver. When it's 
turned on, it receives and transmits radio frequency (RF) signals. 
When you use your phone, the system handling your call controls 
the power level. This power can range from 0.006 watts to 0.2 
watts in digital mode.
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Maintaining Your Phone's Peak Performance

For the best care of your phone, only authorized personnel should 
service your phone and accessories. Faulty service may void the 
warranty.

There are several simple guidelines to operating your phone 
properly and maintaining safe, satisfactory service.
• To ensure that the Hearing Aid Compatibility rating for your phone is 

maintained, secondary transmitters such as Bluetooth and WLAN 
components must be disabled during a call. For more information, 
refer to “Bluetooth”  on page 81.

• If your phone is equipped with an external antenna, hold the phone 
with the antenna raised, fully-extended and over your shoulder.

• Do not hold, bend or twist the phone's antenna, if applicable.
• Do not use the phone if the antenna is damaged.
• If your phone is equipped with an internal antenna, obstructing the 

internal antenna could inhibit call performance.
• Speak directly into the phone's receiver.
• Avoid exposing your phone and accessories to rain or liquid spills. If 

your phone does get wet, immediately turn the power off and remove 
the battery. If it is inoperable, call Customer Care for service.

Availability of Various Features/Ring Tones
Many services and features are network dependent and may 
require additional subscription and/or usage charges. Not all 

features are available for purchase or use in all areas. 
Downloadable Ring Tones may be available at an additional cost. 
Other conditions and restrictions may apply. See your service 
provider for additional information.

Battery Standby and Talk Time
Standby and talk times will vary depending on phone usage 
patterns and conditions. Battery power consumption depends on 
factors such as network configuration, signal strength, operating 
temperature, features selected, frequency of calls, and voice, 
data, and other application usage patterns.

Battery Precautions
• Avoid dropping the cell phone. Dropping it, especially on a hard 

surface, can potentially cause damage to the phone and battery. If you 
suspect damage to the phone or battery, take it to a service center for 
inspection. 

• Never use any charger or battery that is damaged in any way.
• Do not modify or remanufacture the battery as this could result in 

serious safety hazards.
• If you use the phone near the network's base station, it uses less 

power; talk and standby time are greatly affected by the signal 
strength on the cellular network and the parameters set by the 
network operator.

• Follow battery usage, storage and charging guidelines found in the 
user’s guide.
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• Battery charging time depends on the remaining battery charge and 
the type of battery and charger used. The battery can be charged and 
discharged hundreds of times, but it will gradually wear out. When the 
operation time (talk time and standby time) is noticeably shorter than 
normal, it is time to buy a new battery.

• If left unused, a fully charged battery will discharge itself over time.
• Use only Samsung-approved batteries and recharge your battery only 

with Samsung-approved chargers. When a charger is not in use, 
disconnect it from the power source. Do not leave the battery 
connected to a charger for more than a week, since overcharging may 
shorten its life.

• Do not use incompatible cell phone batteries and chargers. Some Web 
sites and second-hand dealers, not associated with reputable 
manufacturers and carriers, might be selling incompatible or even 
counterfeit batteries and chargers. Consumers should purchase 
manufacturer or carrier recommended products and accessories. If 
unsure about whether a replacement battery or charger is compatible, 
contact the manufacturer of the battery or charger. 

• Misuse or use of incompatible phones, batteries, and charging devices 
could result in damage to the equipment and a possible risk of fire, 
explosion, leakage, or other serious hazard.

• Extreme temperatures will affect the charging capacity of your battery: 
it may require cooling or warming first.

• Do not leave the battery in hot or cold places, such as in a car in 
summer or winter conditions, as you will reduce the capacity and 

lifetime of the battery. Always try to keep the battery at room 
temperature. A phone with a hot or cold battery may temporarily not 
work, even when the battery is fully charged. Li-ion batteries are 
particularly affected by temperatures below 
0 °C (32 °F).

• Do not place the phone in areas that may get very hot, such as on or 
near a cooking surface, cooking appliance, iron, or radiator. 

• Do not get your phone or battery wet. Even though they will dry and 
appear to operate normally, the circuitry could slowly corrode and 
pose a safety hazard. 

• Do not short-circuit the battery. Accidental short-circuiting can occur 
when a metallic object (coin, clip or pen) causes a direct connection 
between the + and - terminals of the battery (metal strips on the 
battery), for example when you carry a spare battery in a pocket or 
bag. Short-circuiting the terminals may damage the battery or the 
object causing the short-circuiting.

• Do not permit a battery out of the phone to come in contact with metal 
objects, such as coins, keys or jewelry. 

• Do not crush, puncture or put a high degree of pressure on the battery 
as this can cause an internal short-circuit, resulting in overheating. 

• Dispose of used batteries in accordance with local regulations. In some 
areas, the disposal of batteries in household or business trash may be 
prohibited. For safe disposal options for Li-Ion batteries, contact your 
nearest Samsung authorized service center. Always recycle. Do not 
dispose of batteries in a fire.
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Care and Maintenance
Your phone is a product of superior design and craftsmanship 
and should be treated with care. The suggestions below will help 
you fulfill any warranty obligations and allow you to enjoy this 
product for many years.
• Keep the phone and all its parts and accessories out of the reach of 

small children.
• Keep the phone dry. Precipitation, humidity and liquids contain 

minerals that will corrode electronic circuits.
• Do not use the phone with a wet hand. Doing so may cause an electric 

shock to you or damage to the phone.
• Do not use or store the phone in dusty, dirty areas, as its moving parts 

may be damaged.
• Do not store the phone in hot areas. High temperatures can shorten the 

life of electronic devices, damage batteries, and warp or melt certain 
plastics.

• Do not store the phone in cold areas. When the phone warms up to its 
normal operating temperature, moisture can form inside the phone, 
which may damage the phone's electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break 
internal circuit boards.

• Do not use harsh chemicals, cleaning solvents or strong detergents to 
clean the phone. Wipe it with a soft cloth slightly dampened in a mild 
soap-and-water solution.

• Do not paint the phone. Paint can clog the device's moving parts and 
prevent proper operation.

• Do not put the phone in or on heating devices, such as a microwave 
oven, a stove or a radiator. The phone may explode when overheated.

• If your phone is equipped with an external antenna, use only the 
supplied or an approved replacement antenna. Unauthorized antennas 
or modified accessories may damage the phone and violate 
regulations governing radio devices.

• If the phone, battery, charger or any accessory is not working properly, 
take it to your nearest qualified service facility. The personnel there 
will assist you, and if necessary, arrange for service.
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Section 17: Warranty Information

Standard Limited Warranty
What is Covered and For How Long? 
SAMSUNG TELECOMMUNICATIONS AMERICA, LLC (“SAMSUNG”) 
warrants to the original purchaser (“Purchaser”) that SAMSUNG's 
Phones and accessories (“Products”) are free from defects in 
material and workmanship under normal use and service for the 
period commencing upon the date of purchase and continuing for 
the following specified period of time after that date:

What is Not Covered? This Limited Warranty is conditioned upon 
proper use of Product by Purchaser. This Limited Warranty does 
not cover: (a) defects or damage resulting from accident, misuse, 
abuse, neglect, unusual physical, electrical or electromechanical 
stress, or modification of any part of Product, including antenna, 
or cosmetic damage; (b) equipment that has the serial number 

removed or made illegible; (c) any plastic surfaces or other 
externally exposed parts that are scratched or damaged due to 
normal use; (d) malfunctions resulting from the use of Product in 
conjunction with accessories, products, or ancillary/peripheral 
equipment not furnished or approved by SAMSUNG; (e) defects or 
damage from improper testing, operation, maintenance, 
installation, or adjustment; (f) installation, maintenance, and 
service of Product, or (g) Product used or purchased outside the 
United States or Canada. 

This Limited Warranty covers batteries only if battery capacity 
falls below 80% of rated capacity or the battery leaks, and this 
Limited Warranty does not cover any battery if (i) the battery has 
been charged by a battery charger not specified or approved by 
SAMSUNG for charging the battery, (ii) any of the seals on the 
battery are broken or show evidence of tampering, or (iii) the 
battery has been used in equipment other than the SAMSUNG 
phone for which it is specified.

What are SAMSUNG's Obligations? During the applicable warranty 
period, SAMSUNG will repair or replace, at SAMSUNG's sole 
option, without charge to Purchaser, any defective component 
part of Product. To obtain service under this Limited Warranty, 
Purchaser must return Product to an authorized phone service 

Phone 1 Year

Batteries 1 Year

Leather Case 90 Days

Holster 90 Days

Other Phone Accessories 1 Year
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facility in an adequate container for shipping, accompanied by 
Purchaser's sales receipt or comparable substitute proof of sale 
showing the date of purchase, the serial number of Product and 
the sellers' name and address. To obtain assistance on where to 
deliver the Product, call Samsung Customer Care at 1-888-987-
4357. Upon receipt, SAMSUNG will promptly repair or replace the 
defective Product. SAMSUNG may, at SAMSUNG's sole option, 
use rebuilt, reconditioned, or new parts or components when 
repairing any Product or replace Product with a rebuilt, 
reconditioned or new Product. Repaired/replaced leather cases, 
pouches and holsters will be warranted for a period of ninety (90) 
days. All other repaired/replaced Product will be warranted for a 
period equal to the remainder of the original Limited Warranty on 
the original Product or for 90 days, whichever is longer. All 
replaced parts, components, boards and equipment shall 
become the property of SAMSUNG.

If SAMSUNG determines that any Product is not covered by this 
Limited Warranty, Purchaser must pay all parts, shipping, and 
labor charges for the repair or return of such Product.

WHAT ARE THE LIMITS ON SAMSUNG'S WARRANTY/LIABILITY? 
EXCEPT AS SET FORTH IN THE EXPRESS WARRANTY CONTAINED 
HEREIN, PURCHASER TAKES THE PRODUCT “AS IS,” AND 
SAMSUNG MAKES NO WARRANTY OR REPRESENTATION AND 
THERE ARE NO CONDITIONS, EXPRESS OR IMPLIED, STATUTORY 

OR OTHERWISE, OF ANY KIND WHATSOEVER WITH RESPECT TO 
THE PRODUCT, INCLUDING BUT NOT LIMITED TO:
• THE MERCHANTABILITY OF THE PRODUCT OR ITS FITNESS FOR ANY 

PARTICULAR PURPOSE OR USE;
• WARRANTIES OF TITLE OR NON-INFRINGEMENT;
• DESIGN, CONDITION, QUALITY, OR PERFORMANCE OF THE PRODUCT;
• THE WORKMANSHIP OF THE PRODUCT OR THE COMPONENTS 

CONTAINED THEREIN; OR
• COMPLIANCE OF THE PRODUCT WITH THE REQUIREMENTS OF ANY 

LAW, RULE, SPECIFICATION OR CONTRACT PERTAINING THERETO.

NOTHING CONTAINED IN THE INSTRUCTION MANUAL SHALL BE 
CONSTRUED TO CREATE AN EXPRESS WARRANTY OF ANY KIND 
WHATSOEVER WITH RESPECT TO THE PRODUCT. ALL IMPLIED 
WARRANTIES AND CONDITIONS THAT MAY ARISE BY OPERATION 
OF LAW, INCLUDING IF APPLICABLE THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, ARE HEREBY LIMITED TO THE SAME DURATION OF 
TIME AS THE EXPRESS WRITTEN WARRANTY STATED HEREIN. 
SOME STATES/PROVINCES DO NOT ALLOW LIMITATIONS ON HOW 
LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION 
MAY NOT APPLY TO YOU. IN ADDITION, SAMSUNG SHALL NOT BE 
LIABLE FOR ANY DAMAGES OF ANY KIND RESULTING FROM THE 
PURCHASE, USE, OR MISUSE OF, OR INABILITY TO USE THE 
PRODUCT OR ARISING DIRECTLY OR INDIRECTLY FROM THE USE 
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OR LOSS OF USE OF THE PRODUCT OR FROM THE BREACH OF 
THE EXPRESS WARRANTY, INCLUDING INCIDENTAL, SPECIAL, 
CONSEQUENTIAL OR SIMILAR DAMAGES, OR LOSS OF 
ANTICIPATED PROFITS OR BENEFITS, OR FOR DAMAGES ARISING 
FROM ANY TORT (INCLUDING NEGLIGENCE OR GROSS 
NEGLIGENCE) OR FAULT COMMITTED BY SAMSUNG, ITS AGENTS 
OR EMPLOYEES, OR FOR ANY BREACH OF CONTRACT OR FOR 
ANY CLAIM BROUGHT AGAINST PURCHASER BY ANY OTHER 
PARTY. SOME STATES/PROVINCES DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT 
APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS, WHICH VARY 
FROM STATE TO STATE/PROVINCE TO PROVINCE. THIS LIMITED 
WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE 
ORIGINAL PURCHASER OF THIS PRODUCT AND STATES 
PURCHASER'S EXCLUSIVE REMEDY. IF ANY PORTION OF THIS 
LIMITED WARRANTY IS HELD ILLEGAL OR UNENFORCEABLE BY 
REASON OF ANY LAW, SUCH PARTIAL ILLEGALITY OR 
UNENFORCEABILITY SHALL NOT AFFECT THE ENFORCEABILITY 
FOR THE REMAINDER OF THIS LIMITED WARRANTY WHICH 
PURCHASER ACKNOWLEDGES IS AND WILL ALWAYS BE 
CONSTRUED TO BE LIMITED BY ITS TERMS OR AS LIMITED AS 
THE LAW PERMITS. THE PARTIES UNDERSTAND THAT THE 
PURCHASER MAY USE THIRD-PARTY SOFTWARE OR EQUIPMENT 

IN CONJUNCTION WITH THE PRODUCT. SAMSUNG MAKES NO 
WARRANTIES OR REPRESENTATIONS AND THERE ARE NO 
CONDITIONS, EXPRESS OR IMPLIED, STATUTORY OR 
OTHERWISE, AS TO THE QUALITY, CAPABILITIES, OPERATIONS, 
PERFORMANCE OR SUITABILITY OF ANY THIRDPARTY SOFTWARE 
OR EQUIPMENT, WHETHER SUCH THIRD-PARTY SOFTWARE OR 
EQUIPMENT IS INCLUDED WITH THE PRODUCT DISTRIBUTED BY 
SAMSUNG OR OTHERWISE, INCLUDING THE ABILITY TO 
INTEGRATE ANY SUCH SOFTWARE OR EQUIPMENT WITH THE 
PRODUCT. THE QUALITY, CAPABILITIES, OPERATIONS, 
PERFORMANCE AND SUITABILITY OF ANY SUCH THIRD-PARTY 
SOFTWARE OR EQUIPMENT LIE SOLELY WITH THE PURCHASER 
AND THE DIRECT VENDOR, OWNER OR SUPPLIER OF SUCH 
THIRD-PARTY SOFTWARE OR EQUIPMENT, AS THE CASE MAY BE.

This Limited Warranty allocates risk of Product failure between 
Purchaser and SAMSUNG, and SAMSUNG's Product pricing 
reflects this allocation of risk and the limitations of liability 
contained in this Limited Warranty. The agents, employees, 
distributors, and dealers of SAMSUNG are not authorized to make 
modifications to this Limited Warranty, or make additional 
warranties binding on SAMSUNG. Accordingly, additional 
statements such as dealer advertising or presentation, whether 
oral or written, do not constitute warranties by SAMSUNG and 
should not be relied upon.
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Precautions for Transfer and Disposal

If data stored on this device is deleted or reformatted using the 
standard methods, the data only appears to be removed on a 
superficial level, and it may be possible for someone to retrieve 
and reuse the data by means of special software.

To avoid unintended information leaks and other problems of this 
sort, it is recommended that the device be returned to Samsung’s 
Customer Care Center for an Extended File System (EFS) Clear 
which will eliminate all user memory and return all settings to 
default settings. Please contact the Samsung Customer Care 
Center for details.

Important!: Please provide warranty information (proof of purchase) to 
Samsung’s Customer Care Center in order to provide this service 
at no charge. If the warranty has expired on the device, charges 
may apply.

Customer Care Center:

1000 Klein Rd.

Plano, TX 75074

Toll Free Tel: 1.888.987.HELP (4357)

Samsung Telecommunications America, LLC:

1301 East Lookout Drive

Richardson, Texas 75082

Phone: 1-800-SAMSUNG (726-7864)

Important!: If you are using a handset other than a standard numeric keypad, 
dial the numbers listed in brackets.

Phone: 1-888-987-HELP (4357)
©2008 Samsung Telecommunications America. All rights 
reserved.

No reproduction in whole or in part allowed without prior written 
approval. Specifications and availability subject to change 
without notice.
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